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Easy Mobile Pro User Guide

This document is the official user guide for the Pro version of the Easy Mobile plugin for Unity by SgLib Games.

Easy Mobile Versions

e Easy Mobile Pro
e Easy Mobile Basic
e Easy Mobile Lite (Free)

Important Links

o Website
e API Reference
e Support Email

e Forum

Connect with SgLib Games

e Unity Asset Store
e Facebook

e Twitter

e YouTube


http://u3d.as/Dd2
http://u3d.as/184q
http://u3d.as/FN0
http://easymobile.sglibgames.com
http://easymobile.sglibgames.com/api/pro
mailto:support@sglibgames.com?Subject=[EM Pro][YOUR_INVOICE_NUMBER]
https://forum.unity3d.com/threads/easy-mobile-many-in-one-package-for-mobile-games.453496/
https://www.assetstore.unity3d.com/en/#!/search/page=1/sortby=popularity/query=publisher:20993
https://www.facebook.com/sglibgames
https://twitter.com/SglibGames
https://www.youtube.com/channel/UCfNiWpkrQsoXDAMBrjhV9GQ

Introduction

Today mobile games have many "de facto standard" features ranging from advertising, in-app purchasing, game
services, notifications to sharing and rating system. These are considered "necessary evils" by many developers
though: required, but not necessarily fun to do. More importantly, it takes time (a lot) to implement them. That means
developers would need to repeat the boring, time-consuming task of integrating these features in almost every mobile
games they are going to build, instead of focusing their energy on doing what we're all in game development for:
creating fun!

Easy Mobile is our attempt to solve this problem. It is a many-in-one Unity plugin that greatly simplifies the
implementation of the de facto standard features every mobile game needs. It is packed with ready-to-use
components that you can just "plug" into your project, and have the necessary evils taken care of. We've been
spending thousands of hours creating this product, so you can save that same amount of time1 and spend your time

on real game development!

Easy Mobile supports two major mobile platforms: iOS and Android.

Highlights
Usability is our number one priority when designing Easy Mobile, hence the name. Other top priorities including
robustness, flexibility and versatility. With that in mind, we come up with a product that boasts the following highlights:

e Cross-platform API: Easy Mobile's scripting API allows you to accomplish most tasks with only one line of code.
And it is cross-platform, which means you can write code once and deploy on both iOS and Android.

e Friendly Editor: Easy Mobile comes with a simple yet powerful (and beautiful!) built-in editor that allows you to
easily control everything from one place.

e Automation: Much more than a mere collection of methods, Easy Mobile operates quietly in the background and
automates many chores such as service initialization and ad loading.

e Modular Design: Easy Mobile’s functionalities are grouped into modules that can be enabled or disabled
separately, so you can use what you want and not be worried about redundancies or contradictions with existing
code.

e Leveraging Official SDKs: Easy Mobile leverages official 3rd-party SDKs of interest, e.g. Google Play Games
plugin for Unity, integrating them with its own code to form a coherent system that maximizes usability and
reliability - without reinventing the wheel!

e Visual Scriptingz: Easy Mobile is not only for coders - it is fully compatible with Unity's most popular visual
scripting plugin Playmaker, thanks to more than 100 custom actions built-in to the package.

What's in the Box?

This plugin is currently packed with the following modules:
e Advertising

o Supports most popular ad networks including AdColony, AdMob, Chartboost, Facebook Audience Network,
Heyzap, ironSource, MoPub, Tapjoy and Unity Ads

o Even more ad networks can be used via mediation service provided by AdMob, Heyzap, ironSource, MoPub
or Tapjoy


https://github.com/playgameservices/play-games-plugin-for-unity
https://assetstore.unity.com/packages/tools/visual-scripting/playmaker-368

o Automatic ad loading
o Allows using multiple ad networks in one build
o Allows different ad configurations for different platforms
o Allows having multiple placements of each ad type
o User consent support (GDPR compliant)
e Game Services
o Works with Game Center on iOS and Google Play Games on Android
o Automatic authentication
o Custom editor for easy management of leaderboards and achievements
o Saved Games®
e GIF
o Records screen, plays recorded clips and exports GIF images
o High-performance, mobile-friendly GIF encoder
o Giphy upload API for sharing GIF to social networks
e In-App Purchasing
o Leverages Unity In-App Purchasing service
o Custom editor for easy management of product catalog
o Auto initialization
o Receipt validation
o Apple's Ask To Buy
o Apple's Promotional Purchases
e Native APIs
o Access to mobile native Ul elements including alerts and (Android) toasts
o More native functionalities will be added soon
¢ Notifications
o Fully-customizable local notifications
o Compatible with OneSignal and Firebase Cloud Messaging, free and popular services for push notifications
o Supports notification channels and channel groups on Android O and higher
o User consent support (GDPR compliant)
e Privacy
o Provides tools and resources to help getting compliant with user privacy regulations such as GDPR

o Multi-purpose native consent dialog that can act as the common interface for collecting user consent for all
relevant services, instead of having multiple interfaces for various services

o Built-in system to manage consent and communicate consent to relevant services


https://onesignal.com/
https://firebase.google.com/docs/cloud-messaging/

o API to check if the current device is in the European Economic Area region (EEA region, affected by GDPR)

e Sharing
o Shares texts, URLs and images using the mobile native sharing functionality
o Utilities
o Store Review: provides an effective way to ask for reviews and ratings using the system-provided rating
prompt of iOS (10.3+) and a native, highly customizable popup on Android

Easy Mobile: Basic vs Pro

Easy Mobile comes in 2 different versions: Basic and Pro. Easy Mobile Basic is the lower-price version which contains
most of the core features of the plugin. The Pro version is the premium one and have all features available. Below is a

feature-comparison table of the Basic and Pro versions of Easy Mobile.



Introduction

FEATURES

Advertising

AdColony, AdMob, Chartboost, Facebook Audience Network, Heyzap,
ironSource, MoPub, Tapjoy & UnityAds support

Banner, interstitial & rewarded ad formats

One unified API for all ad networks
Automatic ad loading

Using multiple ad networks in one build
Multiple ad placements support

Built-in Remove-Ads function

User consent support (GDPR compliant)
Game Services

Game Center (iOS) & Play Game Services (Android) support
Automatic authentication/initialization
Leaderboards

Achievements

Saved Games (using iCloud & Google Drive)
GIF

Low-overhead screen recorder

Built-in players for recorded clip playback

Mobile-friendly GIF encoder

Full control on GIF parameters: sizes, length, quality, frame-rate, etc.
Advanced color quantization for high quality GIF images

Giphy upload API

In-App Purchasing

Multiple stores supported: App Store, Google Play, Amazon Apps, etc.

Consumable, non-consumable & subscription product types
Custom editor for easy management of product catalog
Auto initialization

Apple's Ask-To-Buy

Apple's Promotional Purchases

Local receipt validation
Native APIs

Native mobile Ul elements (alerts, toast) —

Notifications

Fully-customizable local notifications

Android 8.0 notification channel & channel group support

Push notifications (OneSignal & Firebase Cloud Messaging support)
User consent support (GDPR compliant)
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Native, multi-purpose consent dialog
Built-in flexible consent management system
EEA region detector

Sharing of images, texts and URLs via native sharing functionality

Built-in screenshot capturing API
Utilities

Store Review (native rating dialog) —

Visual Scripting Support
Playmaker support (100+ custom actions)
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Introduction

1. We consider ourselves average developers, so this should be true to most indie developers, the main

audience of this product. <
. Easy Mobile Pro only.

3 Easy Mobile Pro only. ¥
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Using Easy Mobile

Using Easy Mobile

Overview

Using Easy Mobile involves 3 steps:

1. Configuring the plugin using the built-in Settings interface
2. Initializing the plugin runtime
3. Making appropriate API calls from script (or using visual scripting actions)

Main Menu

After importing Easy Mobile, there will be a new menu added at Window > Easy Mobile from which you can open the
Global Settings interface to configure modules as well as access other resources.

I Vincow [ oo

Minimize M ¢ id <Ope
Zoom

© |nspector

Bring All to Front

Easy Mobile [ Settings
Google Play Games > Install PlayMaker Actions
Unity AP > Reimport Play Services Resolver
| User Guide
e .y Scripting Reference |
Unity UDP »  Support |
About I

Vuforia Configuration {3V

Global Settings

The Global Settings interface is the only place you go to configure the plugin. Here you can control everything
including toggling module on or off, providing ads credentials, adding leaderboards, creating a product catalog, etc.

13



Using Easy Mobile

All these settings are stored in the EM_Settings object, which is a ScriptableObject created automatically after
importing the plugin and is located at Assets/EasyMobile/Resources. You can also access this EM_Settings class

from script and via its properties accessing each module settings in runtime.

14



Using Easy Mobile

EM_Settings.asset

Initializing

You must always initialize Easy Mobile before using its API.

Since the initialization must be done before the Easy Mobile API can be used, it is advisable to do it as soon as your

app launches. This will also allow automatic services such as ad loading to start soon and the ads will be more likely

available when needed. Practically, this means attaching the initializing script to some game object in the first scene of

your app.

To initialize simply call the Init method of the RuntimeManager class. This method is a no-op if the initialization has
been done so it's safe to be called multiple times. You can also check if Easy Mobile has been initialized using the
IsInitialized method.

using UnityEngine:
using System Collections.
using EasyMobile; // include the Easy Mobile namespace to use its scripting API

public class EasyMobileInitializer : MonoBehaviour

{
// Checks if EM has been initialized and initialize it if not.
// This must be done once before other EM APIs can be used.
void Awake()
{
if [ !RuntimeManager IsInitialized &
RuntimeManager Init
}
}

Scripting API

After initializing Easy Mobile you can use its scripting API, which is written in C#. Note that the API is put under the
namespace EasyMobile so you need to add the following statement to the top of your scripts to access it.

// Put this on top of your scripts to use Easy Mobile scripting API
using EasyMobile:

15



Easy Mobile's API is cross-platform so you can use the same code for both iOS and Android. You can find the
API reference here.

Testing

Most of Easy Mobile's functionalities are mobile-specific which may not work properly within the Unity editor.
Therefore you should always perform testing on actual iOS or Android devices.

Using the Demo App

Easy Mobile comes with a demo app that you can use to quickly test each module's operation after configuring, even
before writing any code! The demo app is located at folder Assets/EasyMobile/Demo. Its scenes are in the subfolder
Scenes, you can build all scenes or only scenes that you want to test. Its scripts are in the subfolder Scripts, which
you can refer to for an example of how Easy Mobile API can be used.

Project | Elconsale
“Creat,.e h Q
¥ &5 EasyMohile 4 Assets » EasyMobile » Demo » Scenes » Modules
¥ &3 Demao & AdvertisingDemo
&5 Anim @ GameServices Demo
& Audio € GameServices Demo_SavedGames
& Fonts &) Gifbemo
(&5 Prefabs €} InAppPurchasingDema EASY MOBILE Pro
¥ Gl Scenes € NativeUlDemo
@ NotificationsDemo
b 5 Scripts Q PrivacyDemo
&3 scrollableList ) sharingDemo
&5 Sprites & Utilities Demo @ e
> &5 Editor ADS GAME AP
il Generated SERVICES
» & GUISkins
&5 Materials
& Packages
» &5 PlayMakerActions GIF  NATIVEUI NOTIFS
» &5 Plugins
» Ga Prefabs
&5 Resources
v ﬁ Scripts
» & Common SHARING UTILITIES PRIVACY
& Core
¥ &5 Modules v & DemoHome.unity

Using PlayMaker Actions

Easy Mobile is officially compatible with PlayMaker, with more than 100 custom actions ready to be used. You can
install these actions from menu Window > Easy Mobile > Install PlayMaker Actions.

When installing the PlayMaker actions, a demo app will also be imported at
Assets/EasyMobile/Demo/PlayMakerDemo. This demo is a copy of our main demo app, rebuilt using PlayMaker
actions instead of C# scripts. You can take it as an example to get an insight into how Easy Mobile's PlayMaker
actions can be used in practice. Apart from installing PlayMaker (obviously), you need to do a few more setup steps
as described below before running this demo app.

Installing the Unity Ul add-on for PlayMaker

Our PlayMaker demo app uses the Unity Ul system, so you need to install the Unity Ul add-on for PlayMaker.

Importing PlayMakerGlobals

The demo app uses global PlayMaker variables and events, so you need to import them before running the app.


http://easymobile.sglibgames.com/api-pro/
https://hutonggames.fogbugz.com/?W1192

If you project is new and doesn't have any PlayMakerGlobals (in the Assets/PlayMaker/Resources folder), simply copy
our Globals over by these steps:

e Double-click the PlayMakerGlobals.unitypackage in the Assets/EasyMobile/Demo/PlayMakerDemo folder.
e Locate the newly created file PlayMakerGlobals_ EXPORTED.asset right under the Assets folder.
e Rename the file to PlayMakerGlobals.asset and move it to the Assets/PlayMaker/Resources folder.

If you project already contains some global PlayMaker variables and events (a PlayMakerGlobals.asset file exists in
the folder Assets/PlayMaker/Resources), you can merge these with our demo's Globals using PlayMaker's Import
Globals tool: go to menu PlayMaker > Tools > Import Globals and select the PlayMakerGlobals.unitypackage in the
Assets/EasyMobile/Demo/PlayMakerDemo folder.

With the PlayMaker demo app, we perform the Easy Mobile initialization using a FSM in the
DemoHome_PlayMaker scene so you should always build this scene when using this demo app.

Requirements

Easy Mobile requires:

e Unity 5.5.5 or newer.
e iOS 8.0 or newer.
e Android 4.0 (API Level 14) or newer.



Advertising: Introduction

The Advertising module helps you quickly setup and show ads in your games. Here're some highlights of this module:
o Supports multiple networks

o This module allows showing ads from most of top ad networks: AdColony, AdMob, Chartboost, Facebook
Audience Network, Heyzap, ironSource, MoPub, Tapjoy and Unity Ads
o Even more networks can be used via mediation service provided by AdMob, Heyzap, ironSource, MoPub or
Tapjoy
e Using multiple networks in one build

o It's possible to use multiple ad neworks at the same time, e.g. use AdMob for banner ads, while using
Chartboost for interstitial ads and Unity Ads for rewarded ads
o Different configurations for different platforms are allowed, e.g. use Unity Ads for rewarded ads on Android,
while using Chartboost for that type of ads on iOS
e Automatic ad loading

o Ads will be fetched automatically in the background; new ad will be loaded if the last one was shown

The table below summarizes the ad types supported by Easy Mobile for each ad network.

Ad Network Banner Ad Interstitial Ad Rewarded Ad Mediation
AdColony @® ®

AdMob @ O ® ®
Chartboost ® O

Audience Network ® ® @

Heyzap @® @® @® @®
ironSource ® ® @ O

MoPub ® ® O @

Tapjoy @® @® ®

Unity Ads @® ®

Ad Placements

An ad placement in Easy Mobile represents a specific "location" in your app where an ad is served. For example the
"GameOver" placement can be defined as the "location" in your app where a game is over, and an ad is served. An ad
placement is normally associated with an ad unit with a specific ad ID. Easy Mobile has several built-in ad placements
including a default placement and other placements such as "Startup”, "HomeScreen", "MainMenu", etc. You can also
create more custom ad placements to suit your needs.

Grouping ads into placements provides an intuitive way to organize ads in your app and simplifies the implementation
of flexible and sophisticated advertising strategies. It allows having more than one unit of a certain ad type (banner,
interstitial or rewarded ad) of the same ad network. For example, you can use the default placement to show normal
AdMob interstitial ads (and get paid!), while having a "Startup" placement to show AdMob interstitial house ads (at app
launch), thus creating a free cross-promotion system for your apps!


https://support.google.com/admob/answer/3212684?hl=en

Ad placements don't complicate things though. If you only need a basic usage of advertising, you can simply
ignore all placement stuff when working with the Advertising API, and Easy Mobile will automatically use the
default placement. Therefore, it's only necessary to provide ad IDs associated with the default placement when
setting up ad networks (some ad networks may not even require such IDs). All other ad placements are optional
and you only need to configure if you want to use any of them.

Default vs Non-Default Ads

A default ad of a certain type is the ad unit that belongs to the default network for that ad type at the default
placement. For example, if the default interstitial network for the current platform is AdColony, then the AdColony
interstitial ad at the default placement is the default interstitial ad. The rest are considered non-default interstitial ads.
The same is true for banner and rewarded ads.

GDPR Compliance

We recommend you to read the Privacy chapter first to gain a comprehensive understanding of the tools and
resources offered by Easy Mobile to help your app get compliant with GDPR, including the consent dialog and

the consent management system.

Advertising is one of those services affected by the GDPR, because most ad providers collect user data to serve
personalized ads. Most ad networks recommend requesting user consent for such data usage and serve personalized
or non-personalized ads accordingly. Easy Mobile provides a native, multi-purpose dialog for collecting user consent
for all ad networks or each individual ad network, as well as other relevant services, in a flexible manner. It also allows
you to flexibily communicate the collected consent (apply the consent) to the Advertising module either at the module
level or the vendor level.

Allowing the user to provide and manage consent for all services via a single interface (dialog) is advisable in
terms of user experience, because the user may find it irritating being presented multiple dialogs asking
consent for various things.

Consent Description Priority
Module Common consent applied to all supported ad networks in the Advertising Lower
consent module

Ve Consent applied to an individual ad network, e.g. AdMob Higher
consent

Consent is normally applied during the initialization of an ad network. Therefore it is important to collect consent
before initializing ad networks. Practically this means collecting consent before initializing the Easy Mobile runtime. If
there's a vendor consent specified for the current network, it will be used. Otherwise the module consent will be used.
If neither was specified, the global consent will be used. In case no consent provided at all levels, the ad network
carries out its initialization without applying any consent and will serve personalized ads (the "pre-GDPR" behavior).
The table below summarizes how Easy Mobile configures each network according to the provided consent.

Ad Consent Granted Consent Revoked Consent
Network Unknown
AdColon Setting GdprRequired to 'true' and Setting GdprRequired to 'true' and Do

y GdprConsentString to "1" GdprConsentString to "0" nothing

. . . Setting "npa" key to "1" when
AdMob Lo ey | 6 Berviie persehl e constructing AdRequest to serve non- b .
ads as normal) . nothing
personalized ads

Chartboost Calling Calling Do



Chartboost

Audience
Network

Heyzap

ironSource

MoPub

Tapjoy

Unity Ads

Reference:

Chartboost.restrictDataCollection(false);

Do nothing

Calling
HeyzapAds.SetGdprConsent(true);

Calling IronSource.setConsent(true);

Calling
MoPub.PartnerApi.GrantConsent();

Calling Tapjoy.SetUserConsent("1");

Calling SetGdprMetadata(true);

Chartboost.restrictDataCollection(true);

Do nothing

Calling
HeyzapAds.SetGdprConsent(false);

Calling IronSource.setConsent(false);

Calling
MoPub.PartnerApi.RevokeConsent();

Calling Tapjoy.SetUserConsent("0");

Calling SetGdprMetadata(false);

e AdColony: https://github.com/AdColony/AdColony-Unity-SDK-3/wiki/GDPR
e AdMob: https://developers.google.com/admob/unity/eu-consent
e Chartboost: the C# source code of the Chartboost SDK for Unity
e Facebook Audience Network: https://developers.facebook.com/docs/audience-network/unity/ (the documentation

doesn't mention anything about consent)

nothing
Do
nothing

Do
nothing

Do
nothing

Do
nothing

Do
nothing

Do
nothing

e Heyzap: https://developers.heyzap.com/docs/unity_sdk_setup_and_requirements#step-7-adding-user-consent

e ironSource: https://developers.ironsrc.com/ironsource-mobile/android/advanced-settings/#step-1

e MoPub: https://developers.mopub.com/docs/unity/gdpr/

e Tapjoy: https://dev.tapjoy.com/sdk-integration/

e Unity Ads: https://unityads.unity3d.com/help/legal/gdpr


https://developers.google.com/admob/unity/eu-consent
https://developers.facebook.com/docs/audience-network/unity/
https://developers.heyzap.com/docs/unity_sdk_setup_and_requirements#step-7-adding-user-consent
https://developers.ironsrc.com/ironsource-mobile/android/advanced-settings/#step-1
https://developers.mopub.com/docs/unity/gdpr/
https://dev.tapjoy.com/sdk-integration/
https://unityads.unity3d.com/help/legal/gdpr

Settings

Advertising: Settings

To use the Advertising module you must first enable it. Go to Window > Easy Mobile > Settings, then click the toggle

to the right-hand side of the Advertising tab to enable and start configuring the module.

Automatic Ad Loading

Automatic ad loading is a handy feature of the Advertising module. It regularly checks for the availability of ads, and
performs loading if an ad hasn't been loaded or was consumed. With automatic ad loading, you can forget about
loading ads manually and rest assure that ads are always ready whenever they are needed. You can configure this
feature in the AUTO AD-LOADING CONFIG section.

21



~ AUTO AD-LOADING -

Auto Ad-Loading Mode | Load All Defined Placements =
Ad Checking Interval - |10 |
Ad Loading Interval w, |20 :

e Auto Ad-Loading Mode:
o None: disable the auto ad-loading, you can load ads manually from script, see Manual Ad Loading
o Load Default Ads: only default ads are loaded automatically, non-default ads must be loaded manually
o Load All Defined Placements: this mode allows loading of all placements (default and non-default) that are
added in the module settings, provided that the placements are well defined, meaning that each has a valid
associated ID (where applicable) and the corresponding SDK is imported; this is the recommended option
e Ad Checking Interval: change this value to determine how frequently the module should perform ads availability
check, the smaller value the more frequently
e Ad Loading Interval: the minimum duration required between two ad loading requests

Default Ad Networks

You can select default ad networks for each platform in the DEFAULT AD NETWORKS section. You can have
different networks for different ad types and different selections for different platforms. If you don't want to use a
certain type of ad, simply set its network to None.

f_:,_i DEFALLT AD NETWORKS ~
¥Yios
Banner Ad Network | Ad Mab =
Interstitial Ad Network | Chartboost ™
Rewarded Ad Network | Unity Ads s
¥ Android
Banner Ad Network | Ad Mab =
Interstitial Ad Network | Ad Mab :]
Rewarded Ad Network | Unity Ads s |

& Default ad network AdMob has no SDE, Please import its plugin.

& Default ad network Chartboost has ne SDK, Please import its plugin.

& Default ad network UnityAds has no SDE. Please import its plugin,

Pay attention to the warnings and import the required plugins if you haven't already.



Advertising: Settings | Setup AdColony

Creating AdColony Apps and Zone Ids

To show ads from AdColony you need to create apps and ad zones in its clients portal. To access the clients portal,
create an account and login to AdColony page.

In the clients portal, select MONETIZATION tab, then select the Apps sub-tab and click the Setup New App button.

HOME MONETIZATION ADVERTISING SUPPORT B

Apps App Reports Download SDK
Q, Search Filter Back to Top &

Search by App Name Platform Date Range

Q All v - This Month + + Setup New App

In the opened page enter the required information for your new app, e.g. app name, platform and location. You can
also select the ad types that you would like to allow in your app. Hit Create when you're done, your app will be created
and you'll be redirected back to the Apps page. Select your newly created app to reveal its information, which looks

similar to the picture below. Note the AdColony App ID as we will use it later.

e Easy Mobile Demo (Unreleased)

Basic App Information

App Name Easy Mobile Demo (Unreleased)
Platform ’
Status 3 Zones
[
Price Free
Categories Casual,

AdColony App ID app770e6afad SN

Now your app is ready, the next step is to create ad zones for it. Click the Setup New Ad Zone at the bottom of the
app edit page to create a new ad zone.

In the Integration section, give your ad zone a name, optional notes and set its as active. Note the Zone ID as we'll
use it later.

The Zone ID will appear once you save your new ad zone.


https://www.adcolony.com/

Setup AdColony

Integration

Zone is active?

o Yes () No

Zone IDvz9494457a0750000000

Mame your ad zone

rewarded-ad

Special notes on this zone

Dedicated zone for rewarded ads

In the Creative Type section, select the Video option.

Creative Type

WARNING: Creative type for a zone cannot be change once the zone is created
+ Video

Display (In Testing)

In the Zone Type section, select Preroll/Interstitial if you want to use this zone for interstitial video ads. Otherwise,
select Value Exchange/V4VC to use it for rewarded ads.

Zone Type

~ Preroll/Interstitial @
© Value Exchange/V4VC @

VAVC Secret Key: vAve725c833860D

Client Side Only?

D Yes () No
Virtual Currency Name Daily Max Videos per User Reward Amaount
CfEd!tS 20 Must be greater than O 1 Must be greater than 0
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In the Options section, you can set a daily cap or a session cap to limit the number of ads served to a user per day or
per session, respectively. In the Development section, you can choose to show test ads only (for debug purpose),
don't forget to disable this option when your app is released.

Options
Daily play cap Session play cap
0 0 e

0
Override App-Level Settings

Development
Show test ads only (for dev or debug)? — Yes ONo

Now your new ad zone is fully configured, click the Save button to save it. Repeat the process to create other ad
zones to suit your needs. Typically, you'd want to have 2 ad zones, one for interstitial ads and one for rewarded ads. If
you're targeting multiple platforms, create a new app for each platform, and for each app create the necessary ad

zZones.

Importing AdColony Plugin

To have your Unity app work with AdColony you need to import the AdColony plugin for Unity. In the ADCOLONY
section of the Advertising module, click the Download AdColony Plugin button to to open the download page.
Download the plugin and import it to your project.

o
-~ ADCOLONY

& AdColany plugin not found, Please dewnload and import itte show ads from AdColany,

I Download AdCelony Plugin

Configuring AdColony

After importing the AdColony plugin, the ADCOLONY section will be updated as below.


https://github.com/AdColony/AdColony-Unity-SDK-3

o
-~ ADCOLONY

'f_[;' AdColany plugin was imparted.

Download AdCelony Plugin

App ID

¥ App ID
i0s ID
Android ID

Default Placement
¥ Interstitial Ad
05 1D
Android ID
Rewarded Ad
05 1D
Android ID

Custom Placements
b Interstitial Ads
b Rewarded Ads

Ad Settings

Ad Orientation | Ad Crientation All
Show Rewarded Ad PrePopup ||

Show Rewarded Ad PostPopup ||

A

App ID

In this section you can enter the app ID created in the AdColony clients portal for each platform.

Default Placement

Here you can enter the ad IDs to be used with the default placement for each platform. These are the only ad IDs
required if you are not using any custom placements in your app. Note that you only need to provide IDs for the ad
types you want to use, e.g. if you only use AdColony interstitial ads you can leave the rewarded ad IDs empty.

Custom Placements

Here you can optionally enter the ad IDs associated with non-default ad placements to be used in your app. You can
have an arbitrary number of custom placements and can use built-in placements or create new placements for your
needs.

Ad Settings

This section includes other settings including:

e Ad Orientation: the default ad orientation of your app.
e Show Rewarded Ad PrePopup: whether to show a popup before a rewarded ad starts.
e Show Rewarded Ad PostPopup: whether to show a popup after a rewarded ad has finished.



Setup AdColony
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Advertising: Settings | Setup AdMob

Importing AdMob Plugin

To show ads from AdMob you need to import the Google Mobile Ads plugin. In the ADMOB section, click the
Download Google Mobile Ads Plugin button to to open the download page. Download the plugin and import it to your
project.

o
-~ ADMOEBE

Google Mobile Ads (AdMab) plugin net found. Please download and impart it to show ads
fram AdMob.

I Download Google Mobile Ads Flugin

Configuring AdMob

After importing the Google Mobile Ads plugin, the ADMOB section will be updated as below.

o
-~ ADMOEBE

'i_[‘_:l Google Maobile Ads (AdMab) plugin was imported.

l Download Google Mobile Ads Flugin

App ID

¥ App ID
i0s ID
Android ID

Default Placement
¥ Banner Ad
05 1D
Android ID
¥ Interstitial Ad
05 1D
Android ID
¥ Rewarded Ad
05 1D
Android ID

Custom Placements

¥ Banner Ads +
¥ Interstitial Ads +
¥ Rewarded Ads +

Targeting Settings
Tag For Child Directed Treatmel| Unspecified
b Extra Options

A

Test Mode
Enable Test Mode ]
Test Device IDs ham =

Elerment 0



https://github.com/googleads/googleads-mobile-unity/releases

App ID

First you need to enter the required AdMob app ID for each platform. To find the App ID for your app follow the
instructions here.

Update your AndroidManifest.xml on Android platform

Apart from entering the app ID in the Advertising module settings, starting in version 17.0.0 of the Google
Mobile Ads SDK for Android, you as an AdMob publisher are required to add your AdMob app ID in your
AndroidManifest.xml file. The added element should look like below.

manifest
application
<!-- TODO: Replace with your real AdMob app ID -->
meta-data
android:name
android:value
application
manifest

You can either add this app ID to the Assets/Plugins/Android/AndroidManifest.xml file if you have one, or the
Assets/Plugins/Android/GoogleMobileAdsPlugin/AndroidManifest.xml file. In the latter case, you may need to
repeat the process if you re-import the GoogleMobileAds plugin.

To know if you're using the Android Google Mobile Ads SDK version 17.0.0 or newer, navigate to your
Assets/Plugins/Android folder and check the version of following files (in this screenshot we are having version

17.0.0, yours may be different).

| | com.google.android.gms.play-services-ads-17.0.0
| | com.google.android.gms.play-services-ads-hase-17.0.0
ﬁ com.google.android.gms.play-services-ads-lite-17.0.0

You can learn more about this requirement here.

Default Placement

Here you can enter the ad IDs to be used with the default placement for each platform. These are the only ad IDs
required if you are not using any custom placements in your app. Note that you only need to provide IDs for the ad
types you want to use, e.g. if you only use AdMob banner ads you can leave the interstitial and rewarded ad IDs
empty.

If you're not familiar with AdMob, follow the instructions here to create ad units and obtain the ad IDs; an ad ID
should have the form of ca-app-pub-0664570763252260XXXXXXXXXXX.

Custom Placements

Here you can optionally enter the ad IDs associated with non-default ad placements to be used in your app. You can
have an arbitrary number of custom placements and can use built-in placements or create new placements for your
needs.

Targeting Settings

You can provide targeting information for your app in the Targeting Settings section. These settings will be applied to
all AdMob ad requests in your app. You can learn more about AdMob ad targeting here.

e Tag For Child Directed Treatment: indicates whether you want Google to treat your content as child-directed
when you make an ad request for the purposes of Children's Online Privacy Protection Act (COPPA)


https://support.google.com/admob/answer/6232340?hl=en
https://ads-developers.googleblog.com/2018/10/announcing-v1700-of-android-google.html
https://support.google.com/admob/answer/2773509
https://developers.google.com/admob/unity/targeting

Setup AdMob

e Extra Options: extra settings in form of key value pairs, e.g. for setting "max_ad_content_rating"

Using AdMob with the Designed for Families program

According to this article, apps that join in to Google Play's Designed for Families program can fall into two
categories:
e Primarily child-directed apps: if your app is admitted to the program as a primarily child-directed app,
"AdMob will automatically begin serving Designed for Families-compliant ads for all ad requests coming
from the app", which means you don't need to specify the child directed setting in your app.

o Mixed-audience apps: if your app targets both child and adult audiences, you need to set the extra key
"is_designed_for_families" to frue and tag your app for child-directed treatment. You can do that in Easy

Mobile settings as below.

Targeting Settings

Tag For Child Directed Treatment [ ves :]
¥ Extra Options +
Key |is_designed_for_families | Value |true| |=

Overriding AdMob targeting settings in script

You can override AdMob targeting settings in script by setting the property
EM_Settings.Advertising. AdMob. TargetingSettings. All subsequent ad requests will be sent with the new

settings.

Test Mode

To enable AdMob's test mode, simply check the Enable Test Mode option and enter the IDs of your testing devices

into the Test Device Ids array.

Test Mode

Enable Test Mode [

Test Device IDs + -
Element 0 [219436D312DE3320727941 ]
Elernent 1 [e29cdogog7asfzgaesdd7fs ]

You can find the ID of your test device by building and running the Easy Mobile demo app on that device.
Remember to add the EasyMobile prefab to the DemoHome scene before starting the build.
Android device ID

e In Unity, build the Easy Mobile demo app for Android platform
e Install and run the demo app on your testing device
e Open Terminal (Mac) or Cmd (Windows) and type in

adb logcat -s Ads

(if you're on Windows, you may need to add the Android SDK path to the Windows System PATH)

e In the demo app, select ADVERTISING and then click the SHOW BANNER AD button
e Observe the output logcat in the Terminal/Cmd and locate a line similar to the one in the following image,

the value between the double quotes is your device ID

I Ads : Starting ad request.
I Ads : Use AdRequest.Builder.addTestDevice("219436D312DE332072794000'] to get test ads on this device.
iOS device ID
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https://support.google.com/admob/answer/6223431?hl=en
https://developer.android.com/distribute/googleplay/families/about.html
https://www.howtogeek.com/118594/how-to-edit-your-system-path-for-easy-command-line-access/

e In Unity, build the Easy Mobile demo app for iOS platform
e Open the generated project in Xcode and run it on your testing device
e Type 'google' into the filter box of the Xcode Console, and find your device ID between the double quotes

as highlighted in the following image

@ 2 | @ easymobile

2017-85-84 13:53:33.613316+870@ ecasymobi s pas Gl il G el et
this device, call: request.testDevices =
GoogleMobileAds.Api.InterstitialGoogleMoSTICAOS. 105, o ETC T of: 4
idReceiveAdCallback({IntPtr)

GoogleMobileAds.Api.RewardBasedVideoAd: <RewardBasedVideoAds=m__1(0Object,
AdFailedTolLoadEventArgs)

GoogleMobileAds.i05.RewardBasedVideoAdClient :RewardBasedVideoAdDidFailToReceiveAdwWit
hErrorCallback(IntPtr, String)

GoogleMobileAds. Api.RewardBasedVideoAd: <RewardBasedVideoAd>m__8(0bject, EventArgs)
GoogleMobileAds.1i05.RewardBasedVideoAdClient :RewardBasedVideoAdDidReceiveAdCallback(
IntPtr)

All Output 2 (® google o| W OO

Notes on Rewarded Ads

AdMob only allows one rewarded ad to be loaded at a time. That means the loaded ad must be consumed before
another ad can be loaded. If you register multiple placements for AdMob rewarded ad, only one of them can be used
at a time. The automatic ad loading feature favors the rewarded ad at the default placement and will always load it
first.

Building Notes

The Google Mobile Ads plugin for Unity employs CocoaPods to automatically import the necessary frameworks to the
generated Xcode project when an iOS build is performed in Unity. Therefore you need to install CocoaPods to your
Mac: please go to https://cocoapods.org/ for install instructions, as well as for more information about CocoaPods.
Note that you only need to install CocoaPods, everything else will be done automatically by the Google Mobile Ads
plugin.

Recent versions of the Google Play Services Resolver (that is bundled with Easy Mobile) handles the

installation of CocoaPods for you automatically.

When building for iOS in Unity, CocoaPods will automatically create an Xcode workspace (with .xcworkspace
extension) in the generated Xcode project. You should always open this workspace instead of the normal project file
(with .xcodeproj extension).


https://cocoapods.org/

Setup AdMob

» [ build
BE Classes
Bl Data
Info.plist
B LaunchScreen-iPad.png
LaunchScreen-iPad.xib
= LaunchScreen-iPhone.xib
B LaunchScreen-iPhonelLandscape.png
B LaunchScreen-iPhonePortrait.png
» [ Libraries
B MapFileParser
MapFileFarser.sh
Podfile
Podfile.lock
» [ Pods
[ Unity-iPhone
[ Unity-iPhone Tests
5 Unity-iPhone. xcodeproj
_@ Unity-iFhone. xcworkspace |
UnityAds
[ UnityData.xcassets

L

Yy

v
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Advertising: Settings | Setup Chartboost

Importing Chartboost Plugin

To show ads from Chartboost you need to import the Chartboost plugin for Unity. In the CHARTBOOST section, click
the Download Chartboost Plugin button to open the download page. Download the plugin and import it to your project.

o
-~ CHARTBOOST

Chartboost plugin not found. Please download and import it to show ads from
Chartboost.

I Download Chartboost Plugin

Configuring Chartboost

After importing Chartboost plugin, the CHARTBOOST section will be updated as below.

o
-~ CHARTBOOST

'i_[‘_:l Chartboost plugin was imported,

l Download Chartboost Plugin

Placements
Easy Mobile's ad placements are directly translated inte Chartboost's ad locations of the same name. Mo need to
declare any associated IDs,

Setup

| Chartboost can be setup in dedicated window.

l Setup Chartboost

Placements

An Easy Mobile's ad placement will be directly translated into a Chartboost's ad location with the same name in
runtime. Therefore if you want to specify a location when showing a Chartboost ad, simply show the ad with an ad
placement of the same name. There's no need to declare any ad IDs to be associated with the placements.

Setup

Click the Setup Chartboost button to open Chartboost's dedicated settings interface.


https://answers.chartboost.com/hc/en-us/articles/200780379

& |nspector

=

ChartboostSettings

,

Open |

|Add the Chartboost App Id and App Secret associated with this game |

i0s
App Id [7]:

App Signature [?]:

|CE_IOS_APP_ID

Coogle Play
App Id [?]:

| CE_IOS_APP_SIGNATURE |

App Signature [?]:

iCB_AN DROID_APP_ID

Amazon
App Id [7]:

| CE_ANDROID_APP_SIGNATURE

App Signature [?]:

|CE_AMAZON_APP_ID

Android Platform [?]:

| CE_LAMAZON_APP_SIGNATURE |

Android Platform [ Google Play ¢]
Enable Logging for Debug Builds
isLoggingEnabled -

Setup Android SDE

Provide the App IDs and App Signatures for your targeted platforms. Remember to click the Setup Android SDK

button if you're building for Android.

To obtain the App Id and App Signature you need to add your app to the Chartboost dashboard. If you're not
familiar with the process please follow the instructions here.

After adding the app, go to APP SETTINGS > Basic Settings to find its App ID and App Signature.

Chartboost 4

@ Buster's Boost

DASHBOARD

App Settings

App Nickname
Buster's Boost
Basic Settings
App Bundie ID (2
com.chartboost.apollo

App Oriantation

Portrait Lands!

Please select a default orienta

MARKETPLACE

cape

HELP

la

=L

App ID
5689b4418838092b63cf94f0

App Signature
edabc1cedad0318eddB4ad584e500534c985373c

ation for this app: Official Name

Buster's Boost

Android READ_PHONE_STATE Permissions

The Chartboost SDK includes the READ_PHONE_STATE permission on Android, to "handle video playback when
interrupted by a call", as stated in its manifest. READ_PHONE_STATE permission requires your app to have a

privacy policy when uploaded to Google

Play. Since this permission is not mandatory to run the Chartboost SDK, you

can safely remove it if you are not ready to provide the required privacy policy. To remove the permission, open the
AndroidManifest.xml file located at Assets/Plugins/Android/ChartboostSDK folder, then delete the corresponding line

(or comment it out as below).


https://answers.chartboost.com/hc/en-us/articles/200797729-Adding-Your-First-App-and-Campaign-

Setup Chartboost

<!-- Exclude the READ_PHONE_STATE permission because it requires a privacy policy -->
<!-- <uses-permission android:name="android.permission.android.permission.READ_PHONE_STATE" /> -->

Testing Notes

Please note that to show ads from Chartboost you need to either create a publishing campaign or enable the Test
Mode for your app.

e To create a publishing campaign follow the instructions here
e To enable Test Mode follow the instruction here

Building Notes

If the version of the imported Chartboost plugin includes a copy of android-support-v4.jar, it may create build errors on
Android platform due to conflict with the com.android.support-v4 library that exists in the Assets/Plugins/Android
folder.

To avoid this issue, remove the android-support-v4.jar in Assets/Plugins/Android/ChartboostSDK/libs/ folder.

» Plugins » Android » ChartboostSDK » libs
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https://answers.chartboost.com/hc/en-us/articles/204930539-Creating-a-Publishing-Campaign
https://answers.chartboost.com/hc/en-us/articles/200780549-Test-Mode

Advertising: Settings | Setup Audience Network

Importing Facebook Audience Network Plugin

To show ads from Facebook Audience Network you need to import the Facebook Audience Network plugin for Unity.
In the FACEBOOK AUDIENCE NETWORK section, click the Download FB Audience Plugin button to open the
download page. Download the plugin and import it to your project.

~ FACEBOOK AUDIENCE NETWORK

Facebook Audience Metwork plugin not found. Please download and import it to show ads from FB
Audience.

l Download FB Audience Plugin

Configuring Facebook Audience Network

After importing Facebook Audience Network plugin, the FACEBOOK AUDIENCE NETWORK section will be updated
as below.

f—j_z FACEEOQOK AUDIENCE NETWORK

If_[;I Facebook Audience Network plugin was impaorted.

Download FB Audience Network Plugin

Default Placement

¥ Banner Ad
05 1D
Android 1D

¥ Interstitial Ad
05 1D
Android 1D

¥ Rewarded Ad
05 1D
Android 1D

Custom Placements
b Banner Ads

b Interstitial Ads

b Rewarded Ads

Test Mode
Enable Test Mode [
Test Device IDs =

Element 0

Default Placement

Here you can enter the ad IDs to be used with the default placement for each platform. These are the only ad IDs
required if you are not using any custom placements in your app. Note that you only need to provide IDs for the ad
types you want to use, e.g. if you only use Audience Network banner ads you can leave the interstitial and rewarded


https://developers.facebook.com/docs/audience-network/unity

Setup Audience Network

ad IDs empty.

To create Audience Network ad units and get the IDs, follow the instructions here.

Custom Placements

Here you can optionally enter the ad IDs associated with non-default ad placements to be used in your app. You can
have an arbitrary number of custom placements and can use built-in placements or create new placements for your
needs.

Test Mode

To enable test mode, simply check the Enable Test Mode option and enter the test device IDs.

Test Mode
Enable Test Mode [
Test Device IDs oot

Element O [ ]

Facebook Audience Network testing instructions can be found here.

If your project is still in development, we strongly recommend setting up the testing mode properly to avoid "No
fill" error, especially on iOS.

Android device ID

The device ID is printed in the device logcat, you can follow the instructions in the Setup AdMob/Test Mode
section to find it. Note that you will need to import the Google Mobile Ads plugin, which is quite awkward if you
don't use it in your project. However the Audience Network documentation is lacking on this detail and using the
AdMob plugin is the simplest workaround we know for now.

iOS device ID
Follow these steps to find the device ID:

e In Unity, build your project for I0S platform.

e Open the generated project in XCode.

e Open the UnityAppController.mm file.

e Import the FBAudienceNetwork header into that file.

#import <CoreGraphics/CoreGraphics.h>
#import «QuartzCore/QuartzCore.h>
#import <QuartzCere/CADisplaylLink.h>
#import <Availability.h>

11 #import <FBAudienceMetwork/FBAudienceNetwork.hs

#import <OpenGLES/EAGL.h>

#import <OpenGLES/EAGLDrawable.h>
#import <OpenGLES/ES2/gl.h>
#import <OpenGLES/ES52/glext.h>

e Add this line [FBAdSettings setLoglLevel:FBAdLogLevellLog]; into the init method, before the return
statement.
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https://www.facebook.com/help/publisher/1195459597167215
https://developers.facebook.com/docs/audience-network/testing

Setup Audience Network

ene o m UnityAppController.mm

B8 < > [B unity-iPhone ) [ Classes ) m UnityAppContraller.mm ) [ -init

%0 = (id)init

N oA

L} if ((self = [super init]})

93 {

94 f/ due to clang issuwes with generating warning for overriding deprecated methods

95 ff we will simply assert if deprecated methods are present

9 /f MB: methods table is initied at load (before this call), so it is ok to check for override

9 NSAssert(![self respondsToSelector: @selector(createUnityViewImpl])],

98 @"createUnityViewImpl is deprecated and will not be called. Override createUnityView"

¥ IH

100 NSAssert(![self respondsToSelector: @selector(createViewHierarchyImpl)],

1M @"createViewHierarchyImpl is deprecated and will not be called. Override
willStartWithViewController"

102 )i

103 NSAssert(![self respondsToSelector: @selector(createViewHierarchy)],

104 @"createViewHierarchy is deprecated and will not be implemented. Use createUI”

105 ¥;

106 }

107 [FBAdSettings setlLoglevel:FBAdLoglevellogl;

108 return self;

109 }

111 - (void)setWindow:(id)object {}

112 = (UIWindows)window { return _window; }

113

114

115 = (void)shouldAttachRenderDelegate {}

116 - (void)preStartUnity {

e Run the app on your device and find the ID in the XCode console.
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E = [ o~ L Ll 5o <« e ammohile

| Auto 3 @

12 libdispatch.dylib
@x8000000183aT6208 <redacted> +
13 libdispatch.dylib
8x0800888183aTs0ac <redacted> +
14 Foundation
8x06800000184b4bATE <redacted> +
15 libdispatch.dylib
@x8oeeeedlBlaeceals <redacted> +
16 1libdispatch.dylib
8x8e80889183aT6Te8 <redacted> +
17 libdispatch.dylib
@x00800080183aT580c <redacted> +
18 1libdispatch.dylib
8x0082800183aThecfs <redacted> +
19 libdispatch.dylib
8x0808000183aTha38 <redacted> +
20 libsystem_pthread.dylib
8x0000000183d9786¢c _pthread_wgthread + 1268
21 libsystem_pthread.dylib
BxPBA00B8183d96béc start_wgthread + &
Setting up 1 worker threads for Enlighten.
Thread -» id: 16d13380@ -> priority: 1
UnloadTime: 3.542875 ms
201B-84-14 16:88:83.0956147+0788
easymobile[4631:2441662]
[FBAudienceNetworkLog/FBAdSettings: 149
thread:4] When testing your app with
Facebook's ad units you must specify the
device hashed ID to ensure the delivery of
test ads, add the following code before
loading an ad: [FBAdSettings
addTestDevice : 0" b&d2839daec2382dB8e9936d feFad
57ciZachafed"]
2018-04-14 16:80:03.096230+8700
easymobile[4631:2441662]
[FBAudienceNetworkLog/FBAdSettings:15@
thread:4] Test mode device hash:
b4d2839daec2382dBe?9346dfePadE67c12achafcd
20818-84-14 16:88:83.108433+0788
easymobile[4631:2441498] [MC] System group
container for
systemgroup.com.apple.configurationprofiles
path is [private/var/containers/Shared/
SystemGroup/
systemgroup.com.apple.configurationprofiles
2018-24~14 146:88:83.1008999+8788
easymobile[4631:2441498] [MC] Reading from

All Output & @ JgA ()

EEREEEEE R

Building Notes

Please follow build instructions here: Android, iOS.

On Android, if you encounter the "Unable to convert classes into dex format" issue when building your game,

there might be duplicated files in your project and you need to delete the support-xxx files in the

AudienceNetwork folder.

@ Project

| Create 'i E'l
¥
¥ &l Plugins
'?ﬁ“::“ ¥ &l Plugins
¥ & Android

& ads-release

4 exoplayer-core
E ] llllh‘l‘l:"““‘l

* & ios

=| Audience Network README

¥ & EasyMobile
* Gl Demo

@ Project

)| 4

| Create *‘ ’iq

» i PlayServicesResolver

com.android

com.android.supp

android.arch.core.common-1.0.0
android.arch lifecycle.commen-1.0.0
i android.arch.lifecycle.runtime-1.0.0
port.support-annotations-26.1.0
com.android.support.support-compat-26.1.0
com.android.support.support-core-ui-26.1.0
com.android.support.suppor e-utils-26.1.0
com.android.support.support-fragment-26.1.0
ort.support-media-compat-26.1

com.android.support.support-v4-26.1.0

com.sglib.easymobile.easy-mobile-1.0.3



https://developers.facebook.com/docs/audience-network/unity#android
https://developers.facebook.com/docs/audience-network/unity#ios
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Advertising: Settings | Setup Heyzap

Importing Heyzap Plugin

To show ads from Heyzap you need to import the Heyzap plugin for Unity. In the HEYZAP section, click the Download
Heyzap Plugin button to open the download page.

o
=~ HEYZAP (FYBER] ~

‘ & Heyzap plugin not found. Please download and import it to show ads from Heyzap,

[ Download Heyzap Flugin ]

In the download page select your preferred networks to use with Heyzap mediation. The Heyzap dynamic
documentation will update automatically to reflect your selections.

Network Selection:

heyZap AdColony v AdMob

2 AppLovin Chartboost | v/ [35eR00K
HyprMX InMobi Tapjoy
v/ UnityAds v Vungle

Follow the instructions provided by Heyzap to download and import its plugin as well as other required 3rd-party
plugins. Also go through the Integration Notes section below to avoid problems that may occur during the integration
of 3rd-party networks.

If you haven't already, use Heyzap's Integration Wizard to setup the 3rd-party networks to use with mediation.

Configuring Heyzap

After importing Heyzap plugin, the HEYZAP section will be updated as below.


https://answers.chartboost.com/hc/en-us/articles/200780379
https://developers.heyzap.com/integration_wizard

HEYZAP (FYBER)

:-r;: Heyzap plugin was imported.

Download Heyzap Flugin

Publisher ID
Heyzap Fublisher ID

Placements

Easy Mobile's ad placements are directly translated inte Heyzap's ad tags using placement name, Mo need to
declare any associated IDs,

Test Mode
Show Heyzap Test Suite ]

Publisher ID

Here you can enter the required publisher ID to the Heyzap Publisher ID field. This ID can be found in the Account
Details page in the Heyzap dashboard.

Placements

An Easy Mobile's ad placement will be directly translated into a Heyzap's ad tag that is same to the placement name
in runtime. Therefore if you want to specify a tag when showing a Heyzap ad, simply show the ad with an ad

placement whose name is the tag you want to use. There's no need to declare any ad IDs to be associated with the
placements.

Test Mode
The Heyzap plugin comes with a convenient Test Suite that you can use to test the operation of each mediation
network. To use this Test Suite, simply check the Show Heyzap Test Suite option in the Test Mode section.

Below is the Test Suite interface on iOS (it's similar on Android).

iPhone 6 - iPhone 6 /i0S 9.3 (13£230) iPhone 6 - iPhone 6 /i0S 9.3 (13£230)

iPhone 6 - iPhone 6 /i0S 9.3 (13£230)
You can skip this video in 1 seconds.

Done Mediated Networks < Mediated Networks UnityAds

Interstitial Rewarded

Show Ad —

Fyber Version 8.5.0
Successfully Integrated
AdColony
AppLovin
Facebook Audience Network
UnityAds _
Bad / Missing Credentials
AdMob @

No SDK Detected

Chartboost ©)
HyprMx ©)
UnityAds 1.5.5-r2
Inmobi (\D Supported ad formats: Interstitial Rewarded

A rewarded ad available

Vungle

v

©

This video ends in 21 seconds.


http://blog.heyzap.com/post/102474751663/introducing-ad-tags

Mediation Notes

This section discusses some notes that you should take when using Heyzap mediation with various other networks.

If you use Heyzap's mediation feature with other networks (AdColony, AdMob, Chartboost, etc.), you should not
import the standalone-plugins of those networks, to avoid potential conflicts. Instead, import their corresponding

adapter packages provided at the Heyzap download page.

Facebook Audience Network (Android-specific)

The Facebook Audience Network package contains an android-support-v4.jar _file under Assets/Plugins/Android
folder. If you project already contains a support-v4-xx.x.x.aar file under that same folder, feel free to remove (or
exclude it when importing) the jar file or it will cause the "Unable to convert dex..." error when building due to duplicate
libraries.

AppLovin (Android-specific)

As instructed in the Heyzap documentation, you need to add the AppLovin SDK key to its AndroidManifest.xml file
located at Assets/Plugins/Android/AppLovin folder. Simply add the following line inside the <application> tag in the
manifest, replacing YOUR_SDK_KEY with your actual AppLovin SDK key.

This manifest also includes the READ_PHONE_STATE permission, which requires your app to have a privacy policy
when uploaded to Google Play. This permission is not mandatory to run the AppLovin SDK, therefore you can safely
remove it if you are not ready to provide the required privacy policy. To remove the permission, simply delete the
corresponding line from the manifest or comment it out as below.

The minSdkVersion Problem (Android-specific)

The current Heyzap SDK requires a minSdkVersion of 10, while some other 3rd-party plugins may require a version of
11 or above. If you get a build error including this line

Unable to merge android manifests...

and this line

Main manifest has but library uses minSdkVersion='y'

where x <y, it means you need to increase the minSdkVersion of the app. To do so go to Edit > Project Settings >
Player, then select the Android settings tab and increase its Minimum API Level to the required one (which is 'y' in this
example).
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Advertising: Settings | Setup ironSource

Importing ironSource Plugin

To show ads from IronSource you need to import the IronSource plugin. In the IRONSOURCE section, click the
Download IronSource Plugin button to to open the download page. Download the plugin and import it to your project.

o
=~ IRONSOURCE s

‘ & IronSource plugin not found. Flease download and import it to show ads from lronSource.

[ Download IronSource Plugin ]

Configuring ironSource

After importing the ironSource plugin, the IRONSOURCE SETUP section will be updated as below.

s
=~ IRONSOURCE ~

I:_i) IronSource plugin was imported.

[ Download IronSource Plugin ]

App Key

¥ App Key
i0S ID | |
Android ID | |

Placements

Easy Maobile’s ad placements are directly translated into ironSource’s ad placements of the same name. No
need to declare any associated 1Ds.

Advanced Settings
Use Advanced Settings [

Segment Name
Age

Gender

]

Level
Is Paying

User Creation Date

elle|[][=

lapt
P Custom Params

App Key
First you need to provide the app key for each platform.

Go to the ironSource dashboard to setup your app and get the key. Then follow these instructions to setup
mediation networks for your project.

Placements


https://developers.ironsrc.com/ironsource-mobile/unity/unity-plugin/#step-1
https://platform.ironsrc.com/partners/tour
https://developers.ironsrc.com/ironsource-mobile/unity/mediation-networks-unity/#step-1

Easy Mobile's ad placements will be directly translated into ironSource's placements of the same name in runtime. If
you want to specify a non-default placement when showing an ironSource ad, simply show the ad with one of Easy
Mobile's built-in placements or create a new placement for your needs. There's no need to declare any ad IDs to be
associated with the placements.

Note that the placements you use with Easy Mobile must also exist on ironSource dashboard, otherwise you
have to create them on the dashboard before using. If you show an ad with an undefined placement (the
placement doesn't exist on ironSource dashboard) the ad will be shown with the default placement but
corresponding ad event handlers will receive the undefined placement as argument, which may cause
unexpected behaviors.

Advanced Settings

ironSource has an additional feature called segment to help you serve ads that target a specific audience, further
information can be found here. To enable the advanced settings, simply check the Use advanced settings option and
enter required the fields.

Advanced Settings
Use Advanced Settings [

Segment Name
Age 0
Gender

Level

Is Paying

User Creation Date
lapt

elle|[][=

¥ Custom Params +
ey WValue -

Adding IronSourceEventsPrefab
It's important to add the IronSourceEventsPrefab found at folder Asset/IronSource/Prefabs to the first scene in your
app, otherwise ironSource ad events won't be received properly.

Mediation Setup Notes

In order to integrate 3rd-party mediation networks you need to perform two steps.

1. Set up the networks on the ironSource dashboard, follow these instructions.
2. Go to this page and download the mediation adapters that you want to integrate and import them into your Unity
Project.

The code to work with ironSource ads remains the same whether you setup mediation or not. All mediating
works are done by the ironSource SDK and the adapters.

AdMob Network (Android-specific)

As of version 4.2.1 of the ironSource’s adapter for AdMob, you may also need to import the Google Mobile Ads plugin
into your project to make it work properly.

Building Notes

Android


https://developers.ironsrc.com/ironsource-mobile/unity/additional-sdk-settings/#step-1
https://developers.ironsrc.com/ironsource-mobile/air/mediation-ad-networks-setup/#step-1
https://developers.ironsrc.com/ironsource-mobile/unity/mediation-networks-unity/#step-1
https://github.com/googleads/googleads-mobile-unity/releases

The ironSource's instructions for Android can be found here.

If you encounter the "No resource found that matches the given name (at 'value' with value
'@integer/google_play_services_version')" error, comment out the following lines (177, 178, 179) in the ironSource's
AndroidManifest that can be found at folder Assets/Plugin/Android/lIronSource/AndroidManifest.xml.

SettingsEditor.cs EM_Settings.cs EM_ScriptingSymbols.cs

pardHidden|orientation|s

jp-maic
andro ntent.action.VIEW

i0OS

The ironsource's intructions for iOS can be found here.


https://developers.ironsrc.com/ironsource-mobile/unity/unity-plugin/#step-2
https://developers.ironsrc.com/ironsource-mobile/unity/unity-plugin/#step-3

Advertising: Settings | Setup MoPub

Importing MoPub Plugin

To show ads from MoPub you need to import the MoPub plugin for Unity. In the MOPUB ADS section, click the
Download MoPub Plugin button to open the download page.

o
-~ MOPUB ADS

& MoPub plugin not found. Please download and import it to show ads from MoPub

I Download MoPub Plugin

Configuring MoPub

After importing the MoPub plugin, the MOPUB ADS section will be updated as below.

s
=~ MOPUB ADS

'i_[‘_:l MoPub plugin was imported.

l Download MoPub Plugin

Default Placement

¥ Banner Ad
05 1D
Android 1D

¥ Interstitial Ad
05 1D
Android 1D

¥ Rewarded Ad
05 1D
Android 1D

Custom Placements
b Banner Ads

b Interstitial Ads

b Rewarded Ads

Advanced Settings

Enable Location Passing [
Use Advanced Settings [
GDPR Consent

Auto Request Consent -
Force GDPR Applicable [

Default Placement

Here you can enter the ad IDs to be used with the default placement for each platform. These are the only ad IDs
required if you are not using any custom placements in your app. Note that you only need to provide IDs for the ad
types you want to use, e.g. if you only use MoPub banner ads you can leave the interstitial and rewarded ad IDs
empty.


https://github.com/mopub/mopub-unity-sdk

If you're not familiar with MoPub, please follow the instructions here to setup ad units for your app.

Custom Placements

Here you can optionally enter the ad IDs associated with non-default ad placements to be used in your app. You can
have an arbitrary number of custom placements and can use built-in placements or create new placements for your
needs.

Advanced Settings

e Enable Location Passing: check this if you want to enable location support for banners & interstitials.
e Use Advanced Setting: check this to enable MoPub's advanced settings, including initialization with custom
configurations, which can read more about here.

Advanced Settings

Enable Location Passing -

Use Advanced Settings [

Initialize Networks + -
Advanced Bidders + -
Mediation Settings + -

GDPR Consent

These settings are only useful if you want to use the GDPR support features provided by MoPub (and thus,
specific to MoPub only). If you're using the consent management system and consent dialog provided by Easy
Mobile to manage consent for the whole app you should ignore these settings.

GDPR Consent
Auto Request Consent al
Force GDPR Applicable [

e Auto Request Consent: check this box if you want the Mopub's GDPR consent dialog to show automatically
during initialization.

e Force GDPR Applicable: enable this to show the MoPub's GPDR consent dialog in all regions (useful for
debugging in development).

Building Notes

Android

MoPub plugin manually includes android-support-v4 jar, which is also required by EasyMobile (and many other
plugins) and will be fetched automatically by the Google Play Services Resolver, therefore you need to remove the
duplicated file before starting building to avoid errors due to duplication. Navigate to Plugins/Android/mopub/libs and
delete the files there.


https://developers.mopub.com/docs/ui/
https://developers.mopub.com/docs/unity/initialization/

Setup MoPub

£
E3
)
0
0
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0

i0OS
MoPub plugin requires iOS 8.0+ and Xcode 9.0+.

Mediation Notes

New mediation networks need to be configured and enabled correctly in the dashboard before you can show
them in your app. Follow this instruction to create and setup new networks.

In order to integrate a 3rd-party network, you will need to import that network Unity plugin (you can also use its native
plugin, but it can take some extra work, especially on iOS, so it's not recommended) and the MoPub adapter (which
can be download here).

Android

Place the adapter .jar files in Plugins/Android/mopub-support/libs folder (directly, not in any subfolder).

If the 3rd-party network plugin uses .jar files, place them in Plugins/Android/mopub-support/libs. If they're .aar files,
place them in Plugins/Android. For example:
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https://developers.mopub.com/docs/ui/networks/
https://github.com/mopub/mopub-unity-mediation

Setup MoPub

0
0
0
)
0
)
0
f
f

There may be conflicts between the AndroidManifest of these networks with the one of Mopub, causing build
errors. In such case you should update the AndroidManifest of those networks to solve the conflicts while

maintaining the one of Mopub.
iOS

Just keep all the imported files where they are.
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Advertising: Settings | Setup Tapjoy

Importing Tapjoy Plugin

To show ads from Tapjoy you need to import the Tapjoy Unity Plugin. In the TAPJOY section, click the Download
TapJoy Plugin button to to open the download page. Download the plugin and import it to your project.

o—
- TAPIOY s

‘ & Tapjoy plugin not found. Please download and import it to show ads from Tapjoy.

[ Download Taploy Plugin ]

Configuring Tapjoy

After importing the Tapjoy plugin, the TAPJOY section will be updated as below.

s
-~ TAPIOY ~

I:_LJ Tapjoy plugin was imported.

[ Download Tapjoy Plugin ]

Default Placement
¥ Interstitial Ad
i0s ID | |
Andraid ID [ |
¥ Rewarded Ad
i0S 1D [ |
Android 1D | |

Custom Placements
P Interstitial Ads
b Rewarded Ads

Auto Reconnect Settings
Auto Reconnect

4
Auto Reconnect Interval - 10

[ Open Tapjoy Setup Window ]
[ Generate Android Manifest ]

Before configuring Tapjoy placements in Easy Mobile settings, you have to create them on the Tapjoy
dashboard. If you're not familiar with the process, follow the instruction here. Basically, you'll need to:

Go to TapJoy dashboard and create a new app.

Setup at least one virtual currency.

Create some contents to show in your app.

Create some placements and assign content for them.

Default Placement


https://ltv.tapjoy.com/d/sdks
https://dev.tapjoy.com/sdk-integration/unity/getting-started-guide-publishers-unity/
https://ltv.tapjoy.com/
https://dev.tapjoy.com/virtual-currency/#setting_up_virtual_currency_in_the_tapjoy_dashboard

Here you can configure the default placement for each platform. Note that in the ID fields you would enter the name of
the placements created on the Tapjoy dashboard whose content is relevant to the corresponding ad type (interstitial,
rewarded). You only need to provide placement names for the ad types you want to use, e.g. if you only use Tapjoy
rewarded ads you can leave the interstitial ad fields empty.

Custom Placements

Here you can optionally enter the Tapjoy placement names associated with non-default placements to be used in your
app. You can have an arbitrary number of custom placements and can use built-in placements or create new
placements for your needs.

Auto Reconnect Settings

e Auto Reconnect: should we reconnect to the server automatically until connected. If you uncheck it, players might
never be able to connect to the Tapjoy server if they opened your app when their device is offline.
e Auto Reconnect Interval: auto reconnect coroutine refresh rate.

Tapjoy Setup Interface

Click the Open TapJoy Setup Window button to open the Tapjoy's setup window (you can also navigate to the menu
Window > Tapjoy and open it). A window will be opened as below.



Setup Tapjoy

e Tapjoy requires a TapjoyUnity GameObject with some components attached to it. The _Fix _button right next to
the "No TapjoyUnity GameObiject in this scene" warning label can create that GameObject for you, make sure to
add it in the scene that appears first in your game.

e Enter the SDK Key for each platform.

e Make sure the Auto-Connect field is checked.

More details about these settings can be found here.
Building Notes

Android

e Tapjoy needs Google Play Services library to work, but starting from version 11.10.1, the Tapjoy plugin for Unity
no longer includes it in the package, so make sure to add it into your game (you can read about this here).

e You need to make sure your game has a valid AndroidManifest.xml placed under Assets/Plugins/Android (read
more about it here).
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https://dev.tapjoy.com/sdk-integration/unity/getting-started-guide-publishers-unity/
https://dev.tapjoy.com/sdk-integration/unity/getting-started-guide-publishers-unity/#sdk_installation
https://dev.tapjoy.com/sdk-integration/unity/getting-started-guide-publishers-unity/#add_app_permissions_and_activities_for_android

Setup Tapjoy

e |[f there is no AndroidManifest.xml in that folder, you will see some "not found” warning labels like the image
above. Simply click the Generate Android Manifest in the TAPJOY section, a valid file will be created
automatically.

e If you already have a AndroidManifest in the folder, but some elements are missing, you can at them via
Tapjoy's setup window. Click all the fix button there (see the image below) and Tapjoy will do the job

automatically.

i0OS
After exporting your project to XCode, add the following into your Info.plist file (read more about it here).

~key NSAppTransportSecurity key
<dict>
<!--To support localhost -->
~key NSAllowsLocalNetworking key
<true/>
<!--To continue to work for i0S 9 -->
~key NSAllowsArbitraryLoads  key -
<true/>
</dict>
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https://dev.tapjoy.com/faq/app-transport-security-ats-ios-10/

Advertising: Settings | Setup Unity Ads

Enabling Unity Ads Service
To use Unity Ads service, you must first set up your project for Unity Services.

To show ads from Unity Ads you need to enable the corresponding service. Easy Mobile will automatically check for
the service's availability and warn you to enable it if needed. Below is the UNITY ADS section when Unity Ads is not
enabled.

o
‘ = UNITY ADS

Unity Ads service is disabled or not available for the current platform. To enable it go to
Window > Services.

To enable Unity Ads switch the platform to iOS or Android, then go to Window > Services and select the Ads tab.


https://docs.unity3d.com/Manual/SettingUpProjectServices.html

Setup Unity Ads

SERVICES

«4 Analytics

& Cloud Build

% Multiplayer

In the opened configuration window, click the toggle at the right-hand side to enable Unity Ads service. You may need
to answer a few questions about your game.
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Setup Unity Ads

i0s

Configuring Unity Ads

The UNITY ADS section will be updated after Unity Ads has been enabled.

i

—
== UNITY ADS

Pt
‘ @ Unity Ads service is enabled. ‘
Default Placement
These placement IDs match the default placement IDs that Unity Ads generated automatically.
These IDs are not editable and you should avoid repeating them when creating custom placements.
b Interstitial Ad

b Rewarded Ad

Custom Placements
I Interstitial Ads
b Rewarded Ads

Default Placement

The ad IDs associated with the default placement are prefilled for you automatically. These IDs match the default
placement IDs generated by the Unity Ads service when it is enabled and therefore cannot be changed.

Custom Placements

58



Here you can optionally enter the ad IDs associated with non-default ad placements to be used in your app. You can
have an arbitrary number of custom placements and can use built-in placements or create new placements for your
needs. Note that you must not reuse the default placement IDs with these custom placements.

Before entering the ad IDs for custom placements in the Custom Placements section, you must create these
placements in the Unity Dashboard. In the dashboard select your project, select the Operate tab, then in the left

navigation menu select Monetization > Placements and click the ADD PLACEMENT button at the top right
corner.

Q unity Dashboard Develop  Operate  Acquire @ O  solibGames v

€ Allprojects

Placements

video

Easy Mobile ~

>
B0 Overview

rewardedVideo >
~* Reporting v

$  Monetization > SET DEFAULT PLACEMENTS
‘ Placements

Legal Privacy Policy Cookies
Platforms

Testing Notes

It is advisable to enable the test mode of Unity Ads during development. This will ensure there's always an ad

returned whenever requested. To enable test mode simple check the Enable test mode option in the Ads tab in the
Services window.

Remember to disable this test mode when creating your release build.



Advertising: Scripting
This section provides a guide to work with the Advertising module scripting API.

You can access the Advertising module API via the Advertising class under the EasyMobile namespace.
Working with Consent

Module Consent

The following snippet shows how you grant, revoke or read the module-level consent of the Advertising module.

Advertising
Advertising

moduleConsent - Advertising DataPrivacyConsent

Vendor Consent

The following snippet shows how you grant, revoke or read the vendor-level consent of an individual network in the
Advertising module.

In this example we use AdMob for demonstration purpose, the same code can be used for any other network.

Advertising AdNetwork  AdMob
Advertising AdNetwork AdMob
admobConsent - Advertising AdNetwork AdMob

Working with Banner Ads

To show a banner ad you need to specify its position using the BannerAdPosition enum. The banner will be displayed
once it is loaded.

Advertising BannerAdPosition Bottom

To hide the current banner ad (it can be shown again later):

Advertising

To destroy the current banner ad (a new one will be created on the next banner ad showing):

Advertising



Working with Interstitial Ads

The method to show an interstial ad requires it to be already loaded. Therefore you should check for the ad's
availability before showing it.

isReady - Advertising

isReady

Advertising

An InterstitialAdCompleted event will be fired whenever an interstitial ad is closed. You can listen to this event to take
appropriate actions, e.g. resume the game.

Advertising InterstitialAdCompleted InterstitialAdCompletedHandler

network location

Debug

Advertising InterstitialAdCompleted InterstitialAdCompletedHandler

Working with Rewarded Ads

The method to show a rewarded ad requires it to be already loaded. Therefore you should check for the ad's
availability before showing it.

isReady = Advertising

isReady

Advertising

A RewardedAdCompleted event will be fired whenever a rewarded ad has completed. You should listen to this event
to reward the user for watching the ad. Otherwise, a RewardedAdSkipped event will be fired if the ad is skipped
before finishing (and the user therefore is not entitled to the reward).

Advertising RewardedAdCompleted RewardedAdCompletedHandler
Advertising RewardedAdSkipped RewardedAdSkippedHandler



Advertising RewardedAdCompleted RewardedAdCompletedHandler
Advertising RewardedAdSkipped RewardedAdSkippedHandler

network location

Debug

network location

Debug

Removing Ads

Removing Ads without Updating Consent

In some cases you need to remove/stop showing ads in your game, e.g. when the user purchases the "Remove Ads
product. To remove ads:

Advertising

The RemoveAds method will destroy the banner ad if one is being shown, and prevent future ads from being loaded
and shown except rewarded ads, since they are unobtrusive and only shown at the user discretion.

Note that the RemoveAds method uses Unity's PlayerPrefs to store the ad removal status with no

encryption/scrambling.

An AdsRemoved event will be fired after ads have been removed. You can listen to this event and take appropriate
actions, e.g update the Ul.

Advertising AdsRemoved AdsRemovedHandler
Debug
Advertising AdsRemoved AdsRemovedHandler

You can also check at any time if ads were removed or not.

isRemoved = Advertising

Removing Ads and Revoke Consents



Because rewarded ads are still available after removing ads (for good reason!), it may be desirable in some cases to
also revoke all consent granted to the Advertising module as well as the individual network. For example, you may
offer "Remove Ads" as an in-app purchase that the user can buy to remove intrusive ads (i.e. banner and interstitial
ads) and stop the app from collecting their personal data for advertising purpose. In such case, you can call the
RemoveAds and pass true to its revokeConsents parameter. This parameter is optional and default to false.

Advertising

Re-enabling Ads after Removal

Finally, you can also revoke the ad removing status and allow ads to be shown again.

Advertising

Manual Ad Loading
With the Automatic Ad Loading feature, you normally don't need to worry about loading ads. However, if you want to
disable this feature and control the loading process yourself, you can do so with manual ad loading in script.

It is advisable to load an ad as far in advance of showing it as possible to allow ample time for the ad to be

loaded.

To load an interstitial ad:

Advertising

To load a rewarded ad:

Advertising

Working with Non-Default Ads

Beside the default ads, you can also show ads from non-default networks at non-default placements, thus
implementing a more sophisticated ad strategy in your app. Note that each method to load or show ad always has a
variant that allows you to specify the target ad network and placement explicitly. For example there're 2 variants of the
LoadInterstitialAd method. One takes no argument and loads the default interstitial ad. The other loads an interstitial
ad from a specified network at an arbitrary placement.

If you're using the "Load All Defined Placements" auto ad-loading mode, both default and non-default ads are
loaded automatically so you never need to worry about loading ads.

If you have AdMob as the default interstitial ad network, you can load and show a non-default interstitial ad like below.

Advertising
Advertising



Advertising InterstitialAdNetwork AdMob. AdPlacement Startup

Advertising InterstitialAdNetwork AdMob AdPlacement Startup
Advertising InterstitialAdNetwork AdMob AdPlacement Startup
Advertising RewardedAdNetwork IronSource AdPlacement HomeScreen
Advertising RewardedAdNetwork IronSource AdPlacement HomeScreen

Ad Network Clients

You can access the underlaying clients for the supported ad networks using the corresponding properties of the

Advertising class.

adcolonyClient - Advertising AdColonyClient
admobClient - Advertising AdMobClient
chartboostClient - Advertising ChartboostClient
fbanClient - Advertising AudienceNetworkClient
heyzapClient - Advertising HeyzapClient
ironSrcClient = Advertising IronSourceClient
mopubClient Advertising MoPubClient
tapjoyClient Advertising TapjoyClient

unityAdsClient Advertising UnityAdsClient

From these clients you can access network-specific events, e.g the OnBannerAdClosed event provided by the
AdMob. Events like this are specific to a certain ad network and normally not available in other networks which is why
they are not exposed in the Advertising class (the Advertising class only exposes a common subset of events that are
provided by all ad networks to ensure a consistent behavior across all networks). Note that these network-specific
events are only available if the corresponding plugin of that network has been imported to your project. You can use
the scripting symbols in the below table to wrap codes that access these event to make sure they only get compiled
when the plugin is available. These symbols are defined automatically by Easy Mobile when the corresponding ad
plugin is imported, except UNITY_ADS which is defined by Unity when the service is enabled.



Ad Network

AdColony

AdMob (Google Mobile Ads)
Chartboost

Facebook Audience Network
Heyzap (Fyber)

ironSource

MoPub

Tapjoy

Unity Ads

Symbol
EM_ADCOLONY
EM_ADMOB
EM_CHARTBOOST
EM_FBAN
EM_HEYZAP
EM_IRONSOURCE
EM_MOPUB
EM_TAPJOY

UNITY_ADS (defined by Unity)



PlayMaker Actions

Advertising: PlayMaker Actions
The PlayMaker actions of the Advertising module are group in the category Easy Mobile - Advertising in the
PlayMaker's Action Browser.

Please refer to the AdvertisingDemo_PlayMaker scene in folder
Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

Easy Mobile - Advertising

Advertising_Destroy Banner Ad

Advertising_Destroy Banner Ad
Destroys banner ad.

Destroy Default Banner Ad 4

[ Preview (
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PlayMaker Actions
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Game Services: Introduction

The Game Services module helps you quickly implement leaderboards and achievements for your game. It works with
the Game Center network on iOS and Google Play Games services on Android. Here're some highlights of this

module:

e Leverages official plugins

o This module is built on top of Unity's GameCenterPlatform on iOS and Google Play Games plugin on Android
o GameCenterPlatform is one part of the UnityEngine itself while the other is the official Google Play Games
plugin for Unity, so reliability and compatibility can be expected
o Easy management of leaderboards and achievements

o Easy Mobile's custom editor features a friendly interface that help you easily add, edit or remove

leaderboards and achievements


https://github.com/playgameservices/play-games-plugin-for-unity

Settings

Game Services: Settings

To use the Game Services module you must first enable it. Go to Window > Easy Mobile > Settings, select the Game

Services tab, then click the right-hand side toggle to enable and start configuring the module.

Android-Specific Setup

Importing Google Play Games plugin for Unity

As stated earlier, this module is built on top of Google Play Games Plugin on Android. Therefore you need to import it
to use the module on this platform. Easy Mobile will automatically detect the availability of the plugin and prompt you
to import it if needed. Below is the module settings interface after switching to Android platform if the Google Play
Games plugin hasn't been imported.
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https://github.com/playgameservices/play-games-plugin-for-unity

Settings

Click the Download Google Play Games Plugin button to open the download page, then download the package and
import it to your project. Once the import completes the module interface will be updated and ready for you to start
with the configuration.

E DOWNLOAD GPGS PLUGIN

@ Google Play Games plugin is imparted and ready to use.

E GOOGLE PLAY GAMES SETUP ~

GPGS Debug Log .

GPGS Popup Gravity 3

Since we're not using Google Play Games plugin on iOS, the NO_GPGS symbol will be defined for iOS
platform automatically after the plugin is imported in order to disable it.

Setup Google Play Games

To setup Google Play Games plugin, you need to obtain the game resources from the Google Play Developer
Console.

The game resources are available after you configured your game on the Google Play Developer Console. If
you're not familiar with the process, please follow the instructions on creating a client ID, as well as
leaderboards and achievements.

To get the game resources, login to your Google Play Developer Console, select Game services tabs then select your
game. Next go to the Achievements tab and click on the Get Resources label at the bottom of the list.
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https://developers.google.com/games/services/console/enabling
https://developers.google.com/games/services/common/concepts/leaderboards
https://developers.google.com/games/services/common/concepts/achievements

Settings
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Engagamisnt dotads

e = Click this to get
i ° the resources

Copy all the xml content from the Android tab.

EXPORT RESOURCES

Android  Objective-C  Javascript Text

~ <7xml version="1.0" encoding="utf-8"?>

<l--

Google Play game services |Ds.

Save this file as res/values/games-ids.xml in your project.

=

<TesoUrcess
<string name="app_id">41 152255531 </string>
<siring name="package_name"=com. geeste epmmminimal</string=
<string name="achievemeant_welcome">Cgllfsil == Q</string>

</resources=>
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Go back to Unity, in the GOOGLE PLAY GAMES SETUP section, paste the obtained xml resouces into the Android
XML Resources area, then click Setup Google Play Games.

You can optionally provide a Web Client ID before setting up Google Play Games if needed.

f—E GOOGLE PLAY GAMES SETUP

GPGS Debug Log -
GPGS Popup Gravity | Top 4

Web App Client ID (Optional)

The web app client ID is needed to access the user's ID token and call other APIs on behalf of the
user, Itis not required for Game Services, Enter your oauth2 client ID below. To obtain this ID,
generate a web linked app in Developer Cansale,

|Example: 12245678901 2-abcdefghijklm.apps.googleusercontent.com
Web Client Id

Android XML Resources

|Paste in the Android XML Resources fram the Play Console and hit the Setup buttan.

<?xml version="1.0" encoding="utf-8"7=> -
<|--
Google Play game services IDs,

Save this file as res/values/games-ids.xml in your project.
-

<resources=
<l-- app_id --=
<sgtring name="app_id" translatable="false" =652 < /string =
<|-- package_name --=

<string name="package_name" translatable="false"=com.sglib.easymobile</string
= 1-- achievement Sample Achieverment 1 --=

4 4

Setup Google Play Games

After the setup has completed, a new file named EM_GPGSIds will be created at Assets/EasyMobile/Generated. This
file contains the constants of the IDs of all the leaderboards and achievements in your Android game.

Within the GOOGLE PLAY GAMES SETUP section there're other settings including:

e GPGS Debug Log: check this to enable Google Play Games debug log.
e GPGS Popup Gravity: use this to control the position of Google Play Games popups (e.g. achievement popup).

Auto Initialization

Auto initialization is a feature of the Game Services module that initializes the service automatically when the module
starts. Initialization is required before any other actions can be done, e.g. reporting scores.

During the initialization, the system will try to authenticate the user by presenting a login popup.

e OniOS, this popup will show up when the app gets focus (brought to foreground) for the first 3 times. If the user
refuses to login all these 3 times, the OS will ignore subsequent authentication calls and stop presenting the login
popup (to avoid disturbing the user). Otherwise, if the user has logged in successfully, future authentication will
take place silently with no login popup presented.

On Android, we employ a similar approach but you can configure the maximum number of authentication
requests before ignoring subsequent ones.



You can configure the auto initialization feature within the AUTO-INIT CONFIG section.

~ AUTO INITIALIZATION A
Auto Init [

Auto Init Delay O (o
[Android] Max Login Requests == (3 5

e Auto Init: uncheck this option to disable the auto initialization feature, you can start the initialization manually from
script (see the Scripting section)

e Auto Init Delay: how long after the module start that the initialization should take place

e [Android] Max Login Requests: maximum number of authentication requests allowed on Android, before ignoring
subsequent ones (in case the user refuses to login)

"Module start" refers to the moment the Start method of the module's associated MonoBehavior (attached to the
EasyMobile prefab) runs.

Leaderboards & Achievements

This section provides a guide to manage leaderboards and managements for your game.
Before You Begin

It is assumed that you already configured your game for the targeted gaming networks, i.e. Game Center and

Google Play Games. If you're not familiar with the process, here're some useful links:
e Configure for Google Play Games (Android)

o Creating a Client ID for you game
o Adding leaderboards
o Adding achievements

e Configure for Game Center (i0S)

o Adding leaderboards and achievements in iTunes Connect

In the LEADERBOARDS and ACHIEVEMENTS you can add, edit or remove leaderboards and achievements.

Adding a New Leaderboard or Achievement

To add a new leaderboard click the Add New Leaderboard button (or Add New Achievement button in case of an
achievement).

‘ ~- LEADERBOARDS A ‘

| e Leaderboard added. |

A new empty leaderboard (or achievement) will be added.

[Untitled Leaderboard] i
Mame | | =
i0S Id | | ¢
Android Id | [Mene] ¢

Fill in the required information of the leaderboard (or achievement):

e Name: the name of this leaderboard (or achievement), this name can be used when reporting scores to this


https://developers.google.com/games/services/console/enabling
https://developers.google.com/games/services/common/concepts/leaderboards
https://developers.google.com/games/services/common/concepts/achievements
https://developer.apple.com/library/content/documentation/NetworkingInternet/Conceptual/GameKit_Guide/Achievements/Achievements.html

leaderboard (or unlocking this achievement)
e jOS Id: the ID of this leaderboard (or achievement) as declared in iTunes Connect
e Android Id: the ID of this leaderboard (or achievement) as declared in Google Play Developer Console

Google Play Games' leaderboards and achievements have generated IDs which can be difficult to memorize
and cumbersome to copy-and-paste, especially if there are many of them. Thankfully, when you setup Google
Play Games, the constants of these IDs are generated automatically (remember that EM_GPGSIds file?),
allowing Easy Mobile to show a nice dropdown of all defined leaderboard and achievement IDs for you to
choose from.

¥ Sample LeaderBoard o
MName |Sample LeaderBoard ([ =
i0s Id |easymobile ldb.sample_1 | €
Android Id [ [Liona] il

~  [Moneg]
Al

achievement_sample_achievement_1 1

*_:_3—3 ACHIEVEMENTS achievement_sample_achievement_10

i achievement_sample_achievement_2
¥ 1 Achievements : :
achievement_sample_achievement_3

‘ # [Untitled Achievement] achievement_sample_achievement_4

I 2 achievement_sample_achievement_5

achievement_sample_achievement_&

f—E COMSTANTS GEMERATION achievement_sample_achievement_7

achievement_sample_achievement_2

constants of leaderboard and achiey
changes to these names.

leaderboard_sample_leaderboard
I Gen

Generate the static class EasyMabi
achievement_sample_achievement_9

Removing a Leaderboard or Achievement

To remove a leaderboard (or achievement), simply click the [-] button at the right hand side.

Sample LeaderBoard ]
Mame !Sample LeaderBoard [l -
05 Id |easymobile.ldb.sample_1 : 77
Android Id | leaderboard_sample_leaderboard 4|

Arranging Leaderboards or Achievements

You can use the two arrow-up and arrow-down buttons to move a leaderboard (or achievement) upward or downward
within its array.

Sample LeaderBoard ]
Mame !Sample LeaderBoard || =
05 Id |easymobile.ldb.sample_1 : 7x
Android Id | leaderboard_sample_leaderboard 4|

Constants Generation



Settings

Constants generation is a feature of the Game Services module. It reads the names of all the added leaderboards and
achievements and generates a static class named EM_GameServicesConstants that contains the constants of these
names. Later, you can use these constants when reporting scores to a leaderboard or unlocking an achievement in
script instead of typing the names directly, thus help prevent runtime errors due to typos and the likes.

To generate the constants class (you should do this after adding all required leaderboards and achievements), click
the Generate Constants Class button within the CONSTANTS CLASS GENERATION section.

[ E COMNSTANTS GEMERATIOMN ~ 1

Generate the static class EasyMabile.EM_GameServicesConstants that contains the constants of leaderboard
and achiewvement names, Remember to regenerate if you make changes to these names,

%

When the process completes, a file named EM_GameServicesConstants will be created at
Assets/EasyMobile/Generated.

4 Assets » EasyMobile ~ Generated
E EM_GCameService
[
[
[

™= Generated
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Game Services: Scripting

This section provides a guide to work with the Game Services module scripting API.

You can access the Game Services module API via the GameServices class under the EasyMobile

namespace.

Initialization

Initialization is required before any other action, e.g. reporting scores, can be done. It should only be done once when
the app is loaded. If you have enabled the Auto initialization feature, you don't need to initialize in script (see Auto
Initialization section). Otherwise, if you choose to disable that feature, you can start the initialization in a couple of

ways.

e Managed initialization: this method respects the Max Login Requests value on Android (see Auto Initialization
section), which means it will ignore all subsequent calls once the user has dismissed the login popup for a
number of time determined by Max Login Requests

e Unmanaged initialization: this method simply initializes the module, on Android it shows the login popup every
time as long as the user hasn't been authenticated

On iOS, the system automatically limits the maximum number of login requests to 3 no matter which method is

used.

To use the managed initialization method:

GameServices

To use the unmanaged initialization method:

GameServices

Note that the initialization should be done early and only once, e.g. you can put it in the Start method of a
MonoBehaviour, preferably a singleton one so that it won't run again when the scene reloads.

GameServices

A UserlLoginSucceeded event will be fired when the initialization completes and the user logins successfully.
Otherwise, a UserLoginFailed event will be fired instead. You can optionally subscribe to these events and take

appropriate actions depended on the user login status.

GameServices UserLoginSucceeded OnUserLoginSucceeded
GameServices UserLoginFailed OnUserlLoginFailed



GameServices UserLoginSucceeded onUserLoginSucceeded
GameServices UserLoginFailed OnUserlLoginFailed

Debug

Debug

You can also check if the module has been initialized at any point using the Is/nitialized method.

isInitialized GameServices

Leaderboards

This section focuses on working with leaderboards.

Show Leaderboard Ul

To show the default leaderboard Ul (the system view of leaderboards):

GameServices

You should check if the initialization has finished (the user has been authenticated) before showing the leaderboard
Ul, and take appropriate actions if the user is not logged in, e.g. show an alert or start another initialization process.

GameServices

GameServices

GameServices

Debug

To show the Ul of a specific leaderboard, simply pass the name of the leaderboard into the ShowLeaderboardUI
method. You can also optionally specify the time scope:

GameServices

GameServices TimeScope Week



Report Scores

To report scores to a leaderboard you need to specify the name of that leaderboard.

It is strongly recommended that you use the constants of leaderboard names in the generated
EM_GameServicesConstants class (see Game Services Constants Generation section) instead of typing the
names directly in order to prevent runtime errors due to typos and the likes.

// Report a score of 100

// EM_GameServicesConstants.Sample_Leaderboard is the generated name constant
// of a leaderboard named "Sample Leaderboard"

GameServices EM_GameServicesConstants Sample_Leaderboard

Load Local User's Score

You can load the score of the local user (the authenticated user) on a leaderboard, to do so you need to specify the
name of the leaderboard to load score from and a callback to be called when the score is loaded.

// Put this on top of the file to use IScore
UnityEngine SocialPlatforms

// Load the local user's score from the specified leaderboard

// EM_GameServicesConstants.Sample_Leaderboard is the generated name constant

// of a leaderboard named "Sample Leaderboard"

GameServices EM_GameServicesConstants Sample_Leaderboard OnLocalUserScoreLoaded

// Score loaded callback

leaderboardName score
score
Debug score
Debug leaderboardName

Load Scores

You can load a set of scores from a leaderboard with which you can specify the start position to load score, the
number of scores to load, as well as the time scope and user scope.

// Put this on top of the file to use IScore
UnityEngine SocialPlatforms

// Load a set of 20 scores starting from rank 10 in Today time scope and Global user scope
// EM_GameServicesConstants.Sample Leaderboard is the generated name constant
// of a leaderboard named "Sample Leaderboard"
GameServices
EM_GameServicesConstants Sample_Leaderboard

TimeScope Today
UserScope Global
onScoreslLoaded



leaderboardName  IScore scores

scores scores Length
Debug scores Length leaderboardName
score scores
Debug score score rank
Debug

You can also load the default set of scores, which contains 25 scores around the local user's score in the AllTime time
scope and Global user scope.

UnityEngine SocialPlatforms

GameServices EM_GameServicesConstants Sample_Leaderboard. OnScoresLoaded

leaderboardName . IScore scores

scores scores Length
Debug scores Length leaderboardName
score scores
Debug score score rank
Debug

Get All Leaderboards

You can obtain an array of all leaderboards created in the module settings interface:

Leaderboard leaderboards EM_Settings GameServices Leaderboards

1db leaderboards

Debug 1db Name



Achievements

This section focuses on working with achievements.

Show Achievement Ul

To show the achievements Ul (the system view of achievements):

GameServices

You should check if the initialization has finished (the user has been authenticated) before showing the achievements
Ul, and take appropriate actions if the user is not logged in, e.g. show an alert or start another initialization process.

GameServices

GameServices

GameServices

Debug

Reveal an Achievement

To reveal a hidden achievement, simply specify its name.

As in the case of leaderboards, it is strongly recommended that you use the constants of achievement names in

the generated EM_GameServicesConstants class instead of typing the names directly.

GameServices EM_GameServicesConstants Sample_Achievement

Unlock an Achievement

To unlock an achievement:

GameServices EM_GameServicesConstants Sample_Achievement

Report Incremental Achievement's Progress

To report the progress of an incremental achievement:

GameServices EM_GameServicesConstants Sample_Incremental_Achievement



Get All Achievements

You can obtain an array of all achievements created in the module settings interface:

Achievement achievements EM_Settings GameServices Achievements

acm achievements

Debug acm Name

User Profiles

You can load the profiles of friends of the local (authenticated) user. When the loading completes the provided
callback will be invoked.

UnityEngine SocialPlatforms
GameServices OnFriendsLoaded
IUserProfile friends
friends Length

user friends

Debug user userName user id

Debug

You can also load user profiles by providing their IDs.

UnityEngine SocialPlatforms

GameServices idArray OnUsersLoaded

IUserProfile users
users Length
user users

Debug user userName user id



Debug

Sign Out

To sign the user out, simply call the SignOut method. Note that this method is only effective on Android.

GameServices



Game Services | Saved Games: Introduction

Saving game data is among the most desirable features of video games in general, and mobile games in particular.
Nowadays, it's not uncommon for a user to own more than one mobile device, be it phone or tablet. Being able to start
a game on one device, and then continue playing on another device without losing any progress brings a seamless - if
not natural - user experience.

The Saved Games feature of Easy Mobile makes it possible - and easy - to save a player's game data to the cloud
and synchronize it across multiple devices. Saving user data to the cloud also means that their game progression is
preserved and can be restored in cases such as reinstallation or device failure.

On iOS, the game data is saved to iCloud via the Game Center (GameKit) API. On Android, it is saved to
Google Drive via the Google Play Game Services API (GPGS).

Understanding Saved Games

A saved game consists of two parts:

e An unstructured binary blob - this can represent whatever data you deem relevant to your game, and your game
is responsible for generating and intepreting it.

e Structured metadata - additional properties associated with the binary data and provide information about this
data.

The table below describes common saved game properties.

Property Description

Name A developer-supplied short name of the saved game

ModificationDate A timestamp corresponding to the last modification of the saved game
DeviceName [iOS only] The name of the device that committed the saved game data
Description [GPGS only][Optional] A developer-supplied description of the saved game

CoverlmageURL [GPGS only] [Optional] The URL of the PNG cover image of the saved game

[GPGS only][Optional] A developer-supplied value (in milisesconds) representing the

el Aeee played time of the saved game

Whether the saved game is "Open". A saved game can only be read or written to if it is

IsOpen open.

It's up to you to decide how and when users can save a game. Depending on your game design, you might want to
allow only a single saved game, or you might want to allow the player to create multiple saved games with different
names (so they can, for example, go back to various checkpoints and try different actions).

The Underlying Cloud Services

As mentioned earlier, saved games are stored on iCloud (iOS/Game Center) and Google Drive (Android/GPGS).
Therefore, it's mandatory that the user has an iCloud or Google account to use the feature on the corresponding
platform.



On iOS, the saved games are tied to the user's iCloud account, not the Game Center account.
On Android, the Google Drive associated with the user's Google account that was authenticated with GPGS is

used.
Limitations
iOS (iCloud/Game Center) Android (Google Drive/GPGS)
No hard limit on the number of saved games No hard limit on the number of saved games

The size of a saved game data is limited to the
amount of available space in the user's iCloud
account)

GPGS currently enforce size limits on binary data and
cover image sizes of 3 MB and 800 KB respectively.

You should always strive to minimize the amount of data being saved. This prevents the user from running out
of space and decreases the amount of time required to fetch or save a game file. Also note that the game

saving operation may fail if there's not enough room in the iCloud or Google Drive account of the user.

Offline Support

Your game can still read and write to a saved game when the player's device is offline, but will not be able to sync with
the cloud services until network connectivity is established. Once reconnected, the synchronization will be done
automatically and asynchronously.

Conflict Resolution

When a user plays your game on multiple devices and uses the saved games feature, it's not uncommon to have
multiple saved games with the same name and from different devices, thus creating conflicts. These conflicts typically
occur when an instance of your game is unable to reach the cloud service while attempting to sync the save game
data, or when it updates the saved game data on the cloud without loading the latest data first. In general, the best
way to avoid data conflicts is to always load the latest data from the cloud service when your game starts up or
resumes, and save data to the service with reasonable frequency. However, it is not always possible to avoid data
conflicts. Your application should make every effort to handle conflicts to preserve users' data as well as maintain a
good user experience. Fortunately, the Saved Games API can help you resolve these conflicts automatically using
several default resolution strategies. It also provides relevant methods to help you implement your own resolution
strategy to better suit your needs.

In this GameOn! - Saved Games In-Depth (Part 2) YouTube video by Google Developers you 'll find in-depth
explanation on conflicts between saved games, how they happen, how to resolve them as well as other important
concepts. The video is dedicated to the Saved Games feature of Google Play Games Services, but the concepts are
also applicable to Game Center. A must watch.

Useful Links

1. Saving A Game - Game Center Programming Guide
2. Saved Games - Google Play Game Services
3. GameOn! - Saved Games In-Depth (Part 2) YouTube video


https://www.youtube.com/watch?v=naQhSkzNGAI
https://developer.apple.com/library/content/documentation/NetworkingInternet/Conceptual/GameKit_Guide/SavedGames/SavedGames.html
https://developers.google.com/games/services/common/concepts/savedgames
https://www.youtube.com/watch?v=naQhSkzNGAI

Saved Games
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Game Services | Saved Games: Settings

The Saved Games feature can be configured in the SAVED GAMES CONFIG section in the Game Service module
settings.

o
‘ =~ SAVED GAMES

Enable Saved Games [+
Conflict Resolution Strategy | Use Base il
[Android] Data Source | Read Cache Or Metwark =

e Enable Saved Games: you must enable the Saved Games feature before using it

e Conflict Resolution Strategy: the default strategy used by the automatic conflict resolution feature

e [Android] Data Source: where the game data can be fetched from, only applicable on Android/Google Play Game
Services platform

iI0OS Setup

To use the Saved Games service on iOS, you must enable the iCloud capability for your app in the Xcode project.
Make sure the iCloud Documents service is selected.

|E| w» Genera Capabilities Resource Tags Info Build Settings Build Phases

Services: Key-value storage
iCloud Documents
CloudKit

Containers: ﬂ Use default container

Also, for the feature to function on their iOS devices, the users must signed into their iCloud account and have the
iCloud Drive service enabled in the Settings app.



Settings

< Apple ID iCloud

Siri

o

Keychain Off >

Find My iPhone On :

e

iCloud Backup Off

iCloud Drive

iBooks

Pages

Numbers

Keynote

GarageBand

iMovie

BQAO0E M6
T"AAAAAA A

iTunes U
Android Setup

Again, on Android we employ the Saved Games feature provided by the Google Play Game Services. Therefore, you
need to enable this feature for your app in the Google Play Console. Select your app, then select the Game Services

tab and enable the feature in the Game details tab.

Saved Games “ OFF a
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Settings

Note that you need to wait at least 24 hours after enabling the Saved Games service for it to be available.
Attempting to authenticate during this time may cause the app to crash.
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Game Services | Saved Games: Scripting

This section provides a guide to work with the Saved Games scripting API of the Game Services module.

You can access the Saved Games API via the SavedGames property of the GameServices class under the
EasyMobile namespace.

Working with saved games involves the following operations:

Operation Description

A saved game must be opened before it can be used for read or write operation. If you attempt to
open a non-existing saved game, a new one will be created and will be opened automatically.

Open You must resolve any conflicts associated with a saved game when opening it. You can have the
conflicts resolved automatically using one of the default strategies, or implement your own
strategy to resolve them manually.

Write Update the data associated with a saved game, the saved game must be open before writing,
and it will be closed automatically after the operation has finished.

Read Retrieve the data associated with a saved game, the saved game must be open.

Delete Delete a saved game from the cloud service

Opening Saved Game

You can open a saved game using either the OpenWithAutomaticConflictResolution or the
OpenWithManualConflictResolution method. Both methods open a saved game with the specified name, or create a
new one if none exists. The saved game returned in their callbacks will be open which means it can be used for read
or write operation. The difference between the two is whether saved game conflicts, if any, will be resolved
automatically or manually.

If the current platform is Google Play Game Services, these methods use the data source specified in the
module settings.

Open With Automatic Conflict Resolution

As its name suggests, when opening a saved game using this method, any outstanding conflicts will be resolved
automatically using the resolution strategy specified in the module settings.

EasyMobile

mySavedGame

GameServices SavedGames OpenSavedGameCallback

savedGame error

error



Debug
mySavedGame - savedGame

Debug error

Open With Manual Conflict Resolution

If the saved game being opened has outstanding conflicts, they will be resolved manually using the specified conflict
resolution function. This function must be implemented by you and it is where you provide your custom conflict
resolution strategy, in case none of the default strategies suits your needs. The function will be invoked automatically
when a conflict is encountered while opening a saved game and can be invoked multiple times if the saved game has
more than one outstanding conflict. Therefore it must be designed to handle multiple invocations.

The conflict resolution function receives the Base and Remote versions of the conflicting saved game (please check
out this GameOn! - Saved Games In-Depth (Part 2) YouTube video by Google Developers for an excellent
explanation on the concepts of "base" and "remote"). These passed saved games are all open. If
OpenWithManualConflictResolution was invoked with prefetchDataOnConfiict set to true, the binary data associated
with these saved games will loaded and passed to the conflict resolution function too. Use the return value of this
function to determine whether the base or the remote will be chosen as the canonical version of the saved game.

The callback will be invoked when all conflicts (if any) have been resolved and the operation finishes.

EasyMobile

mySavedGame

GameServices SavedGames

MyConflictResolutionFunction
OpenSavedGameCallback

baseGame baseData
remoteGame remoteData

SavedGameConflictResolutionStrategy UseBase


https://www.youtube.com/watch?v=naQhSkzNGAI

savedGame error
error

Debug
mySavedGame = savedGame

Debug error

In case you want to merge the data from different versions, simply specify either the base or the remote as the
chosen version. Once all conflicts are resolved and the saved has been opened successfully, perform a write

operation using the merge data.

Writing Saved Game Data

To commit new data to a saved game, use the WriteSavedGameData method. As mention earlier, the saved game
must be open before writing or the operation will fail. When this method completes successfully, the data is durably
persisted to disk and will eventually be uploaded the the cloud (in practice, this process happens very quickly unless
the device doesn't have a network connection). After the operation finishes, the saved game will be closed
automatically. This is to force it to be opened once again (thus resolving any outstanding conflicts) before another
commit can be made.

EasyMobile

savedGame data

savedGame  IsOpen

GameServices SavedGames

savedGame
data
updatedSavedGame error
error
Debug
Debug error
Debug

Beside the binary data, you can also update the metadata (properties) of a saved game. Just use the overloading
version of WriteSavedGameData that accepts a SavedGamelnfoUpdate struct.



Some saved game properties are only available on a certain platform, please review the Game Service >
Module Configuration > Saved Game section for detailed information.

// Put this on top of the script
EasyMobile

// Updates the binary data AND the properties of a saved game
savedGame data

savedGame IsOpen

// The saved game is open and ready for writing
// Prepare the updated metadata of the saved game
builder

builder
builder TimeSpan // update the played time to 30 minutes

infoUpdate - builder

GameServices SavedGames

savedGame
data
infoUpdate // update saved game properties
updatedSavedGame error
error
Debug
Debug error

// The saved game is not open. You can optionally open it here and repeat the process.
Debug

Reading Saved Game Data

To read a saved game data, use the ReadSavedGameData method. The saved game must be open before reading.
The callback will be invoked when the operation finishes and will receive the retrieved data as a byte array, which can
be empty if the saved game has no data committed previously.

// Put this on top of the script
EasyMobile

// Retrieves the binary data associated with the specified saved game
savedGame

savedGame IsOpen
// The saved game is open and ready for reading
GameServices SavedGames
savedGame
game data error

error

Debug
// Here you can process the data as you wish.



data Length

Debug

Debug error

Debug

Deleting Saved Game

To delete a saved game, simply call the DeleteSavedGame method.

EasyMobile

savedGame

GameServices SavedGames savedGame

Fetching All Saved Games

When implement the saved games feature in your game, chances are you will want to show the user a list of existing
saved games for them to choose from. In such case, you can use the FetchAllSavedGames method to retrieve all
know saved games. A callback will be invoked when the method completes, receiving an array of saved games which
can be empty if no saved game was created before. Note that all the returned saved games are NOT open.

If the current platform is Google Play Game Services, this method retrieves saved games from the data source

specified in the module settings.

EasyMobile

GameServices SavedGames
SavedGame games error

error

Debug games Length



Debug error

[Android] Built-in Saved Game Ul

On Android, the Saved Games feature of Google Play Game Services offers a built-in Ul from which the user can
open, select or delete a saved games. You can show this Ul by calling the ShowSelectSavedGameUl method. A
callback will be invoked when the Ul is closed, receiving the selected saved game if any.

This method is a no-op on iOS/Game Center platform.

EasyMobile

GameServices SavedGames

game error
error

Debug game Name

Debug error



Game Services: PlayMaker Actions
The PlayMaker actions of the Game Services module are group in the category Easy Mobile - Game Services in the
PlayMaker's Action Browser.

Please refer to the GameServicesDemo_PlayMaker scene in folder
Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

G I -
™= U | P
b:? Convert ] l’ 1
[ Debug | !
o] Device | E
[ Easy Mobile - Advertising ] |
[ Easy Mobile - Core ]

]

[ Easy Mobile - Demao Actions

Came Service_ls Auto Init

GCame Service_ls Initialized

GCame Service_Is Module Enabled
Game Service_Load Friends

GCame Service_Load Local User Score
GCame Service_Load Scores

GCame Service_Load Users

GCame Service_Managed Init

GCame Service_Report Achievement Progress
Game Service_Report Score

GCame Service_Reveal Achievement
Game Service_Select Achievement
GCame Service_Select Leaderboard
GCame Service_Show Achievements Ul
GCame Service_Show Leaderboard Ul
Came Service_Sign Out

GCame Service_Unlock Achievement

Easy Mobile - Game Services
GCame Service_lnit

Easy Mobile - Gif ]|

Easy Mobile - In-App Purchasing ]|
Easy Mohile - Mative APls |
Easy Mobile - Notifications ] |
Easy Mohile - Privacy |
Easy Mobile - Saved Games ] |
Easy Mobile - Sharing ] =

Game Service_lnit (8]

[Only use this if you disabled the Automatic Login option of the Game Service module]Initializes the service.
This is required before any other actions can be done e.g reporting scores.During the initialization process, a
login popup will show up if the user hasn't logged in, otherwisethe process will carry on silently.Note that on
i05, the login popup will show up automatically when the app gets focus for the first 3 timeswhile subsequent
authentication calls will be ignored.

[ Preview Add Action To State




Saved Games

The PlayMaker actions of the Saved Games feature are group in the category Easy Mobile - Saved Games in the
PlayMaker's Action Browser.

Please refer to the GameServicesDemo_SavedGames_PlayMaker scene in folder
Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

G I -
T‘ el |
E Convert Y
[ Debug
[D Device
[ Easy Mobile - Advertising

Easy Mobhile - Core

Easy Mobile - Demao Actions
Easy Mobile - Game Services
Easy Mobile - Gif

Easy Mobile - In-App Purchasing
Easy Mobile - Mative APls
Easy Mobile - Notifications
Easy Mohile - Privacy

Easy Mobhile - Saved Games

Saved Game_Delete Saved Game

Saved Game_Fetch All Saved Games

Saved Came_GCet Default Conflict Resolution Strategy
Saved Game_|s Feature Enable

Saved Came_Open

Saved Game_Read Saved Game Data

Saved Game_Show Select Saved Game Ul

Saved Game_Write Saved Game Data

Saved Game_Write Saved Game Data With Info Update
[ Easy Mobile - Sharing ]
| Easy Mobile - Utilities |
['F Effects ]
[E Enum ]
E GameOhject |
B Gul ]
™ GUIElement |
2] CUlLayout ]
[L Input ] .
e Level Ik
Saved Game_Delete Saved Game [
Deletes the specified saved game.This will delete the data of the saved game locally and on the cloud.
Saved Game Name =
¥ Preview Add Action To State




PlayMaker Actions

97



GIF: Introduction

GIF module is available on Easy Mobile Pro only.

The GIF module provides you convenient tools to record screen activities into a short clip, play the recorded clip and
export it into a GIF image. You can then upload the GIF file to hosting sites like Giphy and finally share its URL to
social networks. In short, this module helps you easily add the GIF sharing feature to your game, which allows the
user to share animated GIF images of the gameplay, instead of still screenshots, to social networks including
Facebook and Twitter. The following picture illustrates a typical workflow of such feature.

‘ Playback \
Upload GIF
[ Export GIF ]—b[ to Giphy ]—»[ Share GIF URL ]

[ Record Screen ]—»[ Recorded Clip

Here're some highlights of this module:
e High performance, mobile-friendly GIF generator

o Low overhead screen/camera recorder
o GIF generation is done in native code (iOS and Android) on a separate thread to allow fast exporting while
minimizing impact to the main thread. Export callbacks are still called from main thread though, so you can
safely access Unity APl in the callback handlers
Flexible, fully controllable process

o You have full control on the sizes, length, frame rate, loop mode and quality of the exported GIF
o You can also set the priority of the exporting thread to best suit your needs
High quality GIF

o Exported GIF employs GIF89a format and uses 256-color local palettes (one palette per frame)
o Frame image data is LWWZ compressed
Works in Unity editor

o GIF exporting also works in the editor, mostly for testing purpose. On mobiles, the exporting is done in native
code, while in editor it is done in managed code using an adapted version of the Moments plugin (see
Acknowledgement)

Easy GIF sharing

o This module also provides Giphy API for uploading GIF images to Giphy, so that they can be shared and
played on major social networks including Facebook and Twitter using the Giphy hosted URLs

Acknowledgement

The recorder used in this module is adapted from the recorder of the Moments plugin by Chman (Thomas Hourdel).
Also, in Unity editor, GIF generation is done using an adapted version of this plugin.


https://giphy.com/
https://en.wikipedia.org/wiki/Lempel–Ziv–Welch
https://github.com/Chman/Moments

Introduction

99



GIF: Setup

This section explains the various components, objects and concepts involved in clip recording, clip playing and GIF
exporting. It also provides a guide on creating and configuring relevant objects and components.

Recorder Component

The Recorder component records the content rendered by a camera and returns the recorded clip. To start recording,
simply add a Recorder component to the camera that renders the content you're interested in recording (normally this
will be the Main Camera). To add the component to a camera, select that camera in the Hierarchy, then click Add
Component > Easy Mobile > Recorder.

4 Easy Mobile
Clip Player

@ Clip Player (U1
Recorder

Add Component

Once the Recorder component is added to the camera, you can start configuring it in the inspector to determine how
the recorded clip (and as a result, the exported GIF) will be like.

¥ || [ Recorder (Script) 0 %,
Auto Height [
Width 200
Height 356
Frames Per Second o 15
Length — 3—
Estimated VRam Usage 12.222 MB
Current State Stopped

e Auto Height. whether the clip height should be computed automatically from the specified width and the camera's
aspect ratio, which is useful to make sure the exported GIF has a correct aspect ratio

e Width: the width of the recorded clip in pixels

e Height: the height of the recorded clip in pixels

e Frames Per Second: the frame rate of the clip

e Length: the clip length in seconds; the recorder automatically discards old content to preserve this length, e.g. if
you set this value to 3 seconds, only last 3 seconds of the recording will be stored in the resulted clip, the rest will



be discarded
e Estimated VRam Usage: the estimated memory used for recording, calculated based on the above settings
e Current State: the current status of the recorder, which is either Stopped or Recording

Now that the recorder is configured, you can start and stop its recording activity from script (see the Scripting
section). Once the recording is stopped, the recorded clip will be returned for playback of GIF exporting.

Recording the Ul

To record the Ul (Canvas content), you need to set the Canvas Render Mode to World Space or Screen Space
- Camera, and set the Render Camera to the one containing the Recorder component in the latter case.

Recording multiple composited cameras

If your scene contains multiple cameras being composited (using Camera.depth and Clear flags), you can add
the Recorder component to the top-most camera, so it captures whatever content being composited and shown

by that camera.

AnimatedClip Class

Recorded clips are represented by the AnimatedClip class, which has following properties:

e Width: the width of the clip in pixels
Height: the height of the clip in pixels

Frame Per Second: the frame rate of the clip
Length: the length of the clip in seconds

Frames: an array of frames, each frame is a Render Texture object

Playback

Easy Mobile provides two built-in objects dedicated for playing recorded clips: the Clip Player and Clip Player Ul
objects. You can create them from the context menu (as you would with other Unity built-in objects), configure them in
the inspector, and start or stop their playing activity from script (see the Scripting section).

Clip Player

The Clip Player is a non-Ul object, which is basically a Quad object equipped with a ClipPlayer component. It is meant
to be used inside the game world. To create a Clip Player object, right-click in the Hierarchy window to open the
context menu, then select Easy Mobile > Clip Player.


https://docs.unity3d.com/Manual/class-RenderTexture.html

Copy
Paste

Rename
Duplicate
Delete

Create Empty
3D Object
2D Object
Light

Audio

ul

Easy Mobile
Particle System
Camera

EasyMobile Instance

Clip Player {(UI)

R

Each Clip Player object contains a ClipPlayer component.

T Clip Player (Script)

Script - ClipPlayer

Scale Mode [ Auto Height

L]
[

The only parameter of this component is the Scale Mode, which can take one of 3 values:

e None: don't adjust the object sizes

e Auto Height: keeps the current height of the object (the Y component of its localScale), and adjust the width (the
X component of its localScale) to match the aspect ratio of the clip being played

o Auto Width: keeps the current width of the object (the X component of its localScale), and adjust the height (the Y
component of its localScale) to match the aspect ratio of the clip being played

Clip Player Ul

The Clip Player Ul, as it name implies, is a Ul object living inside a Canvas. It is the object to use when you want to
play a clip inside the Ul. It is basically a Raw Image object equipped with a ClipPlayerUl component. To create a Clip
Player Ul object, right-click in the Hierarchy window to open the context menu, then select Easy Mobile > Clip Player

().
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Each Clip Player Ul object contains a ClipPlayerUl component.

v|E  Clip Player UI (Script)

Script = ClipPlayerU|

Scale Mode | Auto width

L]
[

The only parameter of this component is the Scale Mode, which can take one of 3 values:

e None: don't adjust the object sizes

e Auto Height: keeps the current height of the object (the Height value in its Rect Transform), and adjust the width

(the Width value in its Rect Transform) to match the aspect ratio of the clip being played

e Auto Width: keeps the current width of the object (the Width value in its Rect Transform), and adjust the height

(the Height value in its Rect Transform) to match the aspect ratio of the clip being played

Custom Clip Player

Beside the two built-in clip players provided by Easy Mobile, you can construct your own player to serve your specific
needs. To make it consistent with other players, and compatible with Easy Mobile API, this player should contain a
script implementing the IClipPlayer interface, which is responsible for applying the frames (RenderTextures) of the

clip, at the required frame rate, to whatever texture-displaying component it is equipped with.



GIF: Scripting

This section provides a guide to work with the GIF module scripting API. At this stage, it's assumed that you have
setup a recorder for the camera you want to record, and created an appropriate clip player to play the recorded clip. If
you're not familiar with these concepts, please review the Setup section.

You can access the GIF module API via the Gif class under the EasyMobile namespace. As for Giphy API, use

the Giphy class.

Recording

To start recording on the created recorder, use the StarfRecording method. You can do this as soon as the game
starts; the recorder only stores a few last seconds (specified by the Length parameter in the Recorder inspector) of
the recording, and automatically discards the rest.

EasyMobile

recorder

Gif recorder

To stop recording, simply call the StopRecording method, passing the relevant recorder. The method returns an
AnimatedClip object, which can be played or exported into a GIF image afterward. To continue the previous example:

EasyMobile

recorder

myClip

Gif recorder



myClip Gif recorder

Playback

To play a recorded clip using a pre-created clip player, use the PlayClip method. This method receives as argument
an IClipPlayer interface, which is implemented by both ClipPlayer and ClipPlayerUI classes, therefore it works with
both Clip Player and Clip Player Ul object. The second argument is an AnimatedClip object. Other arguments include
an optional delay time before the playing starts, and the looping mode. You can pause, resume and stop the player
using the PausePlayer, ResumePlayer and StopPlayer methods, respectively.

To continue the previous example:

EasyMobile
recorder
clipPlayer
myClip
Gif recorder
myClip Gif recorder

Gif clipPlayer myClip



Gif clipPlayer myClip

Gif clipPlayer
Gif clipPlayer
Gif clipPlayer

Exporting GIF

To export the recorded clip into a GIF image, use the ExportGif method. In the editor, the exported GIF file will be
stored right under the Assets folder; on mobile devices, the storage location is Application.persistentDataPath. You
can specify the filename and the quality of the GIF image as well as the priority of the exporting thread. The quality
setting accepts values from 1 to 100 (inputs will be clamped to this range). Bigger values will result in better looking
GIFs, but will take slightly longer processing time; 80 is generally a good value in terms of time-quality balance. This
method has two callbacks: one is called repeatedly during the process and receives the progress value (0 to 1), the
other is called when the export completes and receives the file path of the generated image. Though the GIF
generation process is done in a separate thread, these callbacks are guaranteed to be called from the main thread, so
you can safely access all Unity API from within them.

In the rare case that you want to control the looping mode of the exported GIF (the default is loop indefinitely), use the
variant of ExportGif that has a loop parameter (note that some GIF players may ignore this setting):

e Joop < 0: disable looping (play once)
e Joop = 0: loop indefinitely
e Joop > 0: loop a number of times

In the following example, we'll export a GIF image from the recorded clip returned after the recording has stopped.

EasyMobile

recorder

myClip

Gif recorder


https://docs.unity3d.com/560/Documentation/ScriptReference/Application-persistentDataPath.html

myClip Gif recorder

filename
loop
quality
tPriority System Threading ThreadPriority Normal
Gif myClip
filename
loop
quality
tPriority
OnGifExportProgress
OnGifExportCompleted
clip progress
Debug progress
clip path
Debug path

Disposing of AnimatedClip

Internally, each AnimatedClip object consists of an array of RenderTexture, a "native engine object" type, which is not
garbage collected as normal managed types. That means these render textures won't be "destroyed" automatically
when their containing clip is garbage collected (the clip object does get collected, but the render textures it references
don't, thus creating memory leaks). To take care of this issue, we have the AnimatedClip implement the IDisposable
interface and provide the Dispose method to release the render textures, as Unity advised. It's strongly recommended
that you call this Dispose method, preferably as soon as you're done with using a clip (e.g. after playing or exporting
GIF), to make sure the render textures are properly released and not cause memory issues.

We'll extend the OnGifExportCompleted callback handler of the previous example to dispose the recorded clip as
soon as we've generated a GIF image from it.


https://docs.unity3d.com/560/Documentation/ScriptReference/RenderTexture.html

clip path
Debug path

// We've done using the clip, dispose it to save memory
clip myClip

myClip
myClip

Since version 2.1.0, we've updated AnimatedClip such that it automatically releases the RenderTexture object
once it is collected, thus avoiding memory leaks even if you forget to call Dispose. However, it can take a long
time before a clip gets collected by the garbage collector, so it's still a good practice to dispose a clip as soon as
you're done using it to avoid wasting memory.

Sharing GIF

Now that a GIF image has been created, you may want to share it (because it's not fun otherwise, is it?). A common
approach is to first upload the image to Giphy, a popular GIF hosting site, and then share the returned URL to other
social networks like Facebook and Twitter, using Easy Mobile's Native Sharing feature (see the Native Sharing >
Scripting section, in particular the ShareURL method).

According to Giphy APl documentation, hosted Giphy URLs are supported and play on every major social
network.

Upload to Giphy

To upload a GIF image to Giphy, use the Upload method of the Giphy class. You can upload a local image on your
device, or an image hosted online, provided that you have its URL. Before doing so, you'll need to prepare the upload
content by creating a GiphyUploadParams struct. In this struct you'll specify either the file path of the local image, or
the URL of the online image to upload. Note that if both parameters are provided, the local file path will be used over
the URL. Within this struct you can also specify other optional parameters such as image tags, the source of the
image (e.g. your website), or mark the image as private (only visible by you on Giphy). The Upload method has three
callbacks: the first one is called repeatedly during the upload process, receiving a progress value (0 to 1); the second
one is called once the upload has completed, receiving the URL of the uploaded image; and the last one will be called
if the upload has failed, receiving the error message. All callbacks are called from the main thread.

Giphy Beta and Production Key

The Upload method has two variants: one using Giphy's public beta key, and the other using your own channel
username and production API key. The public beta key is meant to be used in development only. According to
Giphy Upload API documentation, it is "subject to rate limit constraints”, and they "do not encourage live
production deployments to use the public key". If you have created a Giphy channel and want to upload GIF
images directly to that channel, you'll need to request an Upload Production Key, then provide that key and your
channel username to the Upload method.

We'll extend the above example, and modify the OnGifExportCompleted callback handler to upload the GIF image to
Giphy once it is created. We'll demonstrate two cases: upload using the public beta key and upload using your own
production key.

// This callback is called once the GIF exporting has completed.
// 1t receives a reference to the original clip and the filepath of the generated image.
clip path

Debug path


https://giphy.com/
https://github.com/giphy/Giphyapi#overview-1
https://github.com/giphy/Giphyapi#upload-api
https://github.com/giphy/Giphyapi#request-an-upload-production-key

clip myClip

myClip
myClip

content
content localImagePath path
content tags
content sourcePostUrl
content isHidden

content
content
Giphy content. OnGiphyUploadProgress OnGiphyUploadCompleted OnGiphyUploadFailed
content
Giphy
content
onGiphyUploadProgress
onGiphyUploadCompleted
onGiphyUploadFailed
progress
Debug progress
url
Debug url
error
Debug error

Display the Giphy Attribution Marks

To request a Production Key, Giphy require you to display the "Powered by Giphy" attribution marks whenever their
APl is utilized in your app, and provide screenshots of your attribution placement when submitting for the key. To take
care of this, we provide the static /sUsingAPI boolean property inside the Giphy class. This property will be true as
long as Giphy APl is in use, to let you know when to show their attribution marks. You can display the attribution logo
using an Image or a Sprite object, then poll this property inside the Update() function, and activate or deactivate the

object accordingly.

You can download Giphy's official attribution marks here.


https://github.com/giphy/Giphyapi#request-a-production-key
https://github.com/giphy/Giphyapi#request-a-production-key

attribution

attribution Giphy IsUsingAPI

Share Giphy URLs

After uploading your GIF image to Giphy and obtain its URL, you can share this URL using the ShareURL method of
the MobileNativeShare class. In the example below, we'll modify the OnGiphyUploadCompleted callback handler of
the previous example to store the returned URL into a global variable, which can be used for later sharing.

giphyURL
url
Debug url
giphyURL url
giphyURL

MobileNativeShare giphyURL



PlayMaker Actions

GIF: PlayMaker Actions

The PlayMaker actions of the GIF module are group in the category Easy Mobile - Gif in the PlayMaker's Action

Browser.

Please refer to the GifDemo_PlayMaker scene in folder Assets/EasyMobile/Demo/PlayMakerDemo/Modules for

an example on how these actions can be used.

‘ar #,
T‘ o
' E Conwvert

[i' Debug

[ 0 Device

Easy Mobile - Advertising

Easy Mobhile - Care

Easy Mohile - Demao Actions

Easy Mobile - Game Services

Gif_Clip Player Controller
Gif_Dispose Clip

Gif_Export Gif

GCif_Get Animated Clip Content
Gif_Is Recording

Gif_Is Using Giphy Api
Gif_Start Recording

Gif_Stop Recording
Gif_Upload To Giphy
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Easy Mobile - Gif i

Easy Mobile - In-App Purchasing

Easy Mohile - Mative APls
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Easy Mohile - Privacy

Easy Mobile - Saved Games

Easy Mobile - Sharing

Control Action

Action Type Play

Play Params
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Gif_Clip Player Controller [

Plays, pauses, resumes or stops the specified clip player.

Clip Player

Flayer Type Clip Player Ul N

Clip Player Ul Mone (Clip Player UI) (o]

Clip None
Start Delay 0

Loop 4

[+ Preview |

Add Action To State
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PlayMaker Actions
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In-App Purchasing: Introduction

The In-App Purchasing module helps you quickly setup and sell digital products in your game. Here're some highlights
of this modules:

e Leverages Unity In-App Purchasing service

o This module is built on top of Unity IAP service, a powerful service that supports most app stores including
iOS App Store, Google Play, Amazon Apps, Samsung GALAXY Apps and Tizen Store
o Unity IAP is tightly integrated with the Unity engine, so compatibility and reliability can be expected
e Easy management of product catalog

o Easy Mobile's custom editor features a friendly interface that helps you easily add, edit or remove products
o Receipt validation

o Local receipt validation that offers extra security



Settings

In-App Purchasing: Settings

To use the In-App Purchasing module you must first enable it. Go to Window > Easy Mobile > Settings, select the In-

App Purchasing tab, then click the right-hand side toggle to enable and start configuring the module.

Enabling Unity IAP

The In-App Purchasing module requires Unity IAP service to be enabled. It will automatically check for the service's
availability and prompt you to enable it if needed. Below is the module settings interface when Unity IAP is disabled.
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Settings

To use Unity In-App Purchasing service, you must first set up your project for Unity Services.

To enable Unity IAP service go to Window > Services and select the In-App Purchasing tab.

SERVICES

o Analytics

< Cloud Build

% Multiplayer
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https://docs.unity3d.com/Manual/SettingUpProjectServices.html

Settings

In the opened configuration window, click the toggle at the right-hand side or the Enable button to enable Unity IAP
service.

s IN-APP PURCHASING

Note: Enabling In-App Purchasing also enables Unity Analytics.

Amazon Apps | Amazon Underground || Google Play || i0S App Store
Mac App Store | Samsung GALAXY Apps | Tizen Store || Windows Store

A dialog window will appear asking a few questions about your game in order to ensure COPPA compliance.

Next click the Import button to import the Unity IAP package to your project.
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Settings

s IN-APP PURCHASING

Mote: disabling Analytics also disables In-App Purchasing.

Amazon Apps | Amazon Underground || Google Play | i0S App Store
Mac App Store | Samsung GALAXY Apps | Tizen Store || Windows Store

After importing, there should be a UnityPurchasing folder added under Assets/Plugins folder.

Enabling Unity IAP service will automatically enable the Unity Analytics service (if it's not enabled before), this is a
requirement to use Unity IAP. Go back to the Services panel and make sure that both In-App Purchasing and
Analytics services are now enabled.
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Settings

SERVICES

-

o4 Analytics

& Cloud Build

S In-App Purchasing

«% Multiplayer

After enabling Unity IAP service, the settings interface of the In-App Purchasing module will be updated and ready for
you to start configuring.
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" IN-APP PURCHASING o )

The In-App Purchasing module leverages Unity IAP to help you quickly setup and sell
digital goods in your game,

~ TARGET ANDROID STORE S
Target Android Store | Google Play t]
~ RECEIPT VALIDATION S

|Uni1:',r IAP offers local receipt validation for extra security, Apple stores and Google Play store
only.

Validate Apple Receipt
Validate Gooagle Flay Receipt

Please go to Window = Unity IAP = IAP Receipt Validation ©bfuscator and create
obfuscated secrets to enable receipt walidation for Apple stores and Google Play store,
Mote that vou don't need to provide a Google Play public key if you're only targeting Apple
stores.

o
-~ PRODUCTS s

|N-:- products added. |
[ Add Mew Product ]

f—:E COMSTANTS GEMERATIOMN s

Generate the static class EasyMabile.EM_IAPCaonstants that contains the constants of product
names. Remember to regenerate if you make changes to these names,

[ Generate Constants Class ]

Target Android Store

If you're building for Android platform, you need to specify your target store. In the [ANDROID] TARGET STORE
section select your target store from the dropdown.

f—)'—'"__ TARGET ANDROID STORE S
Target Android Store | Google Play : |
v Google Play
—
—~ RECEIPT VALIDATION Amazon App Store e
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only.
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Apple Ask-To-Buy



Since iOS 8.0, Apple introduces a new parental control feature called Ask To Buy. Basically, Ask To Buy purchases
will defer for parental approval. When this occurs, the In-App Purchasing module will notify your app by raising the
PurchaseDeferred event, which you can subscribe to perform necessary actions, e.g. updating your Ul to reflect the
deferred state of the purchases.

In the APPLE ASK-TO-BUY section you can check the Simulate Ask-To-Buy option to enable the simulation of this
feature in the sandbox environment, which is useful for testing during development.

This setting has no effect on non-Apple platforms.

‘ ~ APPLE ASK-TO-BUY ‘

|5imu|ate Ask-To-Buy [ |

Apple Promotional Purchases

Apple allows you to promote in-app purchases through your app’s product page. Unlike conventional in-app
purchases, Apple promotional purchases initiate directly from the App Store on iOS and tvOS. The App Store then
launches your app to complete the transaction, or prompts the user to download the app if it isn’t installed.

‘ ~ APPLE PROMOTIONAL PURCHASES ‘

| Intercept Promotional Purchases  [of |

You can instruct the In-App Purchasing module to intercept these promotional purchases by checking the Intercept
Promotional Purchases option in the APPLE PROMOTIONAL PURCHASES section. Once a promotional purchase is
intercepted, the PromotionalPurchaselntercepted event will be fired. You can subscribe to this event and in its handler
perform necessary actions such as presenting parental gates, sending analytics events, etc. before sending the
purchase back to Apple by calling the ContinueApplePromotionalPurchases method, which will initiate any queued-up
payments. If you do not enable this option, the promotional purchases will go through immediately with the
PurchaseCompleted or PurchaseFailed event being fired according to the purchase result, and the
PromotionalPurchaselntercepted will never be raised.

e The Intercept Promotional Purchases setting has no effect on non-Apple platforms.
e |tis vital to call the ContinueApplePromotionalPurchases method in the handler of the
PromotionalPurchaselntercepted event for the purchases to be processed properly after being intercepted.

Receipt Validation

The receipt validation feature provides extra security and helps prevent prevent fraudulent users from accessing
content they have not purchased. This feature employs Unity IAP's local receipt validation, which means the validation
takes place on the target device, without the need to connect to a remote server.

Receipt validation is available for Apple stores and Google Play store. Please find more information about Unity
IAP's receipt validation here.

Obfuscating Encryption Keys

To enable receipt validation, you must first create obfuscated encryption keys. The purpose of this obfuscating
process is to prevent a fraudulent user from accessing the actual keys, which are used for the validation process. To
obfuscate your encryption keys, go to Window > Unity IAP > Receipt Validation Obfuscator.


https://developer.apple.com/library/archive/technotes/tn2259/_index.html#//apple_ref/doc/uid/DTS40009578-CH1-UPDATE_YOUR_APP_FOR_ASK_TO_BUY
https://developer.apple.com/app-store/promoting-in-app-purchases/
https://docs.unity3d.com/Manual/UnityIAPValidatingReceipts.html

IAP Obfuscator

Google Play Store Public Key
lMIIBIjANngqhkiGMBAQEFMGCAQSAMIIBCgKCAQEAjsAxIE

[ Obfuscate secrets

In the opened IAP Obfuscator window, paste in your Google Play public key and hit the Obfuscate secrets button.
According to Unity documentation, this will obfuscate both Apple's root certificate (bundle with Unity IAP) and the
provided Google Play public key and create two C# files AppleTangle and GooglePlayTangle at
Assets/Plugins/UnityPurchasing/generated. These files are required for the receipt validation process.

To obtain the Google Play public key for your app, login to your Google Play Developer Console, select your
app, then navigate to the Services & APIs section and find your key under the section labeled YOUR
LICENSE KEY FOR THIS APPLICATION.

Note that you don't need to provide a Google Play public key if you're only targeting Apple stores.

Enabling Receipt Validation

After creating the obfuscated encryption keys, you can now enable receipt validation for your game. Open the In-App
Purchasing module settings, then in the RECEIPT VALIDATION section check the corresponding options for your
targeted stores.

f—:E RECEIFT VALIDATION s

|Uni1:',r IAP offers local receipt validation for extra security, Apple stores and Google Play store anly. |

Walidate Apple Receipt ¥y
Walidate Coogle Play Receipt ¥4

Product Management

In the PRODUCTS section you can easily add, edit or remove your IAP products.

Adding a New Product

To add a new product, click the Add New Product button.

o
‘ —* PRODUCTS Py ‘

|N-:- products added. |

[ Add New Product ]

A new empty product will be added.



[Untitled Product] A}
Mame | || =

“—

Type | Cansumable
1d | |
b More (Optional)

Fill in the required information for your new product:

e Name: the product name, can be used when making purchases

e Type: the product type, can be Consumable, Non-Consumable or Subscription

e /d: the unified product identifier, you should use this ID when declaring the product on your targeted stores;
otherwise, if you need to have a different ID for this product on a certain store, add it to the Store-Specific Ids
array (see below)

Click More if you need to enter store-specific IDs or fill in optional information for your product.

¥ [Untitled Product] T

MName

|
Type | Cansumable #j &
Id | |
Maore (Cptional)

Price | |

Description

Store-Specific Ids =

e Price: the product price string for displaying purpose

e Description: the product description for displaying purpose

e Store-Specific Ids: if you need to use a different product ID (than the unified ID provided above) on a certain
store, you can add it here

Adding Store-Specific ID

To add a new ID to the Store-Specific Ids array, increase the array size by adjusting the number in the right-
hand side box. A new record will be added where you can select the targeted store and enter the corresponding
product ID for that store.

Below is a sample product with all the information entered including the two store-specific IDs.

Sample Product A b
MName |Sample Product 1=
Type | Cansumable 4| €
Id |com.easymobile.sample_product I
¥ More (Optional)
Price [$1.99 |
Description !This i5 @ sample consumable product :
Store-Specific Ids =
| Apple App Store 4| |com.easymobile.sample_product_ios |
| Amazon App Store 4| |com.easymobile.sample_product_amazaon |




Removing a Product

To remove a product, simply click the [-] button at the right hand side.

Sample Product 4 b
Mame Sample Product B
Type | Cansumable 4| €
Id com.easymobile.sample_product
¥ More (Optional)

Price '$1.99

Description This is a sample consumable product

Store-Specific Ids =

| Apple App Store $ | com.easymobile.sample_product_ios

| Amazon App Store 4| com.easymaobile.sample_product_amazaon

Arranging Product List

You can use the two arrow-up and arrow-down buttons to move a product upward or downward within the product list.

Sample Product A b
Mame Sample Product B
Type | Cansumable 4| 1
Id com.easymobile.sample_product
¥ More (Optional)

Price '$1.99

Description This is a sample consumable product

Store-Specific Ids =

| Apple App Store $ | com.easymobile.sample_product_ios

| Amazon App Store 4| com.easymaobile.sample_product_amazaon

Setup Products for Targeted Stores

Beside creating the product list in Unity, you also need to declare similar products for your targeted stores, e.g. if
you're targeting iOS App Store you need to create the products in iTunes Connect. If you're not familiar with the
process, you can follow Unity's instructions on configuring IAP for various stores, which also include useful information
about IAP testing.

On Google Play store, both consumable and non-consumable products are defined as Managed product. If a
product is set to Consumable type in Unity, the module will automatically handle the consumption of the product
once it is bought and make it available for purchase again.

Constants Generation

Constants generation is a feature of the In-App Purchasing module. It reads all the product names and generates a
static class named EM_IAPConstants that contains the constants of these names. Later, you can use these constants
when making purchases in script instead of typing the product names directly, thus help prevent runtime errors due to

typos and the likes.


https://docs.unity3d.com/Manual/UnityIAPAppleConfiguration.html

Settings

To generate the constants class (you should do this after finishing with product editing), click the Generate Constants
Class button within the CONSTANTS CLASS GENERATION section.

[E 'CONSTANTS GENERATION = }

Generate the static class EasyMobile.EM_IAPConstants that contains the constants of product names, Remember
to regenerate if you make changes to these names,

“I

When the process completes, a file named EM_IAPConstants will be created at Assets/EasyMobile/Generated.

Assets » EasyMobile » Generated :
[€
G

[& EM_IAPConstants

Cenerated

| EM_IAPConstants.cs
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In-App Purchasing: Scripting

This section provides a guide to work with the In-App Purchasing module scripting API.

You can access the In-App Purchasing module API via the InAppPurchasing class under the EasyMobile

namespace.

Initialization

The module will automatically initialize Unity IAP at start without you having to do anything. All further API calls can
only be made after the initialization has finished. You can check if Unity IAP has been initialized:

isInitialized InAppPurchasing

Obtaining Product List

You can obtain the array of all products created in the module settings interface:

IAPProduct products InAppPurchasing

prod products

Debug prod Name

Making Purchases

You can purchase a product using its name.

It is strongly recommended that you use the constants of product names in the generated EM_IAPConstants
class (see IAP Constants Generation section) instead of typing the names directly in order to prevent runtime

errors due to typos and the likes.

InAppPurchasing EM_IAPConstants Sample_Product

A PurchaseCompleted event will be fired if the purchase is successful, otherwise, a PurchaseFailed event will be fired
instead. You can listen to these events and take appropriate actions, e.g. grant the user digital goods if the purchase

has succeeded.

InAppPurchasing PurchaseCompleted PurchaseCompletedHandler
InAppPurchasing PurchaseFailed PurchaseFailedHandler



InAppPurchasing PurchaseCompleted PurchaseCompletedHandler

InAppPurchasing PurchaseFailed PurchaseFailedHandler
InAppPurchasing EM_IAPConstants Sample_Product
product

product Name

EM_IAPConstants Sample_Product
Debug

EM_IAPConstants Another_Sample_Product
Debug

product

Debug product Name

Checking Ownership

You can check if a product is owned by specifying its name. A product is considered "owned" if its receipt exists and
passes the receipt validation (if enabled).

isOwned InAppPurchasing EM_IAPConstants Sample_Product

Consumable products' receipts are not persisted between app restarts, therefore this method only returns true

for those products in the session they're purchased.

In the case of subscription products, this method simply checks if a product has been bought (subscribed)
before and has a receipt. It doesn't check if the subscription is expired or not.

Restoring Purchases

Non-consumable and subscription products are restorable. App stores maintain a permanent record of each user's
non-consumable and subscription products, so that he or she can be granted these products again when reinstalling

your game.

Apple normally requires a Restore Purchases button to exist in your game, so that the users can explicitly initiate the
purchase restoration process. On other platforms, e.g. Google Play, the restoration is done automatically during the

first initialization after reinstallation.



During the restoration process, a PurchaseCompleted event will be fired for each owned product, as if the user
has just purchased them again. Therefore you can reuse the same handler to grant the user their products as
normal purchases.

On iOS, you can initiate a purchase restoration as below.

InAppPurchasing

A RestoreCompleted event will be fired if the restoration is successful, otherwise, a RestoreFailed event will be fired
instead. Note that these events only mean the success or failure of the restoration itself, while the
PurchaseCompleted event will be fired for each restored product, as noted earlier. You can listen to these events and
take appropriate actions, e.g. inform the user the restoration result.

The RestoreCompleted and RestoreFailed events are only raised on iOS.

InAppPurchasing RestoreCompleted RestoreCompletedHandler
InAppPurchasing RestoreFailed RestoreFailedHandler

Debug

Debug

InAppPurchasing RestoreCompleted RestoreCompletedHandler
InAppPurchasing RestoreFailed RestoreFailedHandler

Apple Ask-To-Buy

On iOS 8.0 or newer, Ask To Buy purchases will defer for parental approval. You can subscribe to the
PurchaseDeferred event to acknowledge when this occurs, and perform relevant actions such as updating Ul to reflect
the deferred state of the purchase. When the purchase is approved or rejected, the normal PurchaseCompleted or
PurchaseFailed events will be fired.

InAppPurchasing PurchaseDeferred PurchaseDeferredHandler

InAppPurchasing PurchaseDeferred PurchaseDeferredHandler

product



Debug product Name

You can simulate Ask To Buy feature in the sandbox app store for testing during development, see
Settings/Apple Ask-To-Buy.

Apple Promotional Purchases

If you have enabled the Intercept Promotional Purchases option in the In-App Purchasing module settings, the
PromotionalPurchaselntercepted event will be fired every time a promotional purchase is intercepted. In the handler of
this event you can perform relevant actions such as presenting parental gates, sending analytics events, etc. After
that you must call the ContinueApplePromotionalPurchases method to continue the normal processing of the
purchase. This will initiate any queued-up payments. Once the transaction is done, the normal PurchaseCompleted or
PurchaseFailed event will be fired according to the purchase result.

If the Intercept Promotional Purchases option is disabled, the PromotionalPurchaselntercepted event will never

ocCcur.
InAppPurchasing PromotionalPurchaseIntercepted PromotionalPurchaseInterceptedHandler
InAppPurchasing PromotionalPurchaseIntercepted PromotionalPurchaseInterceptedHandler
product
Debug product Name
InAppPurchasing

You can also use the SetAppleStorePromotionVisibility and SetAppleStorePromotionOrder methods to respectively
set the visibility of a promotional product and the order of visible promotional products on the Apple app store of the
current device.



In-App Purchasing: Advanced Scripting

This section describes the methods to accomplish tasks beyond the basic ones such as making or restoring
purchases. These tasks include retrieving product localized data, reading product receipts, refreshing receipts, etc.

Most of the methods described in this section are only available once Easy Mobile's IAP module and Unity IAP
service are enabled, which is indicated by the definition of the symbol EM_UIAP. Therefore, you should always

wrap the use of these methods inside a check for the existing of this symbol.

Also, the types exposed in these methods are only available when the Unity IAP package is imported, and you
should include the UnityEngine.Purchasing and UnityEngine.Purchasing.Security namespaces at the top of

your script for these types to be recognized.

Getting Unity IAP's Product Object

The in-app products are represented in Unity IAP by the Product class, which is different from Easy Mobile's
IAPProduct class, whose main purpose is for settings and displaying. This Product class is the entry point to access
product-related data including its metadata and receipt, which is populated automatically by Unity IAP. To obtain the
Product object of an in-app product, call the GetProduct method with the product name.

UnityEngine Purchasing

sampleProduct InAppPurchasing EM_IAPConstants Sample_Product
sampleProduct
Debug sampleProduct availableToPurchase

sampleProduct hasReceipt

Debug sampleProduct receipt

Getting Product Localized Data

You can get a product's metadata retrieved from targeted app stores, e.g. localized title, description and price. This
information is particularly useful when building a storefront in your game for displaying the in-app products. To get the
localized data of a product, call the GetProductLocalizedData and specify the product name. The following example
iterates through the product list and retrieve the localized data of each item.

UnityEngine Purchasing



IAPProduct

data

Debug
Debug
Debug

products

prod

data

EM_Settings InAppPurchasing Products

products

InAppPurchasing prod Name

data localizedTitle
data localizedDescription
data localizedPriceString

Getting Subscription Info

You can get a subscription product's information such as expire date using the GetSubscriptioninfo method. Internally,

this method uses Unity IAP's SubscriptionManager class to retrieve the subscription data. The following example

iterates through the product list and prints the information of each subscription product.

UnityEngine

IAPProduct

p Typ

i

D

Debug
Debug
Debug
Debug
Debug
Debug
Debug
Debug
Debug
Debug
Debug
Debug

Purchasing

products

p

e IAPPro

nfo

ebug

EM_Settings InAppPurchasing Products

products

ductType Subscription

info InAppPurchasing p Name

info
info
info
info
info
info
info
info
info
info
info
info


https://docs.unity3d.com/Manual//UnityIAPSubscriptionProducts.html

Debug info

Working with Receipts

This sections describes methods to work with receipts. Currently, Unity IAP only supports parsing receipts from Apple
stores and Google Play store.

Note that for the receipt reading methods to work, you need to enable receipt validation feature (see the
Receipt Validation section).

Apple App Receipt

On iOS, you can get the parsed Apple App Receipt for your app using the GetAppleAppReceipt method.

UnityEngine Purchasing
UnityEngine Purchasing Security

Application platform RuntimePlatform IPhonePlayer

appReceipt InAppPurchasing

appReceipt

Debug appReceipt appVersion

Debug appReceipt bundleID

Debug appReceipt inAppPurchaseReceipts Length

Apple InAppPurchase Receipt

On iOS, you can get the parsed Apple InAppPurchase receipt for a particular product, using the GetApplelAPReceipt
method with the name of the product.

UnityEngine Purchasing
UnityEngine Purchasing Security

Application platform RuntimePlatform IPhonePlayer


https://developer.apple.com/library/content/releasenotes/General/ValidateAppStoreReceipt/Chapters/ReceiptFields.html#//apple_ref/doc/uid/TP40010573-CH106-SW1

receipt InAppPurchasing EM_IAPConstants Sample_Product

receipt

Debug receipt productID

Debug receipt originalPurchaseDate

Debug receipt originalTransactionIdentifier
Debug receipt purchaseDate

Debug receipt transactionID

Debug receipt quantity

Debug receipt cancellationDate

Debug receipt subscriptionExpirationDate

j —

Google Play Receipt

On Android, you can get the parse GooglePlay receipt for a particular product, using the GetGooglePlayReceipt
method with the name of the product.

UnityEngine Purchasing
UnityEngine Purchasing Security

Application platform RuntimePlatform Android

receipt InAppPurchasing EM_IAPConstants Sample_Product
receipt
Debug receipt packageName
Debug receipt productID
Debug receipt purchaseDate
Debug receipt purchaseState
Debug receipt transactionID
Debug receipt purchaseToken

Refreshing Apple App Receipt

Apple provides a mechanism to fetch a new App Receipt from their servers, typically used when no receipt is currently
cached in local storage SKReceiptRefreshRequest. You can refresh the App Receipt on iOS using the
RefreshAppleAppReceipt method. Note that this will prompt the user for their password.

Application platform RuntimePlatform IPhonePlayer

InAppPurchasing SuccessCallback ErrorCallback


https://developer.apple.com/library/ios/documentation/StoreKit/Reference/SKReceiptRefreshRequest_ClassRef/index.html#//apple_ref/occ/cl/SKReceiptRefreshRequest

Advanced Scripting

}
}
void SuccessCallback(string receipt)
{
Debug.Log("App Receipt refreshed successfully. New receipt: " + receipt);
}
void ErrorCallback()
{
Debug.Log("App Receipt refreshing failed.");
}
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In-App Purchasing: PlayMaker Actions

The PlayMaker actions of the In-App Purchasing module are group in the category Easy Mobile - In-App Purchasing
in the PlayMaker's Action Browser.

Please refer to the InAppPurchasingDemo_PlayMaker scene in folder
Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

IS . ) #,‘
' E Convert &
[ Debug
[ & Device

Easy Mobhile - Core

[ Easy Mobile - Demao Actions
[ Easy Mobile - Game Services
| Easy Mobile - Gif

I
]
]
]
[ Easy Mobile - Advertising ]
]
]
]
|

Easy Mobhile - In-App Purchasing

In App Purchasing_Get All Products

In App Purchasing_GCet Product Data

In &App Purchasing_Get Product Localized Data
In App Purchasing_Get Raw Receipt

In App Purchasing_ls Initialized

In &App Purchasing_ls Module Enabled

In App Purchasing_ls Product Owned

In App Purchasing_0On Purchase Completed
In App Purchasing_On Purchase Failed

In App Purchasing_On Restore Completed
In App Purchasing_On Restore Failed

In App Purchasing_Purchase

In App Purchasing_Restore Purchases

Easy Mohile - Mative APls

Easy Mobile - Notifications
Easy Mohile - Privacy
Easy Mobile - Saved Games

Nl

T

r Bl il F ol

In App Purchasing_Get All Products 1]

Returns arrays of names, IDs and types of all in-app products. Each product is referenced by the same index in
all resulted arrays.

Result

Product Count None "
Product Names None i
Product Ids None i
Product Types Wone n
Price 5trings None "
Descriptions None i

[ Preview Add Action To State




PlayMaker Actions
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Native APIs: Introduction

The Native APls module allows access to mobile native functionalities. The first feature available is native Ul. More
functionalities will be added soon.



Native APIs | Native Ul: Introduction

The Native Ul module allows you to access native mobile Ul elements such as alerts and dialogs. This module
requires no configuration and all tasks can be done from script.

Alerts

Alerts are useful in providing the users contextual information, asking for confirmation or prompting them to make a
selection out of several options. An alert can have one, two or three buttons with it.

Below are the three types of alert on iOS.

Sample Alert Sample Alert
This is a simple (1-button) alert. This is a 2-button alert.
OK Button 1 Button 2
Sample Alert

This is a 3-button alert.

Button 1
Button 2
Button 3

And below are the three types of alert on Android.

This is a simple (1-button) alert. This is a 2-button alert.

Ok Button 2 Button 1

This is a 3-button alert.

Button 2 Button 3 Button 1

Toasts

Toasts are short messages displayed at the bottom of the screen. They automatically disappear after a timeout.
Toasts are available on Android only. Below is a sample toast message.



Native Ul

E) isFirstButionClicked: FALSE
E) issecondButionClicked: FALSE
isThirdButtonClicked: TRUE

ALERT

2-BUTTON ALERT

3-BUTTON ALERT

A toast is a view containing a quick little message

far the user. It's only available on Android.

ANDROID TOAST

This is a sample Android toast

Pl B
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Native APIs | Native Ul: Scripting

This section provides a guide to work with Native Ul scripting API.

You can access the Native Ul module API via the NativeUl class under the EasyMobile namespace.

Alerts

Alerts are available on both iOS and Android platform and can have up to three buttons.
Simple (one-button) alerts are useful in giving the user contextual information. To show a simple alert with the default

OK button, you only need to provide a title and a message for the alert:

alert NativeUI

You can also show a one-button alert with a custom button label.

alert NativeUI

Two-button alerts can be useful when needing to ask for user confirmation. To show a two-button alert, you need to
specify the labels of these two buttons.

alert NativeUI

Three-button alerts can be used to present the user with several options, a typical usage of it is to implement the Rate
Us popup. To show a three-button alert, you need to specify the labels of the three buttons.

alert NativeUI

Whenever an alert is shown, a NativeUl.AlertPopup object is returned, when the alert is closed, this object will fire an
OnComplete event and then destroy itself. The argument of this event is the index of the clicked button. You should
listen to this event and take appropriate action depending on the button selected.

alert NativeUI



alert

alert OnComplete OnAlertCompleteHandler

buttonIndex

buttonIndex

Only one alert popup can be shown at a time. Any call to show an alert while another one is being displayed will be
ignored. You can check if an alert is being shown using the IsShowingAlert method.

isShowingAlert NativeUI

Toasts

Toast is a short message displayed at the bottom of the screen and automatically disappears after a timeout. Toasts
are available only on Android platform. To show a toast message:

NativeUI



Native APIs: PlayMaker Actions

The PlayMaker actions of the Native APls module are group in the category Easy Mobile - Native APIs in the

PlayMaker's Action Browser.

Please refer to the NativeUIDemo_PlayMaker scene in folder

Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how Native Ul actions can be used.

8]

Device

Easy Mobile - Advertising

Easy Mobile - Care

Easy Mohile - Demao Actions

Easy Mobile - Game Services

Easy Mobile - Gif

Easy Mobile - In-App Purchasing

Mobile Mative UI_Toast
Mobile Mative UI_Two Button Alert

Easy Mobile - Native APls

Mobile Mative UI_Alert

Mobile Mative UI_Three Button Alert

Easy Mobile - Motifications

Easy Mohile - Privacy

Easy Mobile - Saved Games

Easy Mobile - Sharing

Easy Mohile - Utilities

Shows a native one-button alert.

Title
Message
Button Label

Result
Event Target

On Complete Event
Button Index

[ Preview

Ok

Self

None

|

|

|

|

|
['F Effects ]
[E Enum ]
E GameObject ]
[ GUI ]
= GUIElement |
] CUlLayout ]
[L Input ]
[Q Level ] .
[ Lights 11
Mobile Mative Ul_Alert Gl

ar || ar

A

Add Action To State




PlayMaker Actions
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Notifications: Introduction

The Notifications module helps you quickly implement notifications feature in your app. Here're some highlights of this
module:

¢ Remote (push) notification
o The module is currently compatible with OneSignal and Firebase Cloud Messaging (FCM). Both are free and
popular cross-platform push notification delivery services.
e Local notification
o One-time and repeat notifications.
o Fully-customizable notifications: sounds, icons, badge, light, vibration, lock-screen visibility, etc. (feature
availability varies between iOS and Android)
o Supports notification custom action buttons.
o Notification Category

o Unifies Android notification category (channel) and iOS notification category, makes it easy to customize and
organize notifications in your app.

o Fully supports notification channels introduced and required since Android O, while maintaining backward-
compatibility with older Android versions, where notification channels don't exist.

o Fully supports notification channel groups introduced since Android O.
e Friendly editor
o Makes it easy to setup remote notification service, manage categories, adding resources, etc.

Easy Mobile's notification APl works on iOS 10 or newer (more than 95% of iOS devices) and Android API 14 or
newer (more than 99% of Android devices).

Understanding Notifications

A notification is basically a message that is displayed by the system outside of your app's Ul to provide the user with
some timely information about your app. The user can open a notification to bring your app to foreground and take
further actions if they wish.

If your app is in foreground at the moment the notification is delivered, then the notification won't be posted (in
other words, it will be silenced). Instead, its data will be sent to the app directly in form of an event.

Notifications appear to users in different locations and formats, plus their appearance varies slightly between iOS and
Android, and among different versions of these platforms. Depending on the current state of your device, notifications
can appear in the status bar (Android), the notification center (iOS), or the lock-screen. Below are the typical
anatomies of iOS and Android notifications.

iOS Notification Anatomy

Here's a typical iOS notification with basic details.


https://onesignal.com/
https://firebase.google.com/docs/cloud-messaging/
https://developer.apple.com/support/app-store/
https://developer.android.com/about/dashboards/index.html

gy EM DEMO x

Demo One-Time Local Notification
Demo Notification Subtitle 0
This is a demo one-time local notification.

Small icon: provided by the system

App name: provided by the system

Title: the notification title provided by you

Subtitle: the optional notification subtitle provided by you

ok~ 0D~

Body: the main notification message provided by you

Android Notification Anatomy

Here's a typical Android notification with basic details.

090 9

B Messages - now v
e— Justin Rhyss
o—* Do you want to go see a movie tonight?

1. Small icon: required, provided by you (if no valid icon specified, Easy Mobile automatically uses the fallback icon,
which is a bell)

App name: provided by the system

Time stamp: provided by the system

Large icon: optional, provided by you (this is usually used only for contact photos; do not use it for your app icon)
Title: the notification title provided by you

R

Body: the main notification message provided by you

You can learn more about iOS notifications here and Android notifications here.

Notification Custom Actions

Beside basic content, you can optionally attach additional action buttons to the notification for specific tasks. Using
unique action IDs, your app can acknowledge the action selected by the user and response accordingly, e.g. open a
particular Ul for the user to perform further interaction.

A notification on iOS can have up to 4 action buttons. However, the number of actions actually displayed depends on
how and where the notification is displayed. For example, banners display no more than two actions. Here's an
example of an iOS notification with 2 action buttons, Action A and Action B.


https://developer.apple.com/notifications/
https://developer.android.com/guide/topics/ui/notifiers/notifications.html

g £v DEMO X

Demo Repeat Local Notification
This is a demo repeat local notification.

j

Action B

Action A
|

A notification on Android can have up to 3 action buttons. Here's a typical Android notification with 2 action buttons,
REPLY and ARCHIVE.

E MOSSIQEs « now A
Justin Rhyss @

REPLY  ARCHIVE

On Android, Easy Mobile supports notification actions on API 23 or newer.

Local Vs. Remote Notifications

Local notifications are notifications scheduled by your app locally. Your app configures the notification content,
specifies a trigger condition, and passes these details to the system, which then handles the delivery of the notification
when the trigger condition is met.

One-time vs. Repeat local notifications

A one time notification is delivered only once. A repeat notification is delivered once every time the repeat
interval passed. Both notification types survive device reboots. If the delivery time is past at the moment the

device has finished reboot, the notification will be delivered immediately.

Remote notifications are sent (pushed) to user devices from a remote server (be it your own server or a 3rd party
server like OneSignal's) via the Apple Push Notification service (APNs) on iOS, or the Google Cloud Messaging
service (GCM) on Android.

Notification Categories

Easy Mobile's cross-platform notification category unifies Android notification channel/category and iOS notification
category, providing a simple and convenient way to customize and organize notifications in your app. You can use
category to control multiple aspects of notifications including importance, light, vibration, sound and action buttons
(configuration varies between platforms, e.g. importance and light are Android-only). All notifications posted to the
same category share the same customization. Every time you schedule a notification, simply set the category it
belongs to and all the settings of that category will be applied to the notification automatically. Using categories is
therefore a more intuitive and efficient way to customize and organize notifications. You can have multiple categories
in your app, each controls a different type of notifications. For example, you can have a category dedicated for game
event notifications, and another category for user (chat) message notifications.

Notification Categories on iOS



On iOS, cross-platform categories automatically translate to native notification categories, taking only the information
on custom actions because iOS notification categories are mostly responsible for configuring custom actions. About
the other settings of the cross-platform category, those are applicable on iOS (e.g. sound) will automatically be
applied when a notification of this category is scheduled.

iOS notification categories are not visible to users. You can learn more about them here.

Notification Categories on Android

On Android 8.0 Oreo (API level 26), a new feature is introduced which is notification channels/categories. Starting in
this version, all notifications must be assigned to a channel or it will not appear. Notification channels offer the ability
to group notifications, and allow users to control the visual and auditory options of each channel from the Android
system settings.

2 w4l 700 20 W'l 700
<  App notifications @ <  Notification category @
e Clock ° Firing alarms & timers

Clock

Allow notification dot & Importance

Lrgent
Categories

Sound
Firing alarms & timers = o
Make sound and pop on scréen

Vibrate
Missed alarms
Make sound Advanced
Stopwaltch Show notification dot
Make sound

Blink light

Timers
Make sound

0On the lock screen

Show all notification content

Upcoming alarms

Make sound

The Android user interface refers to channels as "categories".

On Android 8.0 and newer, Easy Mobile's cross-platform notification categories automatically translate to native
notification channels. Most settings are applicable to Android channels, except the custom actions (Android
notification channels are not responsible for custom actions). When a local notification is scheduled, it will be assigned
to the native notification channel, and the custom actions (if any) found in its cross-platform category are automatically
added when constructing the notification.

On Android 7.1 (API level 25) and lower, there're no notification channels. When a local notification is scheduled,
individual settings will be read from its cross-platform category and applied automatically when constructing the
notification.


https://developer.apple.com/library/content/documentation/NetworkingInternet/Conceptual/RemoteNotificationsPG/SupportingNotificationsinYourApp.html#//apple_ref/doc/uid/TP40008194-CH4-SW26

You can learn more about Android notification channels/categories here.

Default Notification Category

For notifications to work consistently across iOS and Android platform, your app requires at least one notification
category. Easy Mobile has a built-in default category. If you're scheduling a local notification and not specifying any
category, then the default one will be used. This default category can be customized from the module settings, but it

cannot be removed.

Notification Category Groups

You can organize your notification categories into category groups. On Android category groups directly translate to
native channel groups. Below is an example of how notification channels are organized into groups in the system

settings on Android.

OWwid 0 700

Notifications 7]
NotificationChannels ﬂ

On 7]

Badge app icon ®

I POt
New Comments ®
Hew Comments (&)

Notification category groups don't have any effect on iOS.

GDPR Compliance

We recommend you to read the Privacy chapter first to gain a comprehensive understanding of the tools and
resources offered by Easy Mobile to help your app get compliant with GDPR, including the consent dialog and

the consent management system.

Remote notification is one of those services affected by the GDPR, because most providers (including OneSignal and
Firebase) need to collect a device's unique identifier of one kind or another to deliver messages to that device.
Therefore it may be advisable to get the user consent (explicit opt-in) before initializing the service, especially in EEA


https://developer.android.com/training/notify-user/channels.html

region. Easy Mobile provides a native, multi-purpose dialog which you can use to collect user consent for the remote
notification service as well as other relevant services in your app.

Allowing the user to provide and manage consent for all services via a single interface (dialog) is advisable in
terms of user experience, because the user may find it irritating being presented multiple dialogs asking
consent for various things.

Once the push notification consent is collected, you can communicate it to the Notifications module using the
GrantDataPrivacyConsent or RevokeDataPrivacyConsent methods (see Scripting/Working with Consent). The
consent will then be automatically forwarded to the selected remote notification service during its initialization.
Therefore it is important to collect the consent before initializing the remote notification service. Practically, this means
collecting consent before initializing Easy Mobile runtime, which will automatically initialize the remote notification
service (provided that the Auto Initialization feature of the Notifications module is enabled). The next sections detail
how consent is applied to each remote notification service when it is used in your app.

Currently there's only module-level consent available to the Notifications module. Because consent is only
applicable to remote notification service, and only one service can be selected at a time, providing vendor-level
consent would be irrelevant. Instead, the module-level consent (if any) will be used for whichever service being
selected.

OneSignal

If OneSignal is selected as the remote notification provider in your app, the Notifications module will perform
appropriate actions according to the specified consent before initializing OneSignal service. The table below
summarizes the actions taken in each case.

Consent .

Status Actions Taken
Calling OneSignal.SetRequiresUserPrivacyConsent(true); and

Granted OneSignal.UserDidProvideConsent(true); to inform OneSignal that the consent was granted and
then initialize it.

Calling OneSignal.SetRequiresUserPrivacyConsent(true); and

Revoked OneSignal.UserDidProvideConsent(false); to inform OneSignal that the consent was not
granted/revoked.
Do nothing regarding consent. The initialization of OneSignal is carried out as normal (the "pre-
Unknown

GDPR" behavior).

Reference: https://documentation.onesignal.com/docs/unity-sdk#section--setrequiresuserprivacyconsent-

Firebase Cloud Messaging

Once the FCM SDK is imported into your project, it will automatically perform initialization in runtime, during which it
generates an Instance ID, which is used as a registration token within FCM. When an Instance ID is generated the
library will upload the identifier and configuration data to Firebase. Therefore if you want to get an explicit opt-in before
using FCM, you must disable its auto initialization. Please follow the instructions in the Prevent auto initialization
chapter in the FCM documentation for that purpose.

If the consent communicated to the Notifications module is Granted, it will automatically re-enable FCM during the
initialization process by calling the following command:

Firebase Messaging FirebaseMessaging TokenRegistrationOnInitEnabled

Summary


https://documentation.onesignal.com/docs/unity-sdk#section--setrequiresuserprivacyconsent-
https://firebase.google.com/docs/cloud-messaging/unity/client

Introduction

e If you want to get an explicit opt-in before using FCM, you must disable its auto initialization. If the consent
provided to the Notifications module is Granted, FCM will be re-enabled automatically during initialization.

e If you disable the FCM auto initialization and the consent provided to the Notifications module is Revoked
or Unknown, the FCM service won't be re-enabled and it won't function.

e [f you don't want to get an explicit opt-in before using FCM, you can ignore all described actions. The FCM

service will be initialized automatically as normal.
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Settings

Notifications: Settings

To use the Notifications module you must first enable it. Go to Window > Easy Mobile > Settings, select the

Notifications tab, then click the right-hand side toggle to enable and start configuring the module.

Auto Initialization

Auto initialization is a feature of the Notifications module that initializes the service automatically when the module
starts. You can configure this feature in the AUTO-INIT CONFIG section.

On iOS, a popup will appear during the first initialization following the app installation to ask for the user's
permission to enable notifications for your game.
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‘ f_:,_ﬁ AUTO INITIALIZATION ~ ‘

Auto Init [

Auto Init Delay = |2 ‘

e Auto Init: uncheck this option to disable the auto initialization feature, you can start the initialization manually from

script (see Scripting)
e Auto Init Delay: how long after the module start that the initialization should take place

"Module start" refers to the moment the Start method of the module's associated MonoBehavior (attached to the
EasyMobile prefab) runs. If you add the EasyMobile prefab instance to the first scene of your game then this

moment is mostly identical to the launch time of the app.

Remote Notification Setup

Enable Remote Notifications

To enable remote/push notifications for your app, select a valid service provider from the Push Notification Service
dropdown in REMOTE NOTIFICATION SETUP section. Currently OneSignal and Firebase Cloud Messaging services

are supported.

f—:E REMOTE MOTIFICATIONS s

Remote Notification Service
Push Metification Service [ ©ne Signal

A

Mone
‘ o OneSignal plugin is required. u One Signal

[ Firebase ]

Doy

Setup OneSignal

Before You Begin

Before setting up OneSignal in Unity, you must first generate appropriate credentials for your targeted
platforms. If you're not familiar with the process, please follow the guides listed here. You should also follow the
instructions included in that document on performing necessary setup when building for each platform.

Importing OneSignal Plugin

Using OneSignal service requires the OneSignal plugin for Unity. Easy Mobile will automatically check for the
availability of the plugin and prompt you to import it if needed. You can click the Download OneSignal Plugin button to
open the download page for the plugin. Once it is imported into Unity the settings interface will be updated and ready

for you to start configuring.

In fact all you need to do is enter your OneSignal App Id.


https://documentation.onesignal.com/docs/unity-sdk-setup
https://github.com/OneSignal/OneSignal-Unity-SDK

f—:E REMOTE MOTIFICATIONS

Remote Notification Service
Push Meotification Service | ©ne Signal s

‘ ':_Tt,-:l OneSignal plugin is imported and ready to use, ‘

[ Download OneSignal Plugin ]

OneSignal Setup
OneSignal App ID {444

Customizing Notification Sounds and Icons
Here're the guides on customization OneSignal notification sounds and Android notification icons:

e Customize OneSignal Android Notification Icons
e Customize OneSignal Notification Sounds

Setup Firebase Cloud Messaging

Before You Begin

Before setting up Firebase Cloud Messaging in Unity, you will need to create a project in Firebase console. If

you're not familiar with the process, please follow this guide.
Note that for iOS you need to associate your project with an APNs certificate:

e Inside your project in the Firebase console open Project Settings then select the Cloud Messaging tab
e Select the Upload Certificate button to upload your development or production certificate, or both. For each
certificate, select the .p12 file and provide password if any. Make sure the bundle ID for this certificate

matches the bundle ID of your app
e Save

After setting up the project, download the GoogleService-Info.plist file (i0S) or Google-Services.json file
(Android) from the console and drag it into your Unity project (you can place these files anywhere under the

Assets folder of your project).

Importing Firebase Messaging plugin

Using Firebase service requires the Firebase plugin for Unity. Easy Mobile will automatically check for the availability
of the plugin and prompt you to import it if needed. You can click the Download Firebase Plugin button to download
the Firebase Unity SDK. After the downloading finishes, unzip the downloaded file and import the FirebaseMessaging
package into your project. Once it is imported into Unity the settings interface will be updated and ready for you to

start configuring.

Registering Default Notification Topics

Firebase Cloud Messaging has a concept of topic messaging, which allows you to send a message to multiple
devices that have opted into a particular topic. If you want to have some default topics that every instance of your app
subscribes to when it's installed, you can register them in the settings interface. At the Firebase Topics field click the

"+" button and enter all the default topics that you want.

You can learn more about Firebase topic messaging here.


https://documentation.onesignal.com/docs/customize-notification-icons
https://documentation.onesignal.com/docs/customize-notification-sounds
https://console.firebase.google.com/
https://firebase.google.com/docs/unity/setup
https://firebase.google.com/docs/cloud-messaging/ios/certs
https://firebase.google.com/download/unity
https://firebase.google.com/docs/cloud-messaging/unity/topic-messaging

f—;E REMOTE MOTIFICATIONS
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Firebase Setup
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Element 0 SampleTopic0l
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Sending Notifications to Your App

Firebase provides 3 ways to send notifications to your app:

1. Using the notification composer in the Firebase Console - learn more here
2. Using the Admin SDK
3. Using HTTP and XMPP Protocols

Customizing Notification Sounds and Icons

Currently the Firebase notification composer doesn't allow customizing the notification sound and icon (you can only
toggle sound on or off). On iOS, the app icon will be used as the notification icon. On Android, you can setup a default
notification icon for Firebase by adding the following lines between the <application> element of the
AndroidManifest.xml file at the Assets/notifications/Plugins/Android folder.

Then you need to create notification icons at appropriate resolutions (you can use the Android Asset Studio), name
them firebase_notification_icon, place them into a res folder and import the folder into your Unity project using the
Import Res Folder button under the ANDROID NOTIFICATION RESOURCES section of the settings interface (see
chapter Adding Notification Resources). You can also use another name for the icons as long as the name in the
AndroidManifest.xml and the name of the icon files are same.

If you're using other methods to send notifications to your app, you can specify the notification icons and

sounds in the notification content. Just make sure that the specified icons and sounds are available in your app.

iOS Build Notes

After exporting to Xcode, perform the following steps:

e In the General tab, add the UserNotifications framework into your project if it hasn't been added yet.
e In the Capabilities tab, turn on Push Notifications and Background Modes, then check the Remote Notifications

box under Background Modes.

Adding Notification Resources

Android Notification Resources


https://console.firebase.google.com/project/_/notification
https://firebase.google.com/docs/cloud-messaging/send-with-console
https://firebase.google.com/docs/cloud-messaging/admin/
https://firebase.google.com/docs/cloud-messaging/server/

Android notification resources include notification icons and custom notification sounds.

e Custom notification sounds: if you don't want to use the system's default notification sound, you can provide
custom sounds to be played when your notifications are delivered.

e Small notification icons: small icons or status bar icons are required and will be used to represent notifications
from your app in the status bar. Starting with Android 5, the system forces small notification icons to be all white
when your app targets Android API 21+. If you don't make a correct icon, it will most likely be displayed as the
fallback icon (bell) or solid white icon in the status bar.

e Large notification icons: large notifications icons are optional and will show up at different positions on the
notification depending on the Android version (see below screenshot). If you do not specify a large icon, the small
icon will be used.

Nougat (7.0), Oreo (8.0)

Small lcon @ Hang - Location Update - 6:04 PM ~
The group is at 19th and Valencia, near Tacolicious et HAY
Jane, Tony, and Nick R 1

Lollipop (5.0), Marshmallow (6.0)

e ? B i M ™ The group is at 19th and Valencia, near
| Tacolicious
\‘*-. " .\\-._ @ Jane, Tor n k
Large lcon

KitKat (4.4)

The group is at 19th and ...

KitKat (4.4) without Large lcon

@ The group is at 19th and ...

Preparing Android Notification Icons

It's advisable to use the Android Asset Studio to quickly and easily generate small icons with the correct settings. Note
that the default small icons must be named ic_stat_em_default so that Easy Mobile can recognize it. Below is an
example of a res folder containing the default small icons generated by the Android Asset Studio. Later we will import
this folder to Unity so that the icons can be used in your project.



Settings

v [ res

¥ [0 drawable-hdpi

| ie_stat_em_default.png
¥ [ drawable-mdpi

| le_stat_em_default.png
¥ [ drawable-xhdpi

| ie_stat_em_default.png
¥ [ drawable-xxhdpi

| ie_stat_em_default.png
¥ [0 drawable-xohdpi

| le_stat_em_default.png

If you want to have a default large icon, create a 256x256 icon, name it ic_large_em_default and place it in the
drawable-xxxhdpi folder of the same res folder generated previously.

v [ res

¥ [ drawable-hdpi

| le_stat_em_default.png
¥ [ drawable-mdpi

| le_stat_em_default.png
¥ [ drawable-xhdpi

| ie_stat_em_default.png
¥ [ drawable-xxhdpi

| ie_stat_em_default.png
¥ [ drawable-xothdpi

E ic_large_em_default.png

| le_stat_em_default.png

Non-Default Notification Icons

Beside the default icons, you can add more custom icons which can be used when scheduling different types of
notifications. Just use the Android Asset Studio to generate small icons, and create large icons at the correct
sizes (256x256). Then merge them into the same res folder that contains the default icons, making sure the
icons go into their correct subfolders. When scheduling a notification, you can select these custom icons using

their names.
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¥ [(Mres
¥ | | drawable-hdpi
| le_stat_custom.png
| ie_stat_em_default.png
| | drawable-mdpi
| le_stat_custom.png
_| ic_stat_em_default.png
| | drawable-xhdpi
ic_stat_custom.png
| le_stat_em_default.png
| | drawable-xxhdpi
| le_stat_custom.png
| ie_stat_em_default.png
|| drawable-xxxhdpi
E ic_large_custom.png
E ic_large_em_default.png
ic_stat_custom.png
| le_stat_em_default.png

4

4

4

|

Preparing Android Notification Sounds

To add custom notification sounds, create a folder named raw inside the res folder that contains the default
notification icons and place the sound files there. Later these custom sounds can be specified in your project with their
names. Below is an example res folder that contains default icons, custom icons and custom sounds for Android
notifications.

¥ [(Hres
¥ | | drawable-hdpi
| le_stat_custom.png
ic_stat_em_default.png
¥ | | drawable-mdpi
| le_stat_custom.png
| ie_stat_em_default.png
| | drawable-xhdpi
| le_stat_custom.png
| ic_stat_em_default.png
| | drawable-xxhdpi
ic_stat_custom.png
| ie_stat_em_default.png
|| drawable-xxxhdpi
E ic_large_custom.png
E ic_large_em_default.png
| le_stat_custom.png
_| ic_stat_em_default.png
iy WS e
_ notification_2 .wav
- notification.wav

4

4

4

Importing Android Notification Resources



After constructing the res folder with all the required icons and sounds, the next step is import the folder into your
Unity project so the resources can be used in your app. In the ANDROID NOTIFICATION RESOURCES section, click
the Import Res Folder button, then select the generated res folder to import. That's it!

f—:E AMDROID NOTIFICATION RESOURCES )

Use the &ndroid Motification Icon Generator to prepare notification icons, Default small icon should be named
ic_stat_em_default, while default large icon should be ic_large_em_default. You can optionally add custam
notification sounds to the resulted folder. Finally import the folder so the resources can be used in your app.

[ QOpen Android Notification Icon Generator I

[ Import Res Folder I

iOS Notification Resources

On iOS, notification icons are provided by the system, but you can still have custom notification sounds. To add a
custom sound to your iOS app, simply place the sound file anywhere in your Unity project, build your project for iOS
platform, and then drag the sound file to the Xcode project root (remember to select Copy items if needed on the

Xcode import dialog).

=

U

B X =% Q A ©

v @] Unity-iPhone

' notification. waw

[ takuzu.entitlements

» |9 Data

|5l Images.xcassets
Classes
Unity-iPhone Tests
OneSignalNotificationServiceExtension
Framewaorks

Libraries

Yy v¥rvywyywy
F

» | Products
Info.plist
libiconv.2.dylib
LaunchScreen-iPhone.xib
=/ LaunchScreen-iPhonePortrait.png
=/ LaunchScreen-iPhoneLandscape.png
LaunchScreen-iPad.xib
5| LaunchScreen-iPad.png
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Notes on Notification Sounds
e It's recommended to have notification sounds in .wav format so that they can be used on both Android and iOS.

e Make sure sound names are consistent across iOS and Android.

o Notification sounds must be less than 30 seconds to make sure they can be played on both Android and iOS.

Category Management



Notification Category Groups

In the CATEGORY GROUPS section you can add, edit or remove groups for the notification categories in your app.

o— MName
9_

a b~ W N =

f_;,_f CATEGORY GROUP

| Groups with empty name or ID will be ignored.

¥ 1 Category Groups

Id

¥ My Category Group

|My Category Group

|netification.categorygroup test

|

Add Mew Category Group

. Group content: where you fill in group information

. Add button: use this button to add a new group

. Move up button: move the group up, for arrangement purpose
. Delete button: use this button to remove the current group

. Move down button: move the group down, for arrangement purpose

A category group content includes following fields:

e Name: the group name, must not be empty

e Id: the group ID, must not be empty; a category specifies the group it belongs to using this ID

Notification Categories

You can manage the notification categories in your app within the CATEGORIES section.

o
—~ CATEGORIES

71 Categories (alse called channels on Android) provide a unified system to manage and customize

[]
"2 notifications. All notifications posted to a category share the same customization defined by that categary.

Default Category

| ¥our app must have at least ane category, You can madify the default category but not remove it.

¥ Default

Mame

Id

Description

Group Id

Enable Badge
Importance

Lights

Vibration

Lock Screen Visibility
Sound

Action Buttons

|Default

Enutificatinn.categury.default
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| [Mene]
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| Default

A

| Default

A

| Default

| Public

A

| Default

A

Ak

User Categories
2 User Categories

Add New Category

A category content includes following fields:

e Name: category name, only visible on Android devices, this is required

(o]~ Teo)



e [d: category ID, this is required; a notification specifies the category it belongs to using this ID

e Description: optional category description, only visible on Android devices

e Group Id: the identifier of the group this category belongs to

e Enable Badge: [Android only] whether the notifications of this category can appear as badges in a Launcher
application

e Importance: [Android only] how much interruptive - visually and audibly - the notifications of this category should
be

e Lights: [Android only] determines how the notification light should be displayed, on devices that support this
feature

e Light Color: [Android only] the color of the notification light, only configurable when Lights is set to Custom

e Vibration: [Android only] determines how the device should vibrate when a notification arrives

e Vibration Pattern: [Android] the vibration pattern of the device, only configurable when Vibration is set to Custom

e Lock-screen Visibility: [Android only] determines how notifications should be displayed on lock-screen

e Sound: determine whether the default sound, or a custom sound, or no sound at all should be played when a
notification arrives

e Sound Name: the filename (with extension) of the custom notification sound, only configurable if Sound is set to
Custom

e Action buttons: the custom action buttons to be attached to the notifications of this category, each action button
requires the following fields:

o Id: action ID, used to distinguish between actions
o Title: action title, used to display the action button on the notification

Default Category

Your app must have at least one notification category, and Easy Mobile provides a built-in default category. You can
customize it in the Default Category sub-section of the CATEGORIES section. You can't remove the default
category.

User Categories

Beside the default category, you can add as many more categories as you wish. We call these user categories, and
they can be managed in the User Categories sub-section of the CATEGORIES section.

User Categories
¥ 1 User Categories
¥ My Category 1 T e
Name My Category 1 o= o
Id notification.category .test_1 Js 6
Description
Group Id | notification.categarygroup.test |
Enable Badge o
07 Importance | High o
Lights | Custam |
Light Color [ 12
Vibration | Custom |
Vibration Pattern =
Element 0 300
Element 1 500
Lock Screen Wisibility | Private aa
Sound | Custam |
Sound Name notification.wav
Action Buttons + -
1d category .test_1.action_a Title Action &
1d category.test_1.action_b Title Action B
eil Add New Categary




. Category content: where you fill in category information

. Add button: use this button to add a new user category

. Move up button: move the category up, for arrangement purpose

. Delete button: use this button to remove the current user category

a b~ WON -

. Move down button: move the category down, for arrangement purpose

Constants Generation

Constants generation is a feature of the Notifications module. It reads the IDs of all user categories added and
generates a static class named EM_NotificationsConstants that contains the constants of these IDs. Later, you can
use these constants when scheduling a local notification in script instead of typing the IDs directly, thus help prevent
runtime errors due to typos and the likes.

To generate the constants class (you should do this after adding all required user categories), click the Generate
Constants Class button within the CONSTANTS CLASS GENERATION section.

‘ f—:E COMNTANTS GENERATIOMN ~ 1

Generate the static class EasyMabile.EM_MeotificationsConstants that contains the constants of user category
IDs that can be used when scheduling notifications. Remember to regenerate if you make changes to these IDs.

[ Generate Constants Class ]

When the process completes, a file named EM_NotificationsConstants will be created at
Assets/notifications/EasyMobile/Generated.

3 Project [l Consol

| Create 'l
& Mssets - EasyMobile » Generated
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Notifications: Scripting

This section provides a guide to work with the Notifications module scripting API.

You can access the Notifications module API via the Notifications class under the EasyMobile namespace.

Working with Consent

The following snippet shows how you grant, revoke and read the module-level consent of the Notifications module.

Notifications
Notifications

moduleConsent Notifications DataPrivacyConsent

Initialization

Before notifications can be used, the module needs to be initialized. This initialization should only be done once when
the app is loaded, and before any other calls to the API are made. If you have enabled the Auto initialization feature
(see Module Configuration section), you don't need to start the initialization from script. Otherwise, if you choose to
disable that feature, you can initialize the service using the /nit method.

Notifications

Note that the initialization should be done early and only once, e.g. you can put it in the Start method of a
MonoBehaviour, preferably a singleton so that it won't run again when the scene reloads.

Notifications

You can check if the module has been initialized at any point using the Is/nitialized method.

isInitialized Notifications

Working with Local Notifications

Constructing a Notification Content

Before scheduling a notification, you must first prepare its content. To do this simply create a new NotificationContent
object and fill it with appropriate information.



content
content title
content subtitle

content body

content userInfo
content userInfo
content userInfo
content userInfo

content categoryId EM_NotificationsConstants UserCategory_notification_category_test

content smallIcon
content largeIcon

content

Scheduling Local Notifications

To schedule a local notification, prepare the notification content and feed it to the ScheduleLocalNotification method.

One-Time Local Notifications

You can schedule a notification to be delivered at a specific time (in the future). If the specified time is in the past, the
notification will be delivered immediately.

System

content
triggerDate

Notifications triggerDate content

Instead of a trigger date, you can also schedule a one-time notification to be delivered after some delay time.

System



content
delay

Notifications delay. content

Repeat Local Notifications

If you want the notification to repeat automatically, schedule it to be delivered after some delay time, and then specify
a fixed repeat interval. Repeat interval can be one of the following values:

e None: no repeat

e EveryMinute: notification repeats once every minute
e EveryHour: notification repeats once every hour

e EveryDay: notification repeats once every day

e EveryWeek: notification repeats once every week

System

content
delay

Notifications delay content NotificationRepeat EveryDay

Managing Pending Local Notifications

Get Pending Local Notifications

To get all pending (scheduled but not yet delivered) local notifications, use the GetPendingLocalNotifications method.
The pending notifications will be returned as an array of NotificationRequest objects via a callback. Each pending
notification request is identified by its request ID.

Notifications GetPendingLocalNotificationsCallback

NotificationRequest pendingRequests
request pendingRequests

content request content



Debug request id
Debug content title
Debug content body

Cancel a Pending Local Notification

To cancel a particular pending local notification, call the CancelPendingLocalNotification method with the request ID of
the notification to be canceled. Canceled notifications will no longer be delivered.

Notifications

Cancel All Pending Local Notifications

To cancel all pending local notifications, simply call the CancelAllPendingLocalNotifications method.

Notifications

Working with Remote Notifications

Remote notifications are sent from a remote server and are typically scheduled from a website, e.g. OneSignal's
dashboard. Within your app, you only need to write code to handle when a remote notification is delivered and
opened.

Handling Opened Notifications

Whenever a local or remote notification is opened - either by the user tapping on it (default open action) or selecting
an action button - your app will be brought to foreground and then a LocalNotificationOpened _or a
RemoteNotificationOpened event will be raised. You can subscribe to these events and take appropriate actions
according to your app design. It's recommended to subscribe to the events as soon as your app is loaded, e.g. in the
_OnEnable method of a MonoBehaviour script in your first scene. Otherwise you risk missing them.

If your app is in foreground when a notification is delivered - be it local or remote - then the notification is not
posted (not displayed) and the LocalNotificationOpened or RemoteNotificationOpened event will be raised
immediately as if the notification was opened with the default action.

Notifications LocalNotificationOpened OnLocalNotificationOpened
Notifications RemoteNotificationOpened onRemoteNotificationOpened
Notifications LocalNotificationOpened OnLocalNotificationOpened
Notifications RemoteNotificationOpened OnRemoteNotificationOpened

delivered



Scripting

// The actionId will be empty if the notification was opened with the default action.
// Otherwise it contains the ID of the selected action button.
if (!string.IsNullOrEmpty(delivered.actionId

Debug Log "Action ID: " + delivered actionId
// Whether the notification is delivered when the app is in foreground.
Debug Log( "Is app in foreground: " + delivered isAppInForeground ToString

// Gets the notification content.
content - delivered content

// Take further actions if needed...

// This handler will be called when a remote notification is opened.
void OnRemoteNotificationOpened delivered

// The actionId will be empty if the notification was opened with the default action.
// Otherwise it contains the ID of the selected action button.
if (!string.IsNullOrEmpty(delivered.actionId

Debug Log "Action ID: " + delivered actionId

// Whether the notification is delivered when the app is in foreground.
Debug Log "Is app in foreground: " + delivered isAppInForeground ToString

// Gets the notification content.
content - delivered content

// If OneSignal service is in use you can access the original OneSignal payload like below.
// If OneSignal is not in use this will be null.
osPayload - delivered oneSignalPayload

// If Firebase Messaging service is in use you can access the original Firebase
// payload like below. If Firebase is not in use this will be null.
fcmPayload - delivered firebasePayload

// Take further actions if needed...

Handling Firebase Notifications on Android

On Android, if a Firebase notification arrives when your app is not running or is in background, only the "data
payload" will be sent to the app, while the "notification component" won't because it is intended to be displayed
to the user only. Effectively, the NotificationContent associated with the RemoteNotification object returned by
the RemoteNotificationOpened event will contain empty fields (title, subtile, body, etc.) with the exception of the
'userlnfo' field which represents the data payload. If the app is in foreground then both the data payload and the
notification component will be forwarded to the app.

You can learn more about this here and here.

Removing Delivered Notifications

Normally delivered notifications are cleared automatically when they're opened. You can manually clear all previously
shown notifications of your app from the notification center or status bar with the ClearAllDeliveredNotifications
method.

// Clear all delivered notifications (local and remote).
Notifications.ClearAllDeliveredNotifications
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https://github.com/firebase/quickstart-unity/issues/80
https://firebase.google.com/docs/cloud-messaging/android/receive#handling_messages

[iOS] Setting Application lcon Badge Number

iOS allows us to get and set the application icon badge number directly. Easy Mobile provides the following methods
S0 you can manage the badge number when working with notifications on iOS. Note that they don't have any effect on
Android.

badgeNumber Notifications

Notifications badgeNumber



Notifications: PlayMaker Actions

The PlayMaker actions of the Notifications module are group in the category Easy Mobile - Notifications in the
PlayMaker's Action Browser.

Please refer to the NotificationsDemo_PlayMaker scene in folder
Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

N | By
o Device

| J
[ Easy Mobile - Advertising ]
[ Easy Mobile - Care ]
[ Easy Mohile - Demao Actions ]
[ Easy Mobile - Game Services ]
[ |
[ |
[ |

|
o |

Easy Mobile - Gif

Easy Mobile - In-App Purchasing

Easy Mobile - Mative APls

Easy Mobile - Motifications

Matification_Cancel All Pending Local Motifications
Notification_Cancel Pending Local Notification
Motification_Clear All Delivered Motifications
Maotification_Get Module Data Privacy Consent
Matification_Grant Module Data Privacy Consent
Motification_Init

Motification_ls Initialized

Motification_ls Module Enabled

Maotification_On Local Motification Opened
Matification_On Remote Notification Opened
Motification_Revoke Module Data Privacy Consent
Motification_Schedule Local Motification
Matification_Schedule Local Motification Repeat

[ Easy Mohile - Privacy
[ Easy Mobile - Saved Games
[ Easy Mobile - Sharing

]
]
]
( Easy Mobile - Utilities |
[ Effects |
B Enum |
E GameOhject |
]
|
]
]
|

(o Gul
™ GUIElement
[EE] GUlLayout

[L Input

[Q Level

Motification_Cancel All Pending Local Notifications &

Cancels all pending local notifications.

[ Preview Add Action To State




PlayMaker Actions
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Privacy: Introduction

The Privacy module provides you convenient tools and resources to streamline the process of getting compliant with
user privacy directive and regulations such as the General Data Privacy Regulation (GDPR). Here're some highlights
of this modules:

e Comprehensive, flexible consent management system

o Multi-level, prioritized consent system for flexible management of various consent-requirable services in your
app
o Consent is automatically stored to be persistent across app sessions
o Consent is automatically applied/communicated to relevant services in runtime
e Multi-purpose built-in native consent dialog

o Easy to use dialog that can be used as the common interface for collecting user consent for all relevant
services (to avoid annoying the user with multiple popups asking consent for various things)
o The dialog content and layout can be flexibly adapted to your consent management needs
o The dialog can be created from script or by using the built-in graphical composer
o Native look makes sure the dialog can visually fit into apps of any graphic style
e Location detection tool

o Built-in API to check whether the current device is in the European Economic Area (EEA) region, which is
regulated by the GDPR

Consent Management System

Consent States
A consent can take one of 3 values: Unknown, Granted or Revoke.

State Description

The default state of consent, which means the user neither accepts nor denies the requested use

Unknown of their data.
Granted The user allows permission to the requested use of their data
Revoked The user denies (or revokes a previously granted) permission to the requested use of their data

A consent is considered "defined" if it has a state other than Unknown.

Consent Levels and Priorities

The primary design target of the consent system is flexibility, that it allows setting a global consent or granular consent
for individual modules or services. Different consent-levels have different priorities such that the higher prioritized
consent overrides the lower one. In other words, more specific consent is prioritized over less-specific one. The table
below summarizes the types of consent provided by Easy Mobile.

Type Level Priority Description

Vendor/Provider Lowest (most Highest Consent given to a specific vendor of a certain service,
Consent specific) 9 e.g. AdMob's consent

Module Consent Medium Medium Consent given to a certain module, e.g. Advertising

module's consent



Highest (least

Global Consent o
specific)

Lowest The common consent given to the whole app

Whenever a service seeks for an applicable consent, it searches from the lowest level to the highest level and get the
defined consent with highest priority. The following pseudo-code illustrates the process:

there’s a defined vendor-consent
vendor -consent
there’s a defined module-consent
module-consent

there’s a define consent
consent
to service's behaviour 'the “pre-GDPR” behaviour

ConsentManager Class

Each consent type is managed by a corresponding consent manager. Specifically,

e The vendor consent is managed by the client of the corresponding vendor, e.g. AdMob's consent is managed by
the Advertising.AdMobClient object

e The module consent is managed by the corresponding consent manager of that module, e.g. the Advertising
module's consent is managed by the AdvertisingConsentManager.

e The global consent is managed by the GlobalConsentManager.

Each of these manager extends the ConsentManager class, which is an abstract class that implements the
IConsentRequirable interface. It provides an API for following tasks:

e Querying the current state of the managed consent
e Granting or revoking consent
e Observing consent changes using event

The ConsentManager stores the specified consent state in PlayerPrefs so that it persists across app launches.

You can create classes extending the ConsentManager class to manage consent for other services in your app

that are not governed by Easy Mobile.

Consent Communication

Specified consent (Granted or Revoked) will be automatically communicated (applied) to corresponding services
during their initialization, which most of the time is done automatically during the initialization of Easy Mobile (see
Using Easy Mobile > Initializing), unless you turned off the auto initialization feature of these services in the Settings
interface. If the consent is changed after the corresponding service has been initialized, that change will be applied in
the next initialization. In such case you should inform the user accordingly.

Details on how consent is applied for each individual service can be found in the chapter on GDPR of the
corresponding module. Currently, two modules being affected are the Advertising and Notifications module.

Consent Dialog

Collecting user consent may sound trivial, but if not done right could negatively affect the user experience. A typical
app could incorporate multiple consent-requirable services such as ads, analytics and remote notifications. Each
service may provide its own interface to collect user consent, e.g. AdMob provides the Consent SDK and the MoPub



SDK offers a built-in dialog for the same purpose. However, it may not be ideal to use these vendor-specific interfaces
because it means the user would be presented with multiple dialogs asking consent for different things, which would
not be a great experience, to say the least.

To solve this problem, Easy Mobile provides a multi-purpose consent dialog that can serve as a common interface for
collecting user consent for all relevant services in your app. The dialog is built from native Ul elements to give it a
mobile-native look that easily fits into your app regardless of its graphic style.

Consent Dialog Anatomy

The following image depicts how the consent dialog looks on Android and iOS (left to right).

Coerier T W:E8PM -

9— Cancel Data Privacy Consent

This app collects certain information about your

oa
& DataPrivacy Consent

This a[pp c‘;”ectt: cle"ain infloﬂ'mzﬁzn about '!':"_'r use of our app that we would like your permission
use ol our app that we woul Il your permission e . e .
to use for advertising, analytics and notification to use for advertising, analytics and notification
purposes. We strictly follow our Privacy Policy to purposes. We strictly follow our Privacy Policy to
access and process your information. access and process your information. _—o
Consent is optional, and you may use the app Consent is optional, and you may use the app
wnhourt gl g f‘ Please 'f d "’;‘ without granting consent. Please understand that
iﬂf’:mia;:ms iay nof (nclion propedy Ihyod e some features may not function properly if you
' deny our access.
- Advertising ®
- Advertising o
You will receive relevant ads! Gur ad providers will collect
data and use a unique identifier on your device. You can R " -—
raview their policies: AdMab and Unity Ads. You will receive refevant ads! Cur ad providers will collect
data and use 8 unique ientifier on your device. You can
v Notifieatione coviewe their policies: Aduiol snd Unity Ads.
~ Notifications
~ Analytics* .
v ® ~ Analytics*
Click the below button to confirm your consent. . .
You can change this consent at any time in the Click the below button to confirm your consent.
"Privacy” page of this app. You can change this consent at any time in the

"Privacy" page of this app.
o— I
T — 0

A consent dialog consists of following parts:

e Title bar: on top of the dialog is a title bar containing:

o Title (1): the title for your dialog

o Dismiss button (2): optional button that allows the user to cancel the dialog without updating the consent,
when this button is clicked the dialog closes and raises its Dismissed event.

e Main content: the body of the dialog is comprised of the following element:

o Texts (3)(5): you can use common HTML tags such as <b>, <i> to style the text, as well as using the <a> tag
to include hyperlinks, which is useful for providing links to privacy policies.

o Toggles (4): you can optionally include toggles in your dialog asking the user to provide granular consent for
different services. Toggles can be turned off by default, making them a good means for users to provide
explicit consent (they have to turn them on explicitly). Each toggle consists of a title, a switch and a
description text, which is collapsible. Similar to the body text, you can use common HTML tags such as <b>,
<i> and <a> in this description text. Also, you can, for example, make a toggle on by default and make it
unclickable for a service that is vital for the operation of your app to indicate the user that consent for such
service is required for continued use of the app.

o Buttons (6): whenever a button in the dialog is clicked, the dialog closes and raises its Completed event with
the ID of the clicked button and the current values of the toggles if any.

e You can construct consent dialogs directly in script or by using the built-in consent dialog composer (see
Settings).

e You can flexibly interleave text, toggles and buttons in the body of your consent dialog to achieve the
desired layout.



e You can have zero or more toggles, but the dialog should always have at least one button otherwise the
Completed event will never fire and the dialog results (clicked button ID, toggle values) won't be returned.

Consent Dialog Localization

One of the requirement of the GDPR is the the request for consent must be intelligible, so it may be desirable to
localize the consent dialog into multiple languages. Easy Mobile's consent dialog was designed with that in mind. All
elements of the consent dialog can be accessed and altered at runtime, making it easy to localize them. A typical
approach would be using known string-patterns as placeholders for the texts in the dialog (e.qg title, body texts, toggle
description, button label) and replace them with appropriate localized texts in runtime before showing the dialog.

You may want to use a dedicated localization asset, which can be easily found on the Unity Asset Store, for the

purpose of managing and selecting correct translation for the placeholder texts.

EEA Region Checking

Since the GDPR applies specifically to the EEA region, it may be desirable to have different behaviors for your app
between EEA and non-EEA regions, especially on privacy-sensitive tasks. To serve that purpose, Easy Mobile
provides a built-in validator to detect whether the current device is in EEA region or not. The tool employs several
different methods for the test which are summarized in the table below.

Method Description
Google Validating using the service provided by Google at
Service https://adservice.google.com/getconfig/pubvendors, requires an internet conection

Validating using the country code obtained from the device's mobile carrier information (SIM card

UEEiphneiny; information), no connection required but won't work without a SIM card
Ti Validating using the device's timezone setting. No connection required; note that this setting can
imezone
be changed by the user
Locale Validating using the device's locale setting. No connection required; note that this setting can be

changed by the user

The EEA region validator returns one of the following results: InEEA, NotInEEA or Unknown. It allows you to use all
available validating methods or a subset of them in a predefined order of priorities. If a higher prioritized method fails,
the validator will use the next method until an explicit result (either an InEEA or NotInEEA value) is determined. In the
rare case that all methods fail, the result will be returned as Unknown. For example scripts on using the EEA validator
see the Scripting chapter.

The codes of those countries currently included in the EEA region are stored in the EEACountries enum.

EEACountries

None

AT, BE, BG, HR, CY, CZ, DK, EE, FI, FR, DE, GR, HU, IE, IT, LV, LT, LU, MT, NL, PL, PT, RO, SK, SI, ES
SE, GB

©F, [PFE, TF

EL, UK

IS, LI, NO

CH

AL, BA, MK, XK, ME, RS, TR

{ S—

A Proposed Workflow for Working with Consent
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It's up to you to decide how your app should react to the GDPR, including whether user consent should be collected
for those services in the app that may be subject to the regulation. The following proposed workflow can be optionally

employed in the case you decide to collect user consent and configure relevant service with that consent.

SgLib Games offer tools and information as a resource to assist you in getting compliant with the GDPR, but we

don't offer legal advice. We recommend you contact your legal counsel to find out how GDPR affects you.

When building a consent aware app using Easy Mobile, following considerations can be made:

Since the consent is applied during service initialization, it's advisable to collect user consent and forward it to
relevant modules or services before initializing the Easy Mobile runtime.

A consent dialog should be presented the first time the app launches to collect user consent for all relevant
services; this dialog should not be dismissible, as we want the user to specify explicit consent once before the
normal operation runs.

The consent dialog should be accessible again (e.g. via a menu button) so that the user can change their
consent; this dialog should reflect the current consent states for each individual services and should be
dismissible, so the user can leave it without updating their consent in case the dialog was opened unintentionally.
If the user does change their consent, they should be informed that the changes will take place during the next
app launch (the next initialization).

It may be advisable to only collect and apply consent for devices in the EEA region, while having a "pre-GDPR"
behavior in other region (not setting any consent, as what's normally done before the GDPR came out).

It may be desirable to use a localization tool to localize the consent dialog to languages in the EEA region.

Since it's common to have multiple consent-requirable services in your app, some of those may be governed by Easy

Mobile while others may be not, we recommend having a custom "app consent” class that represents the collection of

all consent given to each individual service in the app. This class should have several functionalities:

Represents the collection of consent given to various services, specifically advertising, analytics and notifications
as in the example script

Forwards the collected consent to corresponding services using appropriate API provided by Easy Mobile (and
other relevant 3rd party SDKs if any)

Allows saving and retrieving the collected consent to and from PlayerPrefs in form of a JSON string (thus it is
attributed as Serializable) so that we can restore the consent values and reflect them on the consent dialog when
it is shown again

For the purpose of explaining this proposed workflow, we reuse the DemoAppConsent class found in our Privacy

demo scene as an example of the aforementioned class.

System Collections

System Collections Generic
UnityEngine

System

EasyMobile Demo

DemoStorageKey



Introduction

// (we could have had different consents for individual ad networks, but for
// the sake of simplicity in this demo, we'll ask the user a single consent
// for the whole module and use it for all ad networks).

public advertisingConsent - ConsentStatus Unknown

// The consent for the whole Notifications module.

// Note that data consent is only applicable to push notifications,
// local notifications don't require any consent.

public notificationConsent = ConsentStatus Unknown

// Since this demo app also has In-App Purchase, which forces the use of

// Unity Analytics, we could have had to ask a consent for that too. However,
// according to Unity it's sufficient to provide the user with an URL

// so they can opt-out on Unity website. So we will include that URL in our
// consent dialog and not need to ask and store any explicit consent locally.

// Here you can add consent variables for other 3rd party services if needed,
// including those not managed by Easy Mobile...

endregion

/// <summary>

/// To JSON string.

/// </summary>

/// <returns>A <see cref="System.String"/> that represents the current <see cref="EasyMobile.Demo.AppCo
nsent"/>.</returns>

public override string ToString

return JsonUtility.ToJson(this

/// <summary>

/// Converts this object to JSON and stores in PlayerPrefs with the provided key.
/// </summary>

/// <param name="key'">Key.</param>

public void Save(string key

PlayerPrefs.SetString(key, ToString

/// <summary>

/// Forwards the consent to relevant modules of EM.

/// </summary>

/// <param name="consent">Consent.</param>

/// <remarks>

/// In a real-world app, you'd want to write similar method

/// to forward the obtained consent not only to relevant EM modules

/// and services, but also to other relevant 3rd-party SDKs in your app.
public static void ApplyDemoAppConsent consent

// Forward the consent to the Advertising module.

if consent advertisingConsent == ConsentStatus Granted
Advertising.GrantDataPrivacyConsent
else 1f [consent advertisingConsent -- ConsentStatus Revoked

Advertising.RevokeDataPrivacyConsent

// Forward the consent to the Notifications module.

if ‘consent notificationConsent == ConsentStatus Granted
Notifications.GrantDataPrivacyConsent

else 1f (consent notificationConsent -- ConsentStatus Revoked
Notifications.RevokeDataPrivacyConsent

// Here you can forward the consent to other relevant 3rd-party services if needed...

/// <summary>

/// Saves the give app consent to PlayerPrefs as JSON using the demo storage key.
/// </summary>

/// <param name="consent">Consent.</param>

public static void SaveDemoAppConsent consent

if (consent != null
consent Save DemoStorageKey
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json PlayerPrefs DemoStorageKey

json
JsonUtility json

The following pseudo-code illustrates the process that should be done at every app launch to collect and forward
consent (if needed) and then initialize Easy Mobile in a consent-aware app.
region

Mobile

first app launch

Mobile

the consent dialog
the consent dialog
non-dismissible consent dialog

consent to relevant services

consent values
Mobile

As mentioned previously, apart from collecting consent at the first app launch we also need to provide a way for the
user to access the consent dialog again to update their consent if needed. The simplest way is having a menu button
that can open the consent dialog at the user discretion. This dialog should reflect the current consent status and is
dismissible. The following pseudo-code illustrate the process to handle such consent dialog opening button.

button clicked

the consent dialog
the consent dialog

having a stored consent
the stored consent
dialog with stored consent
dismissible consent dialog
consent updated
consent to relevant services

consent values
alert



Introduction

Please see folder Assets/EasyMobile/Demo/Scripts/PrivacyDemo for example scripts on this subject.
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Settings

Privacy: Settings

The settings interface of the Privacy module can be accessed from the Privacy tab at menu Window > Easy Mobile >

Settings.

Default Consent Dialog Composer

There are two ways to construct an Easy Mobile consent dialog: building it in script or using the built-in graphical
consent dialog composer. The latter can be found in the Privacy module settings interface. The dialog composed with
this composer is the default consent dialog and can be obtained from script using the
Privacy.GetDefaultConsentDialog() method (see Working with Default Consent Dialog).
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> DEFAULT CONSENT DIALOG COMPOSER

=Dialog Title
Title

\Privacy Consent

8|

=Main Content

The main contént description of the dialog. You can use HTML tags like <b>, <i> and <a> in the text as well as
insert teggles and butons to form the dialog layout.

|_| Enable Copy & Paste

@[ 8 [+ |||[ insertToggle | id: woggle_analyics ¢ [__1d: bumon_ok ¢ |

| insert Bumon |

This app collects certain information about your use of our app that we would like your
permission to use for advertising, analytics and notification purposes. We strictly follow our <a
href=" 4 EasyMobilePolicyURL + “=Privacy Policy</a> to access and process your information,
Consent is <b>optional</b>, and you may use the app without granting consent. <i>Please
understand that some features may not function properly if you deny our access</fi>.

< [EM_CONSENT_TOGCGLE. Id = toggle_advertising >

< /EM_CONSENT_TOGGLE. Id = toggle_notifications >

< /EM_CONSENT_TOGGLE. Id = toggle_analytics>

Click the below button to confirm your consent. You can change this consent at any time in the
<h>\"Privacy\"</b> page of this app.

< /EM_COMNSENT_BUTTOM. Id = button_ok=>

=Toggle List

The toggles to be inserted to the dialog content,

F Toggles

+
"Button List
The buttons to be inserted to the dialog content. Your dialog must have at least one butian. i
¥ Buttons +

=Preview

177

Preview the consent dialog using the Privacy demo scene.

| Run Preview Scene |

The composer consists of following sections:

1. Title: for editing the dialog's title

. Main Content: this is where you compose the main content of the dialog by inserting texts, toggles or buttons.

. Toogle List. this is where you manage the toggles in your dialog, adding or removing toggles, setting their
parameters such as ID, title, description, etc.

Button List: this is where you manage the buttons in your dialog, adding or removing buttons, setting their
parameters such as ID, label, colors, etc.

Preview: you can use the button in this section to open the preview scene for the composed dialog.

Composing Main Content

You can edit the body of your consent dialog in the Main Content section of the composer.



Main Content

The main content description of the dialog. You can use HTML t2gs like <b>, <i> and <a> in the text as well as
insert toggles and butons to form the dialog layout.

__| Enable Copy & Paste

e |ea || B | t ||| Insert Toggle || Id: toggle_analytics % ||| Insert Bution || Id: button_ok |

This app collects certain information about your use of our app that we would like your
permission to use for advertising, analytics and notification purposes. We strictly follow our <a
href=" + EasyMobilePolicyURL + “>Privacy Policy</a> to access and process your information.
Consent is <b>optional</b>, and you may use the app without granting consent. <i>Please

understand that some features may not function properly if you deny our access</i>.
e— </EM_CONSENT_TOCGLE. Id = toggle_adwvertising =

< /EM_COMNSENT_TOGGLE. Id = toggle_notifications >
< /EM_CONSENT_TOGGLE. Id = toggle_analytics>

Click the below button to confirm your consent. You can change this consent at any time in the
<b>\"Privacy'"</b> page of this app.
< /EM_COMNSENT_BUTTOM. Id = button_ok=>

1. Enable Copy & Paste: in some versions of Unity we can't have both text selection function (for styling or inserting
hyperlinks) and copy-paste function at the same time. In such case you can check this option when you want to
do copy-paste and uncheck it to use the toolbar buttons (which require text selection).

2. Toolbar: containing buttons for text styling (bold, italic), inserting hyperlinks, inserting toggles and buttons.

3. Text Area: for inputing the text that describes the content of your consent dialog.

Text Styling
Common HTML tags including <b> (bold) and <i> (italic) can be used to style the text. In the composer you can select

a chunk of text and use the B or / button on the toolbar to make it bold or italic respectively, the appropriate tag will be
added to the text in the below text area automatically.

[ea)[ 8 | + ][ insestToggle |[  id:ioggle analytics ¢ |||[ InsertButton || id: button.ok 2]

Inserting Hyperlinks

It's important to provide links to appropriate privacy policy in the consent dialog, which can be done by inserting

hyperlinks. To insert a hyperlink, simply select the appropriate text in the text area and click the hyperlink button on
the toolbar and enter the appropriate URL.

||C—:.‘-|| B | ¢ |||| Insert Toggle || Id: toggle_analytics 4 |

Selected Text:
[
|

|| Insert Button || Id: button_ok  # |

|Thi5 app |

Link:

|http:/ feasymobile.sglibgames.com

[ Insert hyperlink ]

Inserting Toggles

Before inserting toggles to the consent dialog, you must create them in the Toggle List section first (see Managing
Toggles). Then select the toggle to insert using its ID in the toggle dropdown on the toolbar and click the Insert Toggle
button. A special toggle tag (e.g. </EM_CONSENT_TOGGLE. Id = toggle_advertising>) will be inserted at the current

cursor position in the text area. In runtime, this will be replaced by an actual toggle constructed with the parameters
corresponding to the toggle ID in the toggle list.



Main Content

The main content =i and <a» in the text as well as
insert toggles andg buttons to form the distee tasenas
Id: toggle_advertising
|| Enable Copy [& Paste S
Id: toggle_notifications
| || B | - |[ Insert Toggle ]| ¥ |d: toggle_analytics || Insert Buttan ][ Id: buttan_ok % |

This app colledereertrrerrierr e eprerrrreeremremee=th at we would like your ‘

permission to use for advertising, analytics and notification purposes. We strictly follow our <a

e e e e e S S I i i B L

et & , F___pa_Lil_m_bi_rim o e oW

Inserting Buttons

Before inserting buttons to the consent dialog, you must create them in the Button List section first (see Managing
Buttons). Then select the button to insert using its ID in the button dropdown on the toolbar and click the Insert Button
button. A special button tag (e.g. </EM_CONSENT_BUTTON. Id = button_ok>) will be inserted at the current cursor
position in the text area. In runtime, this will be replaced by an actual button constructed with the parameters

corresponding to the button ID in the button list.

Your consent dialog must have at least one button so that it can be close with the Completed event.

Main Content

The main content description of the dialog. You can use HTML tags like <b», <i> and <a=> in the text as well as
insert toggles and buttons to form the dialog layout.

[_| Enable Copy & Paste
| E| [ B | ! J| || insert Toggle | [ Id: toggle_analytics & ]I“ IENT Tl Id: button_ok

This app collects certain information about your use of our app that we would like your
permission to use for advertising, analytics and notification purposes. We strictly follow our <a

Managing Toggles

Toggles in your consent dialog can be designed and managed in the Toggle List section. To create a new toggle
click the plus button at the top right corner. To remove a toggle click the minus button to the right of that toggle.

Toggle List

|The toggles to be inserted to the dialog content. |
¥ Togales
b Advertising

b Motifications ‘
| —

b Analytics®

The following shows the parameters of a toggle.



¥ Advertising

Id |t{:gg|&_adver‘tising |
Title |A{_:|'urer‘tis_ing |
Is On i

Interactable [

Toggle Description [

Toggle On Description You will receive relevant ads! You can review their

policies: <a href=" + AdMobPolicyURL +
“=AdMob<a> and <a href=" + UnityAdsPolicyURL

PR POV O P S P e

Toggle Off Description Our ad providers will collect data and use a unique
identifier on your device to show you relevant ads.
Here're their policies: <a href=" + AdMobPolicyURL

P PO O [ P e P e e iy BT

e /d: the ID of the toggle.

e Title: the title of the toggle.

e Is On: whether the toggle should be turned on by default.

e Interactable: whether the toggle is clickable, this value can be changed from script in runtime.

e Toggle Description: whether the description should be updated according to the on off state of the toggle, if this
value is false, the Toggle On Description will always show.

e Toggle On Description: the description to be shown when the toggle is on, or when Toggle Description is false.
e Toggle Off Description: the description to be shown when the toggle is off and Toggle Description is true.

Similar to the main body text, you can use common HTML tags such as <b>, <i> and <a> in the Toggle On

Description and Toggle Off Description.

Managing Buttons

Buttons in your consent dialog can be designed and managed in the Button List section. To create a new button click
the plus button at the top right corner. To remove a button click the minus button to the right of that button.

Button List

|The buttons to be inserted to the dialog content. Your dialog must have at least one button. |

¥ Buttons i+

b Accept |

Again, you consent dialog must have at least one button so the last one won't be removable.

The following shows the parameters of a button.

¥ Accept

Id |button_ok |
Title |A1_:cgpt |
Interactable i

Title Colar | | 2
Background Color - F
Uninteractable Title Caolor I 2
Uninteractable Background Color | | #

e /d: the ID of the button.

e Title: the text on the button

e Interactable: whether the button is clickable, this value can be changed from script in runtime.
e Title Color: the color of the button text in normal state (clickable).

e Background Color: the color of the button body in normal state (clickable).



Settings

e Uninteractable Title Color: the color of the button text when it is not clickable.
e Uninteractable Background Color: the color of the button body when it is not clickable.

Previewing Consent Dialog

You can preview the consent dialog while composing it without having to export a build to a mobile device. In the
Preview section click the Run Preview Scene button to run the Privacy Demo scene.

In the opened scene click the DEFAULT CONSENT DIALOG button to open the default consent dialog which has just

been composed. The consent dialog in the editor looks and functions similarly to its counterparts on iOS or Android

and is useful for quick verifying of your dialog design.

< Privacy Consent

Ths app collects. certan informaiion about your use of our anp St we would ke
Your permmisson 1o use for adverisng, analyScs and noficaion purposes. e
stricty follow our <ahref=" + EasyMoblePoicylIRL + “>Privacy Paicy<fia> o
acoess and process. your nformmaion.

Consent = optional. and you may use e app without graniing consent. Flease
wroier sty Faf some features may nof funcion properly if pou deny our access.

W Advertising @

‘ow well recenve relevant acks! You can revies e poboes. <ahrefs" «
AdddohPolicylURL + > Adilobrcia> and <ahrefs® + UnitphdsPolicylIREL + “=Unity
Adseia

' MNotifications a4
Tree i & eample Egge descriphon by w ogghe of Fe coment by rodlostom
]

W Analytics* g
This is a sample inggle descripiion for T oggle of the consent for aalfySics serice

Clisci. e beiow (bulion io confiern your consent. You can change s, consent at any'
e in e “Privacy™ page of fus app.
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Privacy: Scripting

This section provides a guide to work with the Privacy module scripting API.

EEA Region Checking

Easy Mobile provides a built-in validator to detect whether the current device is in the European Economic Area (EEA)
region, where the GDPR governs. This validator performs the region check using the methods defined in the
EEARegionValidationMethods enum (see Introduction chapter for a detailed explanation of these methods):
GoogleService, Telephony, Timezone or Locale. It will return one of the following results: INEEA, NotInEEA or

Unknown.

The validator can use any subset of the available methods, in any order. To instruct it to use a certain collection of
methods in a specific order, simply prepare a List object containing the methods-to-use in the desired order. The
validator will perform validating using the provided methods in their order in the containing list. If a method fails to
return an explicit result (either INEEA or NotInEEA), the next one in the list will be used until a clear result is found. If
all methods fail, the validator will return Unknown as the result.

Validating Using Default Method List

The default EEA region validating method list is defined as the DefaultMethods variable of the EEARegionValidator
class. It employs all the available methods in the following order:

1. GoogleService
2. Telephony

3. Timezone

4. Locale

To perform EEA region validation using the default method list, call the IsInEEARegion method of the Privacy class.
This method is actually a wrapper of the ValidateEEARegionStatus method of the EEARegionValidator class so you
can also use that method directly.

UnityEngine
EasyMobile

Privacy CheckEEARegionCallback

result

result EEARegionStatus InEEA
Debug

result EEARegionStatus NotInEEA
Debug

Debug



Validating Using Custom Method List

You can instruct the validator to use a custom list of desired methods in the desired order. To do so use the
ValidateEEARegionStatus method of the EEARegionValidator class but provide it your custom method list.

UnityEngine
EasyMobile
System Collections Generic

methodList
EEARegionvalidationMethods Telephony
EEARegionvalidationMethods GoogleService

EEARegionvalidationMethods Locale
EEARegionvalidationMethods Timezone

EEARegionvalidator CheckEEARegionCallback methodList

result

result EEARegionStatus InEEA
Debug

result EEARegionStatus NotInEEA
Debug

Debug

Working with Consent Dialog

Getting the Default Consent Dialog

You can get the default consent dialog that was composed using the built-in composer (see Consent Dialog
Composer) using the GetDefaultConsentDialog method of the Privacy class.

dialog Privacy

Localizing the Consent Dialog

You can localize the main content of the consent dialog by grabbing its Content property and replace the placeholder
texts with the appropriate localized texts.

ddialog Content dialog Content

To localize toggles in the dialog you can iterate through the Toggles property and localize the title and the description
texts of each toggle.



toggle dialog Toggles
toggle Title toggle Title

toggle OnDescription toggle OnDescription

toggle OffDescription toggle OffDescription

j —

To localize buttons in the dialog you can iterate through the ActionButtons property and localize each button title.

button dialog ActionButtons

button Title button Title

For the sake of simplicity, we use sample strings in the above example snippets. In a practical app you may use
a dedicated localization tool, as well as checking toggle or button ID, to pick the correct translation for each

placeholder text.

Showing Consent Dialog

To show a consent dialog simply call its Show method. This method has an optional 'dismissible' parameter. You can
set it to 'true' to allow the user to dismiss the dialog using a cancel button that is added to the dialog automatically.
Otherwise the dialog can only be closed by one of the buttons in its content.

dialog

Only one consent dialog can be shown at a time. Attempts to show a consent dialog when another is being shown will
be ignored. You can check if there's any consent dialog being shown using the IsShowingAnyDialog method.

isShowingAnotherDialog ConsentDialog

Consent Dialog Events

A consent dialog has following events:

Event Description

This event is raised when the value of a toggle in the (being shown) consent dialog
ToggleStateUpdated has been updated. You may subscribe to this event if you want to update the dialog
according to the values of its toggles.

Dismissed This event is raised when the dialog is dismissed (closed by the cancel button)
This event is raised when the dialog is completed (close by one of the action buttons).

Completed The handler of this event will be called with the ID of the selected button and the
values of the toggles in the dialog at the time it is closed.



Updating Toggles in Runtime

You can update the toggle value of a being-shown consent dialog using the SetToggle/lsOn method on the dialog.

dialog

You can also change the interactability of a toggle while the dialog is being shown using the SetTogglelnteractable
method.

dialog

Updating Buttons in Runtime

In some cases, you may want to update the interactability of a button on a being-shown consent dialog, e.g. only
make the button clickable if a certain toggle is on. For that purpose you can use the SetButtoninteractable method.

dialog

A Complete Example

The following script gives an example on how to grab the default consent dialog, localize and show it, as well as
handle its events.

UnityEngine
EasyMobile
System Collections Generic

hasSubscribedEvents

dialog Privacy

dialog Content dialog Content
toggle dialog Toggles
toggle Title toggle Title

toggle OnDescription toggle OnDescription

toggle OffDescription toggle OffDescription

button dialog ActionButtons



button Title button Title

ConsentDialog

hasSubscribedEvents

dialog ToggleStateUpdated DefaultDialog_ToggleStateUpdated

dialog Dismissed DefaultDialog_Dismissed
dialog Completed DefaultDialog_Completed
hasSubscribedEvents
dialog
Debug
dialog toggleId isOn
Debug toggleld isOn
toggleId
dialog
dialog
Debug
dialog results
Debug results buttonId
KeyValuePair kvp results togglevalues
Debug kvp Key kvp Value

Creating Consent Dialog Programmatically

Apart from building consent dialog using the graphical composer, you can construct a dialog completely from script,
using methods such as AppendText, AppendToggle and AppendButton to add texts, toggles and buttons to the dialog
content, respectively. The following example shows how a consent dialog can be constructed programmatically.



Scripting

For the sake of simplicity we use sample hard-coded strings in the example script. In a practical app you may

use a localization tool to pick the correct translation for each text. Also you can load the consent provided by the

user previously and set the toggle values accordingly to reflect the current consent status.

using UnityEngine
using EasyMobile
using System Collections Generic

public static class

// Constructs a consent dialog from script.
public static ConstructConsentDialog

// First create a new consent dialog.
dialog - new

// Set the title.
dialog.Title = "SOME_CONSENT_DIALOG_TITLE"

// Add the first paragraph.
dialog.AppendText ("FIRST_PARAGRAPH_TEXT"

// Build and append the toggle for advertising service consent.

adsToggle - new "ADS_TOGGLE_ID"
adsToggle.Title = "ADS_TOGGLE_TITLE"
adsToggle.OnDescription = "ADS_TOGGLE_ON_DESCRIPTION"
adsToggle.OffDescription = "ADS_TOGGLE_OFF_DESCRIPTION"
adsToggle ShouldToggleDescription = true // make the description change with
adsToggle IsOn - false // make the toggle off by default

// Append the toggle after the 1st paragraph.
dialog AppendToggle adsToggle

// Build and append the toggle for notifications service consent.

notifsToggle = new "NOTIFS_TOGGLE_ID"
notifsToggle.Title = "NOTIFS_TOGGLE_TITLE"
notifsToggle.OnDescription = "NOTIFS_TOGGLE_ON_DESCRIPTION"

the toggle state.

notifsToggle ShouldToggleDescription = false // use same description for both on & off states.

notifsToggle.IsOn = false; // make the toggle off by default

// Append the toggle below the previous toggle.
dialog AppendToggle notifsToggle

// Build and append the toggle for analytics service consent.

uaToggle - new "ANALYTICS_ TOGGLE_ID"
uaToggle.Title = "ANALYTICS_TOGGLE TITLE"
uaToggle.OnDescription = "ANALYTICS_TOGGLE_ON_DESCRIPTION"

uaToggle ShouldToggleDescription = false // the description won't change when the toggle switches be
tween on & off states.

uaToggle.IsInteractable = false; // not interactable

uaToggle IsOn = true // assuming analytics is vital to our app, make its toggle on by default

// Append the toggle below the previous toggle.
dialog.AppendToggle(uaToggle

// Append the second paragraph.
dialog.AppendText ("SECOND_PARAGRAPH_TEXT"

// Build and append the accept button.
// A consent dialog should always have at least one button!
okButton = new "OK_BUTTON_ID"
okButton Title = "OK BUTTON_TITLE"
okButton TitleColor = Color white
okButton BodyColor = new 66 / 255f, 179 / 255f, 1

// Append the button to the bottom of the dialog.
dialog AppendButton okButton

return dialog

188



Managing Global Consent

You can grant or revoke the global consent of your app using the GrantGlobalDataPrivacyConsent and
RevokeGlobalDataPrivacyConsent methods of the Privacy class, respectively.

Privacy

Privacy

You can get the current state of the global consent of your app using the GlobalDataPrivacyConsent property of the
Privacy class.

globalConsent Privacy GlobalDataPrivacyConsent

These APIs of the Privacy class are actually wrapper of those of the GlobalConsentManager, which is the object that
actually manages the global consent. So the above snippets are equivalent to the following script.

GlobalConsentManager Instance
GlobalConsentManager Instance

globalConsent - GlobalConsentManager Instance DataPrivacyConsent

You can also acknowledge when the global consent is updated by subscribing to the DataPrivacyConsentUpdated
event.

UnityEngine
EasyMobile
GlobalConsentManager Instance DataPrivacyConsentUpdated onGlobalDataPrivacyConsentUpdated
GlobalConsentManager Instance DataPrivacyConsentUpdated OnGlobalDataPrivacyConsentUpdated
consent
consent ConsentStatus Granted
Debug
consent ConsentStatus Revoked
Debug

Debug



Scripting
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Privacy: PlayMaker Actions

The PlayMaker actions of the Privacy module are group in the category Easy Mobile - Privacy in the PlayMaker's

Action Browser.

Please refer to the PrivacyDemo_PlayMaker scene in folder

Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

Every Frame

Result

Consent Status

Event Target

Is Consent Granted Event

Iz Consent Revoked Event

Is Consent Unknown Event

[ Preview

Gets the global data privacy consent status.

None

| Self

Actions
[E Array ] !tl
Lo Audio ]
[‘ Camera ]
™ Character |
[t Color ]
E Convert ]
[i. Debug ]
[D Device ]
[ Easy Mohile - Advertising ]
[ Easy Mobile - Core ]
[ Easy Mohile - Demao Actions ]
[ Easy Mobile - Game Services ]
| Easy Mobile - Gif |
[ Easy Mobhile - In-App Purchasing ]
| Easy Mobile - Native APIs |
[ Easy Mobile - Motifications ]
Easy Mobile - Privacy

Privacy_Grant Global Data Privacy Consent

Privacy_ls In EEA Region

Privacy_Revoke Global Data Privacy Consent

Privacy_Show Default Consent Dialog
[ Easy Mobile - Saved Games ]
[ Easy Mobile - Sharing ]
| Easy Mobile - Utilities | E
= — 1
Privacy_Get Global Data Privacy Consent [

ar || ar

A

Add Action To State




PlayMaker Actions
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Sharing: Introduction

The Sharing module helps you easily share texts and images to social networks including Facebook, Twitter and
Google+ using the native sharing functionality. In addition, it also provides convenient methods to capture the
screenshots to be shared.

Below are the sharing interfaces on iOS and Android, respectively.



@ AirDrop. Tap to turn on Wi-Fi and
Bluetooth to share with AirDrop.

-

Message Mail Add to Motes  Twitter

u O F O

Save Image  Assign to Copy Print
Contact

Cancel

. A

e

Add to Dropbox Add to Maps

2 o

Bluetooth ChatOMN

o f

Email Facebook




G+ =

Google+ Group Play

[iOS] Request Photo Library Access Permission

Since iOS 10, in order to use the "Save Image" feature of the sharing utility, the app needs to ask for user permission
before it can access the photo library. Failure to do so will cause the app to crash as soon as the user selects the
option. To request the photo library access permission, you need to add the Privacy - Photo Library Usage
Description and Privacy - Photo Library Additions Usage Description properties to the Info.plist of your Xcode
project.

As of this writing, out tests show that on iOS 10, the Privacy - Photo Library Usage Description property is
required. While iOS 11 asks for the Privacy - Photo Library Additions Usage Description property.

Therefore it's recommended to add both properties if your target platforms including iOS 10 and above.
In your generated Xcode project open the Info.plist file.
B QA = B

¥ @ Unity-iPhone
» |9 Data

|| Images.xcassets
Classes
Unity-iPhone Tests
Frameworks

Libraries

¥y ¥ vryy

Products

| Bnopist
libiconv.2.dylib
LaunchScreen-iPhone.xib

@ LaunchScreen-iPhonePortrait.png

LaunchScreen-iPhonelLandscape.png
LaunchScreen-iPad.xib

LaunchScreen-iPad.png

Click the + button on the right of Information Property List to add a new key.



B2 £ [& Unity-iPhone ' B Info.plist ; No Selection

Key Type Value

Information Property List ¢ Dicticnary £ (26 items)
Localization native development region £~ String en
Bundle display name ~  Btring EM Demo
Executable file & String ${EXECUTABLE_MAME}

F lcon files ~ Array [7 items)
Bundle identifier ~  5tring com.sglib.${PRODUCT_MAME}
InfoDictionary version £~ String 6.0
Bundle name ~  Btring ${PRODUCT_MAME}
Bundle O3 Type code o~ String APPL
Bundle versions string. short £~ String 1.0
Bundle version ~  Btring L]
Application requires iPhone environment o Boolean YES
Scroll down to find the Privacy - Photo Library Usage Description key.
g < [ Unity-iPhone » B Info.plist  No Selection
Key Type Value
¥ Information Property List Dictionary [27 items)
Privacy - Photo Library Usage Description ~ Q@ String - For saving screenshots to photo licrary
Privacy - Photo Library Usage Des & String en
Privacy - Reminders Usage Description ~  String EM Demo
Privacy - Siri Usage Description #  String ${EXECUTABLE_MAME}
p| Privacy - Speech Recognition Usage Description A Array (7 items)

Privacy - TV Provider Usage Description ~  String com.sglib.${PRODUCT_MAME}
Privacy - Video Subscriber Account Usage Descri... A String 5.0
Quick Look needs to be run in main thread #  String ${PRODUCT_NAME}
Quick Lock preview height A String APPL
Quick Look preview width #  String 1.0
Quick Look supports concurrent reguests ~  String Q
Application requires iPhone environment ~ Boolean YES

Enter a value for the key, this message will be displayed as the app requests access permission when the user
selects the "Save Image" option.

ol [E Unity-iPnone » B Info.plist » No Selection
Key Type Value
¥ Information Property List Dictionary (27 items)
| Privacy - Photo Library Usage Description ~ @@ String < For saving screenshots to photo liprary
Localization native development region o~ String en
Bundle display name o~ 5tring EM Demo
Executable file ~  5tring ${EXECUTABLE_MAME}
p Icon files ~ Array (7 items)

Bundle identifier o~ String com.sglib ${PRODUCT_MAME}
InfoDictionary version ~  5tring 6.0
Bundle name ~  String ${PRODUCT_MAME}
Bundle OS5 Type code ~  5tring APPL
Bundle versions string, short ~  String 1.0
Bundle version £~ String Q
Application requires iPhone environment #~ Boolean YES

Repeat the process to add the Privacy - Photo Library Additions Usage Description property.



aial '_|g| Unity-iPhone . Info.plist Mo Selection

Key Type Value

¥ Information Property List Dictionary (2B items)

3

Privacy - Photo Library Usage Description String For saving screenshots to photo library

W
Privacy - Photo Library Additions Usage Description 2 Q& 5tring

# For saving screenshots to photo library
Localization native development region ~  5tring en
Bundle display name £~ String EM Demo
Executable file o~ 5tring ${EXECUTABLE_MAME}
Pk lcon files ~  Array (7 items)
Bundle identifier ~  5tring com.sglib.${PRODUCT_MAME}
InfoDictionary version ~ S5tring 5.0
Bundle name #~  String ${PRODUCT_MNAME}
Bundle OS5 Type code ~  5tring APPL
Bundle versions string, short a~  String 1.0
Bundle version ~  5tring 0
Application requires iPhone envirenment ~ Boolean YES

[Android] Enable External Write Permission

For this module to function on Android, it is necessary to enable the permission to write to external storage. To do so,
go to Edit > Project Settings > Player, select Android settings tab, then locate the Configuration section and set the
Write Permission to External (SDCard).

Configuration

Scripting Backend | Mono2x ¢ |
Mute Other Audio Sources® d

Disable HW Statistics [

Device Filter | FAT {ARMv7 +x86) 4|
Install Location | Prefer External ¢ |
Internet ACCcess | Auto g
Write Permission External {(SDCard) i
Android TV Compatibility |

Android Game [+

Android Gamepad Support Level | Waorks with D-pad s
Scripting Define Symbaols

|[EASY_MOEILE |




Sharing: Scripting

This section provides a guide to work with Sharing module scripting APL.

You can access the Sharing module API via the Sharing class under the EasyMobile namespace.

Screenshot Capturing

To capture the device's screenshot, you have a few options.

Screenshot as PNG Image

To capture and save a screenshot of the whole device screen, simply specify the file name to be saved. This
screenshot will be saved as a PNG image in the directory pointed by Application.persistentDataPath. Note that this
method, as well as other screenshot capturing methods, needs to be called at the end of a frame (when the rendering
has done) for it to produce a proper image. Therefore you should call it within a coroutine after WaitForEndOfFrame().

path = Sharing

You can also captures and saves just a portion of the screen:

path Sharing

Screenshot as Texture2D

In some cases you may want to capture a screenshot and obtain a Texture2D object of it instead of saving to disk,
e.g. to create a sprite from the texture and display it in-game.

texture Sharing

Similar to the case above, you can also capture only a portion of the screen.


https://docs.unity3d.com/ScriptReference/Application-persistentDataPath.html

texture Sharing

Note that screenshot capturing should be done at the end of the frame.

Sharing

To share an image you also have a few options. You can also attach a message to be shared with the image.

Due to Facebook policy, pre-filled messages will be ignored when sharing to this network, i.e. sharing

messages must be written by the user.

Share a Saved Image

You can share a saved image by specifying its path.

path = System IO Path Application persistentDataPath

Sharing path

Share a Texture2D

You can also share a Texture2D object obtained some point before the sharing time. Internally, this method will also
create a PNG image from the Texture2D, save it to the persistentDataPath, and finally share that image.

Sharing sampleTexture

Share a Text

You can share a text-only message using the ShareText method. Note that Facebook doesn't allow pre-filled sharing
messages, so the text will be discarded when sharing to this particular network.

Sharing

Share a URL

To share a URL, use the ShareURL method. On networks like Facebook or Twitter, a summary of the page will be
shown if the shared URL points to a website. URLs are also useful to share GIF images hosted on sites like Giphy
(see the GIF > Scripting section).


https://giphy.com/

Scripting

// Share a URL
Sharing.ShareURL("www.sglibgames.com");
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PlayMaker Actions

Sharing: PlayMaker Actions

The PlayMaker actions of the Sharing module are group in the category Easy Mobile - Sharing in the PlayMaker's
Action Browser.

Please refer to the SharingDemo_PlayMaker scene in folder
Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

far #,
o Device

Easy Mobile - Advertising
Easy Mobile - Care
Easy Mohile - Demao Actions
Easy Mobile - Game Services

l l
[ ]
[ ]
[ ]
[ ]
| Easy Mobile - Gif |
[ ]
[ ]
[ ]
[ ]
[ |

i
=

Easy Mobhile - In-App Purchasing

Easy Mobile - Mative APls
Easy Mobile - Motifications

Easy Mohile - Privacy
Easy Mobile - Saved Games

Easy Mobile - Sharing

Mobile Mative Share_Capture Screenshot

Mobile Mative Share_Save Screenshot

Muobile Mative Share_Share Image

Mobile Mative Share_Share Screenshot

Mobile Mative Share_Share Text

Mobile Mative Share_Share Texture 2D

Mobile Mative Share_Share URL
| Easy Mobile - Utilities |
['F Effects ]
[E Enum ]
E GameObject i
I 1
Mobile Mative Share_Capture Screenshot [
Captures a screenshot into a Texture2D object and returns it.
Result
Scresnshot Mone (Texture) =

Select

Capture Area Whale Screen &
Start X 0 =
Start Y 0 =
Width 100 =
Height 100 =
I Preview | Add Action To State
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PlayMaker Actions
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Utilities: Introduction

The Utilities module is a place to hold useful miscellaneous features. The first feature added to this module is Store
Review.



Utilities | Store Review: Introduction

Ratings and reviews can have a crucial impact on the performance of an app on app stores. Therefore it's a common
practice to ask users for ratings when appropriate. The Store Review feature gives you an efficient way to do that
using a native and highly customizable rating dialog.

This rating dialog has different appearances and behaviors depended on the platform it is being used.
i0S
iOS 10.3 and newer

On iOS 10.3 or newer, the system-provided rating dialog is employed. This dialog is built-in to iOS since its 10.3
release, and is the preferred method to solicit user ratings on this platform.

You can find more information about this built-in rating prompt at https://developer.apple.com/ios/human-

interface-guidelines/interaction/ratings-and-reviews/

It's worth noting that the Submit button on this rating popup will be disabled while your app is still in sandbox

mode. It will be functioning normally when the app is actually live on App Store.

r M

Enjoying Emaoji Blitz?
Tap a star to rate it on the
App Store.

* ok ok ok Kk

Cancel Submit
ke A

iOS Before 10.3

On iOS older than 10.3, a typical 3-button alert is used as the rating prompt. This is mainly for backward-compatibility
purpose, since the new built-in rating prompt is preferred and will be used on the majority of iOS devices in the near
future, given the high adoption rate of new iOS versions.


https://developer.apple.com/ios/human-interface-guidelines/interaction/ratings-and-reviews/

Rate Easy Mobile

Would you mind spending a moment to
rate Easy Mobile on the App Store?

Don't Ask Again
Remind Me Later

Rate Now!
|- .

Unlike the built-in dialog, you can customize the title, message and button labels of this alert to suit your needs. The
default behavior of this rating prompt is described below.

e Don't Ask Again: close and never show this prompt again

e Remind Me Later: close this alert

e Rate Now!: open the "Write A Review" page of the current app on the App Store, the prompt will never be
displayed again

Android

On Android, we built a native, custom alert that employs the RatingBar component to form the rating dialog. The
picture below illustrates how this dialog looks and behaves.

Rate Easy Mobile

- That's bad. Would you like to give us some
bad I'a‘tll"lg feedback instead?

% % % % &

Rate Easy Mobhile
Cancel Send Feedback

How would you rate Easy Mobile?

% %k % % %k

Rate Easy Mobhile
Don't Ask Again Mot Now

Awesome! Let's do it!

goodrating > Y W W W W

Cancel Rate Now!



The idea is to ask the user how they would rate the app, and the dialog will update itself based on the given rating.

You can set a "minimum accepted rating" value, which is the lowest number of stars expected for your app. Any rating
lower than this value is considered a bad rating, and vice versa. If the user is giving a good rating, we will take them to
the store to do the actual rating and review. Otherwise, we will suggest them to send a feedback to your support email
instead. The default behavior of this rating dialog is described below. Again, you can discard this default behavior and

implement a custom one if you wish.

e Don't Ask Again: close and never show this prompt again

e Not Now/Cancel: close this prompt

e Send Feedback: open email client for the user to send feedback to your email address

e Rate Now!: open the product page of the app on the Google Play Store, the prompt will never be displayed again

On Android or iOS older than 10.3, you can discard the default behavior of the rating dialog and give your own

behavior implementation if you wish.

Display Policy

It is up to you to decide when to show the rating prompt in your game to maximize its effectiveness while maintaining
the best user experience. Generally, it is advisable to not annoy the user by asking repeatedly or too frequently. For
that purpose, the rating request feature provides a few general constraints to help regulate the display of the rating
prompt. You are free to configure these values appropriately to suit your needs. These constraints include:

e Annual Cap: the maxium number of requests allowed each year

e Delay After Installation: the required waiting time (days) since app installation before the first rating request can
be made

e Cooling-Off Period: the minimum interval (days) required between two consecutive requests

On iOS 10.3 and newer (where the built-in rating prompt is used), the Annual Cap is overwritten by the OS and

will always be set to 3.

For the Delay After Installation constraint to function properly, it is required that an instance of the EasyMobile

prefab is added to the first scene of your game (so that it can record the installation timestamp).

Dialog Content and Localization

The default content (texts) of the rating dialog can be entered in the settings Ul (see the Configuration section). This
content can be altered in runtime (see the Scripting section), so that you can use this feature in conjunction with
another localization plugin to fully localize your popup.



Settings

Utilities | Store Review: Settings

You can configure the Store Review feature from the Utilities module. Go to Window > Easy Mobile > Settings, then
select the Utilities tab to reveal it.

In the [STORE REVIEW] REQUEST DIALOG CONFIG section, you can customize the appearance, behavior and
display constraints of the rating dialog.
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~ STORE REVIEW | RATING DIALOG

Appearance

| 17 Allinstances of §PRODUCT_MAME in titles and messages will be replaced by the actual Product Mame
l‘-h:r’ given in PlayerSettings.

¥ Default Dialog Content

Title Rate $PRODUCT_MNAME

Message How would you rate $PRODUCT_MNAME?

Low Rating Message That's bad. Would you like to give us some feedback instea
Hight Rating Message Awesome! Let's do it!

Postpone Button Title Mot Mow

Refuse Button Title Daon't Ask Again

Rate Button Title Rate Now!

Cancel Button Title Cancel

Feedback Button Title Send Feedback

Behaviour

Minimum Accepted Rating . 4

Support Email
0S5 App ID

Display Constraints

Annual Cap w, 1z
Delay After Installation - 10
Cooling-0Off Period - 10

Ignore Constraints In Development ]

e Default Dialog Content: the default texts of the rating dialog used on Android and iOS older than 10.3 (on iOS
10.3 or newer this content is governed by the system)

e Minimum Accepted Rating: the lowest number of stars required to be considered as a good rating, you can set it
to 0 to disable the feedback feature (accept all ratings); note that this is only applicable on Android

e Support Email: your email address for receiving feedback

e jOS App Id: your app Id on the Apple App Store, this is required to open the review page of the app on iOS older
than 10.3

e Annual Cap: the maxium number of requests allowed each year

e Delay After Installation: the required waiting time (days) since app installation before the first rating request can
be made

e Cooling-Off Period: the minimum interval (days) required between two consecutive requests

e Ignore Constraints In Development: ignore all display constraints so the rating popup can be shown every time in
Development builds (unless it was disabled before)



Utilities | Store Review: Scripting

This section provides a guide to work with the Store Review scripting API.

You can access the Store Review API via the StoreReview class under the EasyMobile namespace.

Making Rating Request
To show the rating dialog using its default content and retain its default behavior, use the RequestRating method
without any parameter. Note that this method is a no-op if the rating dialog has been disabled, or one of display

constraints is not satisfied. You should call this method when it makes sense in the experience flow of your app, to
maximize the effectiveness of the request.

On iOS 10.3 or newer, the actual display of the rating dialog is governed by App Store policy. When your app is
still in sandbox/development mode, the dialog is always displayed for testing purpose. However, it won't be

shown in an app that you distribute using TestFlight.

StoreReview

To check if the rating dialog has been disabled (because the user selected Don't Ask Again or already gave a rating):

isDisabled StoreReview

To get the number of used and remaining requests in the current year:

usedRequests - StoreReview

unusedRequests — StoreReview

To get the timestamp of the last request:

lastTime StoreReview

To check if it's eligible to show the rating dialog (which means it hasn't been disabled and all display constraints are
satisfied):

StoreReview

StoreReview

Making Rating Request with Custom Callback

On Android or iOS older than 10.3, you can discard the default behavior of the rating dialog and provide your own
implementation to suit your needs (again, on iOS 10.3 or newer we employ the native rating prompt whose behavior is
governed by the system itself). This can be useful in cases when you want to perform additional tasks like recording



the number of users who gave good ratings (maybe for analytics purpose). To do so, simply call the RequestRating
method passing a callback in which the custom behavior is implemented. This callback takes as input an enum value
representing the user action, which you can use to decide whatever action should be taken. Note that you can use the
DisableRatingRequest method to prevent the rating dialog from being displayed in the future, if the user selects "Don't
Ask Again" option. Also note that you can pass a null RatingDialogContent object to use the default content, otherwise
create a new object as described in the Localized the Rating Dialog section above.

From the analytics point of view, it's worth noting that the rating given in the rating dialog on Android is merely a
suggestion of how the user would rate the app. There's currently no reliable way to verify if it is the actual rating
given on the app stores or not.

StoreReview RatingCallback

action
action

StoreReview UserAction Refuse

StoreReview

StoreReview UserAction Postpone

StoreReview UserAction Feedback

StoreReview UserAction Rate

Localizing Rating Dialog

To localize the content of the rating dialog, simply create a new RatingDialogContent to hold the translated texts
(which you may obtain from a standard localization plugin), and pass it to the RequestRating method.

localized
YOUR_LOCALIZED_TITLE RatingDialogContent PRODUCT_NAME_PLACEHOLDER
YOUR_LOCALIZED_MESSAGE RatingbDialogContent PRODUCT_NAME_PLACEHOLDER
YOUR_LOCALIZED_LOW_RATING_MESSAGE
YOUR_LOCALIZED_HIGH_RATING_MESSAGE
YOUR_LOCALIZED_POSTPONE_BUTTON_LABEL
YOUR_LOCALIZED_REFUSE_BUTTON_LABEL
YOUR_LOCALIZED_RATE_BUTTON_LABEL
YOUR_LOCALIZED_CANCEL_BUTTON_LABEL
YOUR_LOCALIZED_FEEDBACK_BUTTON_LABEL

StoreReview localized

Any instance of RatingDialogContent.PRODUCT_NAME_PLACEHOLDER (literal value "$PRODUCT_NAME")
will be automatically replaced by the actual product name (given in PlayerSettings) by the RequestRating
method.



Scripting
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Utilities: PlayMaker Actions

The PlayMaker actions of the Utilities module are group in the category Easy Mobile - Utilities in the PlayMaker's
Action Browser.

Please refer to the UtilitiesDemo_PlayMaker scene in folder
Assets/EasyMobile/Demo/PlayMakerDemo/Modules for an example on how these actions can be used.

L J
Easy Mobile - Advertising

Easy Mobhile - Care
Easy Mohile - Demao Actions
Easy Mobile - Game Services

Easy Mobhile - Gif

#

=
L

Easy Mobile - In-App Purchasing
Easy Mohile - Mative APls
Easy Mobile - Motifications
Easy Mohile - Privacy
Easy Mobile - Saved Games
Easy Mobile - Sharing

Easy Mohile - Utilities
Misc_Open Url

Mobile Native Rating Request_Can Request Rating

Mobile Native Rating Request_Disable Rating Request

Mobile Native Rating Request_Get This Year Remaining Requests
Mohile Native Rating Request_Is Rating Request Disabled

Mobile Mative Rating Request_Request Rating

['a‘ Effects ]
[E Enum ]
E GameOhject |
[.ox Gul ]
™ GUIElement |
[EE] GUlLayout |

[ ] Input ]
[Q Level ]

[ u Lights ]
& Logic |
@ Material |
I= Math |
L._.J. Mesh ] .
[ Physics || =
Misc_Open Url &l
Opens a URL.

Url =
[ Preview Add Action To State
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Release Notes

Version 2.1.2

Changes

e Advertising module:
o Optimizing the implementation of LoadAllDefinedPlacements ad-loading mode.
e Game Services module:

o Bringing back the option to ignore AndroidMaxLoginRequests by setting it to 0.
e Editor:

o Now the Inspector window is automatically focus when opening Easy Mobile Settings.

Version 2.1.1

Changes

e Advertising module:

o Now compatible with the latest version of ironSource SDK (6.7.12).
e Editor:

o Upgraded to Google Play Services Resolver version 1.2.95.

Bug Fixes

e Advertising module:
o Fixed a bug where the "LoadAllDefinedPlacements” mode doesn't load ads at default placements if some
custom placements are not properly defined.
e GIF module:
o Fixed a bug where uploading to Giphy using a production API key fails with the "401 Unauthorized" error.

Version 2.1.0

New Features

e Advertising module:
o Improved Automatic Ad Loading feature, now it can either load only default ads, or load ads at all placements
defined in the module settings, which means you can completely forget about manual ad loading now.
e GIF module:
o AnimatedClip can now automatically release the associated RenderTexture objects while being garbage
collected, which is useful to avoid memory leaks in case you forget to call Dispose.

Changes



e Advertising module:
o The Advertising.IsAutoLoadDefaultAds, Advertising.EnableAutoLoadDefaultAds and
Advertising. SetAutoLoadDefaultAds are now deprecated and replaced by the
Advertising.AutoAdLoadingMode property.

Bug Fixes

e Notifications module:
o Fixed a bug related to applying consent during initializing OneSignal.
o Fixed irrelevant warning message when generating constants without having any user categories defined.

Version 2.0.0

New Features

e Advertising module:
o Added support for Facebook Audience Network.
o Added support for ironSource.
o Added support for Mopub Ads.
o Added support for Tapjoy.
o Added support for showing ads at multiple ad placements in an app.
o Added consent support (GDPR compliance).
e Game Services module:
o Added popup gravity setting for Google Play Games platform.
e In-App Purchasing module:
o Added a method to get subscription product information using Unity IAP's SubscriptionManager class.
o Added support for Apple's Ask-To-Buy feature.
o Added support for Apple's Promotional Purchases.
o Added an option to enable Amazon store sandbox testing.
o Added a method to get Amazon user ID.
e Notifications module:
o Added consent support (GDPR compliance).
o Android local notifications are now expandable (Android 4.1 or newer only).
e Privacy module: brand new module introduced in version 2.0.0 that offers convenient tools and resources to
help with getting GDPR-compliant including:
o A comprehensive, flexible consent management system.
o A native, multi-purpose, customizable consent dialog that can serve as a common interface for collecting
user consent for all services in an app.
o Easy-to-use graphical composer for editing consent dialog content.
o A location checking tool, for detecting if the current device is in the European Economic Region (EEA), which
is regulated by GDPR.
e Editor:
o Brand new redesigned settings Ul that is cleaner, friendlier and prettier :)
o Brand new redesigned settings Ul, once again. (sorry we got too excited, but the new Ul looks really cool,
you'll like it :D)
o PlayMaker support:
o Added new actions for initializing Easy Mobile runtime (for replacing the EasyMobile prefab, see Changes).
o Added new actions for the Privacy module including granting and revoking consent, displaying consent
dialog, etc.



o Added a PlayMaker demo scene for the Privacy module.
o Added an action for the RewardedAdSkipped event.
o Added actions for the LocalNotificationOpened and RemoteNotificationOpened events.

Changes

e Editor:
o The long-time EasyMobile prefab is now officially deprecated. Easy Mobile initialization can now be done
from script using the RuntimeManager class (see Initializing).
o Upgraded to Google Play Services Resolver version 1.2.89.
o The minimum required version of Unity is now 5.5.5f1.

Bug Fixes

o Notifications module:
o Fixed a bug causing the local repeat notifications in the Notifications demo scene to not function on Android
devices due to missing category definition in the module settings.
e Utilities module:
o Fixed a bug causing the rating dialog to be dismissible by tapping outside of the popup and prevent
subsequent dialogs from being shown.
o PlayMaker support:
o Fixed the issue that Saved Games actions don't function correctly with global variables.

Version 1.3.0

New Features

e Notifications module:
o Added support for Firebase Cloud Messaging as a remote notification service.
o Added methods to get and set application icon badge number on iOS.

Changes

e Editor:
o Build managing script now uses IPreProcessBuildWithReport and IPostProcessBuildWithReport interfaces
on Unity 2018.1.0 and newer instead of the deprecated IPreProcessBuild and IPostProcessBuild interfaces.

Version 1.2.1

Changes

e Game Services module:

o Improved PlayMaker actions for Saved Games API.

o Improved PlayMaker demo scene for Saved Games feature.
e Editor:

o Updated to Google Play Services Resolver 1.2.69.



Version 1.2.0p1

Bug Fixes

o Notifications module:
o Fixed a bug that may cause local notifications to not be scheduled properly if the trigger date is not specified
in local timezone.

Version 1.2.0

This is a major update in which we're adding brand new features, revamping the whole API as well as fixing some
known issues. We also renamed some modules and revised related wording to better present the plugin content. Most
importantly, with this update we're restructuring the Easy Mobile product line. Specifically:

e The existing Easy Mobile version will now be Easy Mobile Pro, which is the premium version and contains all the
available features of the plugin. Current Easy Mobile users therefore will own the Pro version automatically.

e A new version named Easy Mobile Basic will be introduced at a lower price than the Pro version. It will contain all
the core features but without a few advanced ones such as GIF and Saved Games. For details about feature
differences between Pro and Basic versions please see the Feature Comparison table.

e The Easy Mobile: GIF Tools version will be deprecated.

New Features

e Game Services module:
o Added the brand new feature Saved Games, which allow easy synchronization of game data to cloud
services including iCloud (iOS) and Google Drive (Android).
o Allows specifying an optional the Web Client ID when setup Google Play Games.
o New PlayMaker actions for Saved Games feature.
e Notifications module:
o Added support for fully-customizable local notifications.
o Fully compatible with Android 8.0 notification channels and channel groups.
o New PlayMaker actions for local notifications.
e Native APIs module:
o Native Ul feature: added a method to check whether an alert is being displayed.

Changes

e Advertising module:
o Removed IsShowingBannerAd and GetActiveBannerAdNetworks methods because there's currently no
reliable way to obtain this information that would work consistently across all the supported networks.
e Scripting:
o Introduced much of code refactoring to enhance stability, maintainability, scalability and readability.
o Renamed major classes to make the API more intuitive; specifically, each module/feature now has a main
class with the same name, where its API can be accessed.
o Removed the feature that automatically disables debug logs in production builds.
e Editor:
o Upgraded to Google Play Services Resolver version 1.2.64.0.

Bug Fixes



e GIF module:
o Fixed Giphy upload error "401 Unauthorized".

Version 1.1.5p2

New Features

e Advertising module:
o AdManager class now exposes a RewardedAdSkipped event, which is raised when a rewarded ad was
closed before finishing.

Bug Fixes

e Editor:
o Replaced the old Chartboost SDK download URL with a new working one.

Version 1.1.5p1

Bug Fixes

o PlayMaker Actions:
o Fixed a minor error in the script for MobileNativeShare_CaptureScreenshot action.

Version 1.1.5

New Features

e Editor:
o Incorporated the Google Play Services Resolver for Unity plugin for Android dependencies management.
o Added the Import Play Services Resolver item to Easy Mobile menu for manual import of this resolver if
needed (normally it will be imported automatically upon importing Easy Mobile)

Changes

e Editor:

o Easy Mobile's native code is now statically included in folder Assets/EasyMobile/Plugins folder, rather than
being imported automatically from script into Assets/Plugins folder as before. This enhances the plugin's
robustness as it prevents build errors due to unintended removal of plugin files in the Assets/Plugins folder.

o Removed the Reimport Native Package item from Easy Mobile menu (as a result of the above change).

Bug Fixes

e Native Sharing module:
o Fixed a bug causing image sharing to fail on Android 7 (Nougat) and above. Image sharing on these
platforms now uses FileProvider to comply with the new Android security requirements.


https://github.com/googlesamples/unity-jar-resolver

Notes

* Since the plugin structure changes quite a lot in this version, you need to do some cleanup before importing the new
plugin. Please see the Upgrade Guide section for more details.

Version 1.1.4b

Changes

e GIF module:
o Optimized memory usage when exporting GIF.

Version 1.1.4a

Bug Fixes
e In-App Purchasing module:

o Updated editor scripts to be compatible with UnitylAP version 1.14.0.

Notes

* If you're upgrading Easy Mobile from an existing project that uses IAP module, you need to upgrade (re-import)
UnitylAP package too. Please see the Upgrade Guide section for more details.

Version 1.1.4

New Features

e Game Service module:

o Added a new method to show the Ul of a specific leaderboard in an (optional) time scope.
e In-App Purchasing module:

o Added a new method to get all IAP products created in the module settings.
e Utilities module - Rating Request feature:

o Added new display constraints: delay after installation & cooling-off period.
o Added an option to ignore display constraints while in development mode.

o Added new methods to get the timestamp of the last request, the number of requests used in the current
year, etc.

o Added the ability to update the dialog content in runtime for localization purposes (see the user guide for
details).

e Editor:

o [Android] leaderboard & achievement IDs are now sorted alphabetically in the settings Ul.



o We've now got a little cute About window where you can quickly find out the version of your Easy Mobile :)

Changes

e Game Service module:
o UserAuthenticated event is now officially removed.

Version 1.1.3

New Features

e Introducing brand new PlayMaker actions!

o Easy Mobile is now compatible with PlayMaker, starting with nearly 100 custom actions covering all modules!
o Utilities module:

o Added new method GetAnnualRequestLimit to get the annual cap of the rating request popup from script

Changes

e Game Service module:
o Added optional callback to ReportScore, RevealAchievement, UnlockAchievement &
ReportAchievementProgress to acknowledge if the operation succeeds or not

Bug Fixes

o Editor:

o Fixed a bug on Unity 5.6+ causing EasyMobile prefab instance to not be detected properly if the containing
scene is not active -> a false "Easy Mobile Instance Not Found" alert is shown before building

Version 1.1.2

Changes

e In-App Purchasing module:
o Updated the receipt validation method to handle cases when the input receipt is null or empty.

Version 1.1.1

New Features

e In-App Purchasing module:
o Added new methods to read receipts from Apple stores and Google Play store
o Added a new method to refresh Apple App Receipt



Version 1.1.0

This is a major release with many new features and improvements!

New Features

e Introducing brand new module GIF!

o Low overhead screen/camera recorder

o Built-in players for playback of recorded clips

o High performance, mobile-friendly GIF image generator

o Giphy upload API for sharing GIF images to social networks
e Native Sharing module:

o Added ShareText and ShareURL methods to MobileNativeShare class
o Editor:

o Added a new context menu for creating EasyMobile instance and other built-in objects in the Hierarchy
window

o Added new item Reimport Native Package to Easy Mobile menu

o [Unity 5.6+] Added a warning popup which is shown when an iOS or Android build starts while no
EasyMobile instance was added to any scene

Version 1.0.4

New Features

e Game Service module:
o Added SignOut method to GameServiceManager class.

Version 1.0.3

This update introduces important improvements and bug fixes.

New Features

e Advertising module:
o AdMob rewarded ad is now supported

o Added support for new ad network: AdColony

Changes

e Advertising module:
o Ad events are now raised from main thread when using AdMob

o RewardedAdCompleted event is now raised after the ad is closed, to ensure a consistent behavior across
different ad networks



Bug Fixes

e Native Sharing module:
o Fixed a potential memory leak issue caused by the SaveScreenshot method of the MobileNativeShare class

Version 1.0.2

New Features
e Introducing whole new module Utilities:

o The first feature of this module is Rating Request, an effective way to ask for rating using a native and
highly customizable "rate my app" popup.
e Game Service module:

o Updated GameServiceManager class, introducing new events UserLoginSucceeded and UserlLoginFailed;
_UserAuthenticated _event is now obsolete.

Version 1.0.1

Changes

e Game Service module:
o Updated scripts to be compatible with version 0.9.37 of the Google Play Games plugin for Unity.

Version 1.0.0

First release.



Upgrade Guide

This section describes the required actions you may need to take when upgrading to a certain version of Easy Mobile.
Please visit this place before upgrading Easy Mobile to avoid unnecessary issues.

Upgrading to version 2.1.1

e This version is compatible with the ironSource Unity SDK version 6.7.12 which unfortunately, makes it
incompatible with older versions of the ironSource SDK. If you upgrade to this version of Easy Mobile, make sure
you also upgrade the ironSource SDK in your project (if any) to version 6.7.12 or newer.

Upgrading to version 2.0.0

e Version 2.0.0 is a major update which introduces lots of changes and improvements. To make the product better,
we had to make some necessary changes that break backward compatibility. Therefore we recommend a clean
upgrade if you are moving from an older version to Easy Mobile Basic 2.0.0 or newer. That means you should
remove the Assets/EasyMobile folder completely before importing the new version and setup the plugin again (re-
apply previous settings in the Settings Ul).

e Version 2.0.0 also removes the longtime EasyMobile prefab. Now you no longer have to add it to the first scene
of your app. Instead you would call the RuntimeManager.Init method (see Using Easy Mobile > Initializing).

Upgrading to version 1.2.0

Version 1.2.0 is a major update in which Easy Mobile has been renamed to Easy Mobile Pro and lots of improvements
and modifications were introduced, most notably API changes. If you're upgrading from an older version to 1.2.0, we
strongly recommend removing the old version completely before importing the new one to avoid potential issues.
Please follow these steps:

e Backup the Assets/EasyMobile/Resources and Assets/EasyMobile/Generated folders and save them somewhere
safe.

e Remove the whole Assets/EasyMobile folder.

¢ Remove the file/folder named com.sglib.easymobile.easy-mobile-1.0.2 in folder Assets/Plugins/Android.

e Import Easy Mobile Pro 1.2.0.

e Copy the backed up Resources and Generated folders back to Assets/EasyMobile folders.

e Go to menu Assets > Play Services Resolver > Android Resolver > Force Resolve.

e [f you're using Game Services module on Android, run Setup Google Play Games once again in the settings Ul.

e Optionally update your scripts to fix warnings due to old classes being deprecated (they still function normally,
we're just introducing new classes with different names to make the API more intuitive).

Upgrading to version 1.1.5 or newer

Since version 1.1.5, Easy Mobile incorporates the Google Play Services Resolver for Unity plugin for Android
dependencies management, as well as moves all native code into the Assets/EasyMobile/Plugins folder. If you're
upgrading from an older version to version 1.1.5 or newer, please remove the following files before importing the new

package to avoid potential issues:



Assets/Plugins/Android/easy-mobile.aar.
Assets/Plugins/Android/libs/armeabi-v7a/libeasymobile.so
Assets/Plugins/Android/libs/x86/libeasymobile.so
Assets/Plugins/iOS/libEasyMobile.a

Upgrading to version 1.1.4a or newer

Since version 1.14.0, the UnitylAP package has made changes to its API that cause some conflicts with Easy Mobile
editor scripts. We addressed this problem in version 1.1.4a. If you're upgrading from an older version to 1.1.4a, and
your project uses the In-App Purchasing module, you need to upgrade (re-import) the UnitylAP package to version
1.14.0 or newer to avoid incompatibility issues.

Upgrading to version 1.1.0 or newer
If you're upgrading from an older version to version 1.1.0 or newer, you'll need to:

1. Remove the EasyMobile/Demo folder
2. Remove the EasyMobile/Script folder
3. Import the new version



Troubleshooting

This section describes known issues and common solutions for them.

App crashes when using Google Play Game Plugin with
Unity 2018.2.0 or newer.

Symptoms

e You are using the Google Play Games Plugin for Unity (GPGS) version 0.9.50 or older (0.9.50 is the latest
version as of this writing, this may or may not apply to future versions).

e You are building the app with Unity 2018.2.0 or newer.

e The app crash while attempting to login to Google Play Games.

e The crashlog includes this line "Application ID ( xxxxxxxxxxxxx) must be a numeric value."

Resolution

This is a known issue of GPGS. Please follow this instruction to solve it.

Google Play Services Resolver gets stuck after importing
OneSignal SDK

Symptoms

e Your project is using Google Play Services Resolver 1.2.88 or newer.
e The resolver worked correctly before importing OneSignal plugin, but gets stuck after importing it.

Resolution

Please follow OneSignal instruction on solving this.

Can't sign in to Google Play Games with development
builds created by Gradle build system

Symptoms

e You have setup your app to work with Google Play Games via the Game Services module.

e |[f you create a non-development build using Gradle and try to sign in to Google Play Games in the app, the
authentication succeeds.

e [f you create a non-development or development build using the Unity's internal build system, the authentication
also succeeds.

e If you create a development build using the Gradle build system, the authentication always fails.


https://github.com/playgameservices/play-games-plugin-for-unity/issues/2013#issuecomment-412073497
https://github.com/OneSignal/OneSignal-Unity-SDK/commit/f60a36a940397dd33121712de40e7194d5a89199

Resolution

The root cause of the problem is the default gradle config of Unity doesn't use the keystore specified in Play Settings
(in other words, the debug keystore is always used), causing Google Play Games authentication to fail. To address
this you need to:

1. Enable the 'Custom Gradle Template' option in Player Settings > Android Tab > Publishing Settings.

2. Add a **SIGNCONFIG** line to the custom gradle config (normally it is at
Assets/Plugins/Android/mainTemplate.gradle) at the debug buildTypes config like below, so that the release
keystore can be used in development builds.

*XSTGN**
buildTypes {
debug {
minifyEnabled **MINIFY_DEBUG**
useProguard **PROGUARD_DEBUG**
proguardFiles getDefaultProguardFile('proguard-android.txt'), 'proguard-unity.txt'**USER_PROGUARD**
jniDebuggable true
**SIGNCONFIG** <--- ADD THIS LINE

3
release {
minifyEnabled **MINIFY_RELEASE**
useProguard **PROGUARD_RELEASE**
proguardFiles getDefaultProguardFile('proguard-android.txt'), 'proguard-unity.txt'**USER_PROGUARD**
**SIGNCONFIG**

Easy Mobile settings are not saved

Symptoms

You open the Easy Mobile global settings interface (Window > Easy Mobile > Settings) and made some changes,
then close the interface. When you re-open it, the changes are gone instead of being saved.

Resolution

Normally, this is because there are more than one Inspector tabs being opened at the same time. So double check
that and make sure you only have one Inspector tab in which the Easy Mobile settings interface is shown.

UnityAds Service is enabled, but shown as unavailable in
Advertising module settings

Symptoms
You have enabled UnityAds from the Services tab in Unity, but the Advertising module still shows that it is unavailable.

UNITY ADS SETUP

& Unity Ads service is disabled or not available for the current platform. To enable it
go to Window » Services.

Resolution



Troubleshooting

1. First of all make sure that your current active platform is iOS or Android, since UnityAds is not available on other
platforms. To switch platform go to File > Build Settings, then select the target platform and hit the Switch
Platform button.

2. In UnityAds settings panel (Window > Services > Ads), make sure the "Enable built-in Ads extension" option in
the Advanced section is checked.

Go to Dashboard

105 § Android Xiaomi

If UnityAds is still not detected as available, perform the following steps:

Disable UnityAds service in the Services tab.

Exit Unity.

Go to the project folder, locate the Project Settings folder and open it.

Delete the UnityConnectSettings.asset file and the UnityAdsSettings.asset file (if any).
Open Unity and enable UnityAds service again. It should be detected now.

o WD =

Errors upon importing Easy Mobile due to conflicting
versions of the Google Play Services Resolver plugin

Symptoms

After importing/upgrading Easy Mobile in a project that already contains the Google Play Services Resolver plugin
(the folder Assets/PlayServicesResolver exists):

227



Troubleshooting

e You get an error in the console starting with "An assembly with the same name 'Google.VersionHandlerimpl'
has already been imported...".

@ Assets/PlayServ Iver /Editor fGoogle Ver dlerimpl.dll Jata will be checked
UnityEngine.l Debug'ch(Objact]
Assets /Pl itor /play lver.txt Jata will be checked
unnyEngine Debug: ch(t)bject]

A Overriding existing asset with new GUID from package, this may break links within your project to package assets (Assets /PlayServ Iver /Editor /Coogle

r sign the

An assembly with tlle same name Gccg rskmliandlerlmpr has already been Impormed Consider removing one of the references or sign the
Assets /Pl layServ J/Editor /Google I_v1.2.52.0.dll {Location of the symbol related to previous error)
Assets /PlayServ Iver/Editor/Google |_v1.2.59.0.dll {Location of the symbaol related to previous error)
error C51704: An assembly with the same name " Google JarResolver' has already been imported. C | g one of the
Assets /PlayServicesResolver /Editor /Google JarResolver_v1.2.52.0.dll (Location of the symbol related to previous error)
Assets (PlayServicesResolver (Editar/Google JarResalver_v1.2.59.0.dll {(Location of the symbal related to previous error)
error C51704: An assembly with the same name " Google.|OSResolver' has already been imported. C g one of the references or sign the bl
Assets/PlayServicesResolver/Editor/Google.| IDSRﬁolver w1.2.52.0.dll (Location of the symbol related to previous error)
Assets [PlayServicesResolver/Editor/Google.|O5SResolver_v1.2.59.0.dll (Location of the symbol related to previous error)

ces or sign the

Compilation failed: 3 error(s), 0 warnings

e The Assets/PlayServicesResolver/Editor contains multiple files with same names but different versions.

Assets » PlayServicesResolver » Editor

== Editor

Resolution

Use menu Assets > PlayServicesResolver > Version Handler > Update. The Version Handler of the Google Play
Services Resolver will automatically resolve the conflict, pick the appropriate version and remove the redundant files.

228



	About
	Introduction
	Using Easy Mobile
	Introduction
	Settings
	Setup AdColony
	Setup AdMob
	Setup Chartboost
	Setup Audience Network
	Setup Heyzap
	Setup ironSource
	Setup MoPub
	Setup Tapjoy
	Setup Unity Ads

	Scripting
	PlayMaker Actions
	Introduction
	Settings
	Scripting
	Saved Games
	Settings
	Scripting

	PlayMaker Actions
	Introduction
	Setup
	Scripting
	PlayMaker Actions
	Introduction
	Settings
	Scripting
	Advanced Scripting
	PlayMaker Actions
	Introduction
	Native UI
	Scripting

	PlayMaker Actions
	Introduction
	Settings
	Scripting
	PlayMaker Actions
	Introduction
	Settings
	Scripting
	PlayMaker Actions
	Introduction
	Scripting
	PlayMaker Actions
	Introduction
	Store Review
	Settings
	Scripting

	PlayMaker Actions
	Release Notes
	Upgrade Guide
	Troubleshooting

